
Multi-Mode Microplate Reader 
 

Synergy  2 

 

TM 

Operator’s Manual 

 



 



Synergy 2
Multi-Mode Reader

Operator's Manual

BioTek® Instruments, Inc.
Part Number 7131000
Revision K
October 2015
© 2015



Notices

BioTek® Instruments, Inc.

Highland Park, P.O. Box 998

Winooski, Vermont 05404-0998 USA

All Rights Reserved

© 2015, BioTek® Instruments, Incorporated. No part of this publication may be
reproduced, transcribed, or transmitted in any form, or by any means electronic or
mechanical, including photocopying and recording, for any purpose other than the
purchaser’s use without written permission of BioTek Instruments, Inc.

Trademarks

BioTek® is a registered trademark and Synergy™, Gen5™, BioStack™, BioCell™, and
Take3™ are trademarks of BioTek Instruments, Inc. Harta™ is a trademark of Harta
Instruments.

Microsoft®, Windows®, Windows 7, Windows 8, and Excel® are either registered
trademarks or trademarks of Microsoft Corporation in the United States and/or other
countries.

All other trademarks are the property of their respective holders.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a commitment by
BioTek Instruments, Inc. Changes made to the information in this document will be
incorporated in new editions of the publication. No responsibility is assumed by BioTek for
the use or reliability of software or equipment that is not supplied by BioTek or its affiliated
dealers.
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Contact Information

BioTek® Instruments, Inc.
Highland Park, P.O. Box 998
Winooski, Vermont 05404-0998 USA

Global Service and Support

BioTek product service and repair is available worldwide at one of BioTek's International
Service Centers and in the field at your location. To arrange for service or repair, contact
the office nearest you; visit www.biotek.com for up-to-date contact information. For
customer service, sales, and technical assistance, refer to the information below.

Customer Service and Sales

Internet: www.biotek.com

Phone: 888-451-5171 (toll-free in the U.S.) or 802-655-4740 (outside the U.S.)

Fax: 802-655-7941

Email: customercare@biotek.com

Service/Technical Assistance Center (TAC)

Phone: 800-242-4685 (toll free in the U.S.) or 802-655-4740 (outside the U.S.)

Fax: 802-654-0638

E-Mail: tac@biotek.com

European Coordination Center/Authorized European Representative

BioTek® Instruments GmbH
Kocherwaldstrasse 34
D-74177 Bad Friedrichshall
Germany

Internet: www.biotek.de

Phone: +49 (0) 7136 9680

Fax: +49 (0) 7136 968 111

E-Mail: info@biotek.de

BioTek Instruments, Inc.
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Revision History

Rev Date Changes

A 8/2006 First issue

B 12/2007 General: Changed all instances of “multi-detection” to “multi-mode”.
Changed all instances of “filter cartridge” to “filter wheel”.

Preface: Added Glowell™ and FluoSpheres® to Trademarks. Removed
Figures list.

Ch. 1, Introduction: Updated Package Contents and Accessories lists. Added
note stating that part numbers are subject to change.

Ch. 2, Installation: Revised unpacking/repackaging instructions. Added note
stating that packaging materials are subject to change.

Ch. 3, Getting Started: Simplified Gen5 Software usage instructions.

Ch. 4, Filters and Mirrors: Mirrors section: Added information on Visible and
UV-polarizing filters. Corrected high end of EM Range for 510 nm mirror
(changed 780 nm to 640 nm). Changed mirror label location from “lower left
corner” to “face up and readable” and added an illustration. Updated list of
dichroic mirrors available from BioTek.

Ch. 5, Instrument Qualification: Added materials and procedure for a
Luminescence Test. Fluorescence Liquid Tests section: Added option to use
Greiner SensoPlate to FI tests for the top optics. Corrected instances of “505
nm” mirror to “510 nm” and “410 nm” to “400 nm”. Under “Results Analysis”
for the FP Test, corrected the wells used for the Mean Blank calculations—
changed from A1-H6 to A6-H6. Added option to use Sodium Borate instead of
PBS. Reconfigured the SF test solutions and dilutions for efficiency and
consistency with other BioTek products. Added troubleshooting tip to reduce
the Gain/Sensitivity value in the Gen5 protocol if well(s) are overranging
during the Fluorescence Intensity tests. To minimize the opportunity for
overranging during these tests, reduced the recommended Gain/Sensitivity
values for the SF Fluorescence Intensity Corners and Sensitivity top probe
tests to 75. Updated the materials list and solution preparation steps for the
TRF test to support the use of FluoSpheres® from Invitrogen. Removed
screen shots of sample BioTek data sheets. Under “Gen5 Protocol Reading
Parameters” added the Gain/Sensitivity value as an example of a protocol
parameter that may need to be adjusted for some readers. Added FI tests
using Methylumbelliferone.

Ch. 6, Preventive Maintenance: Removed task to clean supply bottles.

Ch. 7, As Needed Maintenance: Changed the replacement tungsten lamp part
number to 7080500.

Appendix B, Error Codes: Revised to focus on only the most common, most
easily-fixed error codes that may appear in Gen5.
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Rev Date Changes

C 1/2010 Throughout: Added information for purchasing and using the Harta
Luminometer Reference Microplate. Added support for the BioTek Take3
Multi-Volume Plate.

Preface: Updated the Intended Use Statement; the Synergy 2 may be used
for In Vitro Diagnostic, research and development, or other non-clinical
purposes. Added information for registering products online through the
BioTek Customer Resource Center. Updated the list of Hazards and
Precautions. Updated CE Mark information and Safety Symbols.

Ch 1, Introduction: Updated the list of Optional Accessories and added a
reference to the BioTek online Accessories search tool. Removed the BioTek
shipping address; customers will be notified of the address when they contact
TAC/Service for a Return Materials Authorization number.

Ch 2, Installation: Combined reader unpacking/inspection and shipping panel
removal instructions. Moved dispense module figures from step 2 to
“Repackaging and Shipping Instructions.” Corrected USB Driver Software CD
instructions under “Establish Communication”.

Ch 3, Getting Started: Added “Modular Design,” “External Components,” and
“Internal Components.” Clarified/updated content in remaining sections.

Ch 4, Filters and Mirrors: Clarified instructions throughout. Added “Filters
Available From BioTek.” Moved mirror cleaning instructions to Chapter 7.

Ch 5, Instrument Qualification: Corrected unit of measure typos. Added
reference to new BioTek test kits for fluorescence liquid testing. Added
Luminescence Test using the new Harta plate. Corrected Accuracy % Error
calculation for Dispense Module tests.

Ch 6, Preventive Maintenance: Added instructions for inspecting/ cleaning
mirrors.

Appendix A, Specifications: Added support for the Take3 plate.

Appendix B, Error Codes: Updated error code descriptions.

D 3/2010 Preface: Updated Directive 98/79/EC: In Vitro Diagnostics. Ch 2, Installation:
Corrected typo in the step heading numbers. Ch 5, Instrument Qualification:
For the luminescence test using the Harta Luminometer Reference
Microplate, moved the background (buffer) wells from rows C and D to rows
F and G. For the background read step, changed the Top Probe Vertical Offset
to 4.00 mm. Ch 6, Preventive Maintenance: Under “Run a Dispense Protocol
(Optional),” added instruction to set the Plate Type in the Gen5 protocol to
match the plate being used for the test.

E 4/2010 Ch 5, Instrument Qualification: For the luminescence test using the Harta
Luminometer Reference Microplate, corrected errors in the Gen5 protocol
reading parameter table on page 123 (read step 3).

F 7/2011 Updated Gen5 instructions for new Gen5 version 2.x. Added information for
new side-access door. Added Take3 Trio to “Optional Accessories.”
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Rev Date Changes

G 7/2012 Preface: Updated the Intended Use Statement and the heading for the In
Vitro Diagnostics directive to refer to the instrument’s IVD label (if one
exists). Added ‘Service’ and ‘Accessories’ hazard warnings. Added a warning
to use two people to lift/carry the instrument. Added ‘Spare Parts’
precaution. Updated ‘Power Supply’ precaution. Added EN 61010-2-010 to
Directive 2006/95/EC.

H 2/2014 Preface: Updated contact information to include global info. Chapter 1,
Introduction: Updated part number of power supply and updated incubation
range in Product Description. Chapter 2, Installation: Updated power supply
section to reflect current power supply. Chapter 3, Getting Started: Updated
photo of Synergy 2, added note to Recommendations about using partial
plates during incubation.

I 10/2014 General: Updated references to USB drivers to state that they now reside on
the Gen5 software media. Removed statements that the serial numbers must
match between the reader and dispense module. Changed 'RMA' to 'service
authorization number'. Chapter 2, Installation: Added a new step 11 to
verify/set dispenser calibration values. Chapter 5, Instrument Qualification:
Under ‘Harta Plate Test’, updated instructions for checking the test plate’s
battery and updated the attomole conversion and battery check formulas.
Under ‘Glowell Test’, revised the radiant flux correction formula.

J 4/2015 Preface, Contact Information: To reduce the risk of providing outdated
contact information for BioTek’s offices worldwide, replaced the former
detailed information for every location with a simpler instruction to visit
www.biotek.com for the most up-to-date information. CE Mark: Updated
Directive headings. Notices: Remove trademark information for Glowell.
Chapter 3, Getting Started: To ‘Recommendations for Optimum Performance’
added information on the use of acids, corrosives, and solvents. Chapter 5,
Instrument Qualification, Luminescence Test: Removed the Glowell Test
procedure. In the Gen5 [Harta] protocol parameters table, changed the
Dynamic Range for the Battery Check read step to Extended.

K 10/2015 General: Added information for purchasing and using the BioTek 340 nm
Absorbance Test Plate (BTI #7260551). Preface, CE Mark section: Updated
Directive headings. Created a new Chapter 7, Instrument Qualification
Process to describe the tests designed to qualify the Synergy 2. Added Gen5
protocol parameters tables for Absorbance Testing. Renamed the former
Chapter 7, Instrument Qualification as Chapter 8, Instrument Qualification
Procedures and moved the description content to the aforementioned new
chapter.
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Document Conventions

This icon identifies information that protects the safety of the operator
and the integrity of data.

Warning! AWarning indicates the potential for bodily harm and tells you how to
avoid the problem.

Caution A Caution indicates the potential for damage to the instrument and tells
you how to avoid the problem.

Note: Bold text is primarily used for emphasis.

This icon calls attention to important information.

This style calls attention to usage instructions and helpful facts. For example, "Refer to
Figure 2-3 when performing these steps" and "Part numbers are subject to change."

Topics that apply only to specific reader models are presented in this style. For
example, "Applies only to models equipped with injectors."

Intended Use Statement

The Synergy 2 is a single-channel multi-mode microplate reader. The performance
characteristics of the data reduction software have not been established with any
laboratory diagnostic assay. The user must evaluate this instrument and PC-based
software in conjunction with their specific assay(s). This evaluation must include the
confirmation that performance characteristics for the specific assay(s) are met.

If the instrument has an “IVD” label it may be used for clinical and nonclinical purposes,
including research and development. If there is no such label the instrument may be
used only for research and development or other nonclinical purposes.

BioTek Instruments, Inc.

xiv | Preface



Quality Control

It is considered good laboratory practice to run laboratory samples according to instruc-
tions and specific recommendations included in the assay package insert for the test to be
conducted. Failure to conduct Quality Control checks could result in erroneous test data.

Warranty and Product Registration

Take a moment to review the Warranty information that shipped with your product. Please
also register your product with BioTek to ensure that you receive important information
and updates about the product(s) you have purchased. Register online through the
Customer Resource Center at www.biotek.com or call (888) 451-5171 or (802) 655-4740.

Repackaging and Shipping

If you need to ship the instrument to BioTek for service or repair, contact
BioTek for a Service Call Notice (SCN) number, and be sure to use the
original packing materials. Other forms of commercially available
packaging are not recommended and can void the warranty. If the
original packing materials have been damaged or lost, contact BioTek for
replacement packing.

Synergy 2 Operator's Manual
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Warnings

Operate the instrument on a level, stable surface away from excessive
humidity.

Bright sunlight or strong incandescent light can reduce the linear performance
range of the instrument.

Measurement values may be affected by extraneous particles (such as dust) in
the microplate wells. A clean work area is necessary to ensure accurate
readings.

When operated in a safe environment according to the instructions in this
document, there are no known hazards associated with the instrument.
However, the operator should be aware of certain situations that could result
in serious injury; these vary depending on the instrument type. See Hazards
and Precautions.

Hazards

The following hazard warnings are provided to help avoid injury:

Warning! Power Rating. The instrument’s power supply or power cord must
be connected to a power receptacle that provides voltage and current within
the specified rating for the system. Use of an incompatible power receptacle
may produce electrical shock and fire hazards.

Warning! Electrical Grounding. Never use a plug adapter to connect
primary power to the external power supply. Use of an adapter disconnects
the utility ground, creating a severe shock hazard. Always connect the power
cord directly to an appropriate receptacle with a functional ground.

Warning! Service. Only qualified technical personnel should perform service
procedures on internal components.

Warning! Accessories. Only accessories that meet the manufacturer’s
specifications shall be used with the instrument.

Warning! Lubricants. Do not apply lubricants to the microplate carrier or
carrier track. Lubricant on the carrier mechanism or components in the carrier
compartment will attract dust and other particles, which may obstruct the
carrier path and cause the instrument to produce an error.

Warning! The instrument with all available modules weighs up to 57 pounds
(25.8 kg). Use two people when lifting and carrying the instrument.

BioTek Instruments, Inc.
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Warning! Liquids. Avoid spilling liquids on the instrument; fluid seepage into
internal components creates a potential for shock hazard or instrument
damage. If a spill occurs while a program is running, abort the program and
turn the instrument off. Wipe up all spills immediately. Do not operate the
instrument if internal components have been exposed to fluid.

Warning! Unspecified Use. Failure to operate the equipment according to
the guidelines and safeguards specified in this manual could result in a
hazardous condition.

Warning! Software Quality Control. The operator must follow the
manufacturer’s assay package insert when modifying software parameters
and establishing reading or dispensing methods. Failure to conduct quality
control checks could result in erroneous test data.

Warning! Reader Data Reduction Protocol. No limits are applied to the
raw measurement data. All information exported via computer control must
be thoroughly analyzed by the operator.

Warning! Internal Voltage. Always turn off the power switch and unplug
the power supply before cleaning the outer surface of the instrument or
removing its top case.

Warning! Hot Surface. The lamp assembly is hot when the instrument is
turned on. Turn off the reader and allow the lamp to cool down before
attempting to replace it.

Warning! Potential Biohazards. Some assays or specimens may pose a
biohazard. This hazard is noted by the symbol shown here. Adequate safety
precautions should be taken as outlined in the assay’s package insert. Always
wear safety glasses and appropriate protective equipment, such as chemically
resistant rubber gloves and apron.

Warning! Pinch Hazard. Some areas of the dispense module can present
pinch hazards when the instrument is operating. The module is marked with
the symbol shown here. Keep hands and fingers clear of these areas when the
instrument is operating.

Precautions

The following precautions are provided to help avoid damage to the instrument.

Caution: Service. The instrument should be serviced by BioTek-authorized
personnel. Only qualified technical personnel should perform troubleshooting
and service procedures on internal components.

Synergy 2 Operator's Manual
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Caution: Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and accessories may result
in a loss of warranty and potentially impair instrument performance or cause
damage to the instrument.

Caution: Environmental Conditions. Do not expose the instrument to
temperature extremes. For proper operation, ambient temperatures should
remain within the range listed in the Specifications chapter. Performance
may be adversely affected if temperatures fluctuate above or below this
range. Storage temperature limits are broader.

Caution: Sodium Hypochlorite. Do not expose any part of the instrument
to the recommended diluted sodium hypochlorite solution (bleach) for more
than 20 minutes. Prolonged contact may damage the instrument surfaces. Be
certain to rinse and thoroughly wipe all surfaces.

Caution: Power Supply. Use only the power supply shipped with the
instrument, and operate it within the range of line voltages listed on it. The
power supply was tested for use with the BioTek Synergy 2; do not use it with
any other product. Using this power supply with another product may create a
hazardous condition.

Caution: Disposal. Dispose of the instrument according to Directive
2012/19/EU, “on waste electrical and electronic equipment (WEEE),” or local
ordinances.

Caution: Warranty. Failure to follow preventive maintenance procedures
may void the warranty.

Caution: Shipping Hardware. All shipping hardware (e.g., shipping panel,
carrier shipping screw, etc.) must be removed before operating the
instrument and reinstalled before repackaging the instrument for shipment.

Caution: Electromagnetic Environment. Per EN 61326-2-6 it is the user’s
responsibility to ensure that a compatible electromagnetic environment for
this instrument is provided and maintained in order that the device will
perform as intended.

Caution: Electromagnetic Compatibility. Do not use this device in close
proximity to sources of strong electromagnetic radiation (e.g., unshielded
intentional RF sources), because these may interfere with the proper
operation.

BioTek Instruments, Inc.
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CE Mark

Based on the testing described below and information
contained herein, this instrument bears the CE mark.

See the Declaration of Conformity for more specific information.

Directive 2004/108/EC: Electromagnetic Compatibility

Emissions—Class A

The system has been type-tested by an independent, accredited testing laboratory and
found to meet the requirements of EN 61326-1: Class A for Radiated Emissions and Line
Conducted Emissions.

Verification of compliance was conducted to the limits and methods of EN 55011 –
(CISPR 11) Class A. In a domestic environment it may cause radio interference, in which
case, you may need to take measures to mitigate the interference.

Immunity

The system has been type-tested by an independent, accredited testing laboratory and
found to meet the requirements of EN 61326-1 and EN 61326-2-6 for Immunity.
Verification of compliance was conducted to the limits and methods of the following:

EN 61000-4-2, Electrostatic Discharge
EN 61000-4-3, Radiated EM Fields
EN 61000-4-4, Electrical Fast Transient/Burst
EN 61000-4-5, Surge Immunity
EN 61000-4-6, Conducted Disturbances from RFI
EN 61000-4-11, Voltage Dips, Short Interruptions and Variations

Directive 2006/95/EC Low Voltage (Safety)

The system has been type-tested by an independent testing laboratory and was found to
meet the requirements of this Directive. Verification of compliance was conducted to the
limits and methods of the following:

EN 61010-1, “Safety requirement for electrical equipment for measurement, control and
laboratory use. Part 1, General requirements.”

EN 61010-2-081, “Particular requirements for automatic and semi-automatic laboratory
equipment for analysis and other purposes.”

EN 61010-2-010, “Particular requirements for laboratory equipment for the heating of
materials.”

Synergy 2 Operator's Manual
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Directive 2012/19/EU: Waste Electrical and Electronic Equipment

Disposal Notice: Dispose of the instrument according to the Directive, “on waste
electrical and electronic equipment (WEEE)” or local ordinances.

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use)

Product registration with competent authorities.

Traceability to the U.S. National Institute of Standards and Technology (NIST).

EN 61010-2-101, “Particular requirements for in vitro diagnostic (IVD) medical equipment.”

Electromagnetic Interference and Susceptibility

USA FCC CLASS A

RADIO AND TELEVISION INTERFERENCE

NOTE: This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference, in which case the
user will be required to correct the interference at their own expense.

In order to maintain compliance with FCC regulations shielded cables must be used with
this equipment. Operation with non-approved equipment or unshielded cables is likely to
result in interference to radio and television reception.

Canadian Department of Communications Class A

This digital apparatus does not exceed Class A limits for radio emissions from digital
apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

Le present appareil numerique n'émet pas de bruits radioélectriques depassant les
limites applicables aux appareils numérique de la Class A prescrites dans le Réglement
sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.

BioTek Instruments, Inc.
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User Safety

This device has been type-tested by an independent laboratory and found to meet the
requirements of the following:

l Underwriters Laboratories UL 61010-1, “Safety requirements for electrical
equipment for measurement, control and laboratory use; Part 1: General
requirements.”

l Canadian Standards Association CAN/CSA C22.2 No. 61010-1, “Safety requirements
for electrical equipment for measurement, control and laboratory use; Part 1:
General requirements.”

l EN 61010 Standards, see CE Mark starting on page xix.

Synergy 2 Operator's Manual
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Safety Symbols

Some of these symbols appear on the instrument or accessories.

Alternating current

Courant alternatif

Wechselstrom

Corriente alterna

Corrente alternata

Both direct and alternating current

Courant continu et courant alternatif

Gleich - und Wechselstrom

Corriente continua y corriente
alterna

Corrente continua e corrente
alternata

Direct current

Courant continu

Gleichstrom

Corriente continua

Corrente continua

Earth ground terminal

Borne de terre

Erde (Betriebserde)

Borne de tierra

Terra (di funzionamento)

On (Supply)

Marche (alimentation)

Ein (Verbindung mit dem
Netz)

Conectado

Chiuso

Protective conductor terminal

Borne de terre de protection

Schutzleiteranschluss

Borne de tierra de protección

Terra di protezione

Off (Supply)

Arrêt (alimentation)

Aus (Trennung vom Netz)

Desconectado

Aperto (sconnessione dalla
rete di alimentazione)

Caution (refer to accompanying
documents)

Attention (voir documents
d’accompagnement)

Achtung siehe Begleitpapiere

Atención (vease los documentos
incluidos)

Attenzione, consultare la doc
annessa
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Warning, risk of electric
shock

Attention, risque de choc
électrique

Gefährliche elektrische
schlag

Precaución, riesgo de
sacudida eléctrica

Attenzione, rischio di scossa
elettrica

Warning, risk of crushing or pinching

Attention, risque d’écrasement et
pincement

Warnen, Gefahr des Zerquetschens
und Klemmen

Precaución, riesgo del
machacamiento y sejeción

Attenzione, rischio di schiacciare ed
intrappolarsi

Warning, hot surface

Attention, surface chaude

Warnen, heiße Oberfläche

Precaución, superficie
caliente

Attenzione, superficie calda

Warning, potential biohazards

Attention, risques biologiques
potentiels

Warnung! Moegliche biologische
Giftstoffe

Atención, riesgos biológicos

Attenzione, rischio biologico

In vitro diagnostic medical
device

Dispositif médical de
diagnostic in vitro

Medizinisches In-Vitro-
Diagnostikum

Dispositivo médico de
diagnóstico in vitro

Dispositivo medico
diagnostico in vitro

Separate collection for electrical and
electronic equipment

Les équipements électriques et
électroniques font l’objet d’une
collecte sélective

Getrennte Sammlung von Elektro-
und Elektronikgeräten

Recogida selectiva de aparatos
eléctricos y electrónicos

Raccolta separata delle
apparecchiature elettriche ed
elettroniche

Consult instructions for use

Consulter la notice d’emploi

Gebrauchsanweisung
beachten

Consultar las instrucciones
de uso

Consultare le istruzioni per
uso

Laser radiation: Do not stare into
beam

Rayonnement laser: Ne pas regarder
dans le faisceau

Laserstrahlung: Nicht in den strahl
blicken

Radiación de láser: No mire
fijamente al rayo

Radiazione di laser: Non stare nel
fascio
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Chapter 1

Introduction
This chapter introduces the Synergy 2 Multi-Mode Reader, describes its
key features, lists its package contents, and provides contact
information for technical assistance.

Product Description 2
Package Contents & Accessories 3
Optional Accessories 4

Materials for Conducting Liquid Tests 5
Product Support & Service 6

Technical Assistance Center (TAC) 6
Applications Support 6



Product Description

The Synergy 2 is a single-channel microplate reader for research and development and in
vitro diagnostic use. Depending on the model, detection modes include Fluorescence
Intensity (FI), Fluorescence Polarization (FP), Time-Resolved Fluorescence (TRF),
Luminescence, and UV-visible Absorbance.

Synergy 2 uses a unique combination of monochromator, filters, and dichroic mirrors. Its
three broad-spectrum light sources have been chosen for optimal illumination and
excitation in all applications. The reader is computer-controlled using BioTek’s Gen5 PC
software for all operations including data reduction and analysis. The Synergy 2 is robot
accessible and compatible with BioTek’s BioStack Microplate Stacker. Gen5 supports OLE
automation to facilitate integration into an automated system.

Two light sources are available for Fluorescence determinations: a tungsten halogen lamp
(part of the FI and FP modules) or a xenon flash (part of the TRF module) along with
interference filters and dichroic mirrors for wavelength specificity, and a photomultiplier
tube (PMT) detector. The Synergy 2 has both top and bottom probes for fluorescence
measurements. Bottom probe readings do not use the mirrors. Models with Fluorescence
Polarization (FP) capability are equipped with polarizing filters.

Luminescence is measured by the low-noise PMT detector through an empty filter position
in the Emission filter wheel. Filters can also be used if light filtering is necessary.

Absorbance measurements are made by switching to a xenon flash lamp and a
monochromator for wavelength selection. The xenon lamp allows for both UV and visible
light absorbance measurements. The monochromator provides wavelength selection from
200 to 999 nm in 1 nm increments. Area and spectral scanning, and Pathlength Correction
are available read methods.

The Synergy 2 has a 4-Zone™ temperature control from 4°C (39°F) over ambient to 65°C
(149°F). Internal plate shaking is supported to ensure that reagents are thoroughly mixed
prior to reading.

The Synergy 2 supports the reading of 6-, 12-, 24-, 48-, 96-, 384-, and 1536-well
microplates with standard 128 x 86 mm geometry, as well as the BioTek Take3 Micro-
Volume Plate.

The Luminescence system does not support the reading of 1536-well plates.

i Use of microplates other than those listed here can result in positioning errors during
program execution.

Models with injectors support dual-reagent dispensing to 6-, 12-, 24-, 48-, and 96-well
microplates. An external dispense module pumps fluid from the supply bottles to the two
injectors located inside the instrument. Both injectors are positioned directly above the
bottom probe, and fluid is injected into one well at a time.
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Package Contents & Accessories

Package contents and part numbers are subject to change. Please contact BioTek
Customer Care with any questions.

Item BTI Part #

Synergy 2 Operator's Manual (on USB flash drive) 7131000

Power supply 01317

Power cord set (specific to installation environment):

Europe (Schuko)

USA/International

United Kingdom

Australia/New Zealand

75010

75011

75012

75013

USB cable 75108

RS-232 serial cable 75034

Wrench 48576

Filter "plugs" (2) (also referred to as "dummy filters" or "blanks") 7082073

Spare filter retaining clips (2) 7082075

Storage bag and fastener strips --

Models with injectors ("D" models), an external dispense module
with the following accessories:

Outlet tubes (2, plus 2 spare) from dispense module to reader

Inlet tubes (2) from supply bottles to syringe drives

250-µL syringes (2)

Syringe thumbscrews (2)

Priming plate

Injector tip priming trough

Dispense module communication cable

Dispense module front cover

Dispense module box

Supply bottles (2, 30 mL)

Supply bottle holder assemblies (2)

Injector tip cleaning stylus and storage bag

7082120

7082121

7083000

19511

7132158

7092133

75107

7082137

7090568

7122609

7090564

2872304
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Optional Accessories

Availability and part numbers are subject to change. Please contact BioTek Customer
Care with any questions, or visit our website and use the Accessories search tool.

Item BTI Part #

Absorbance Test Plate (400-800 nm) 7260522

Absorbance Test Plate (340 nm)* 7260551

Luminometer Reference Microplate (includes adapter BTI #8042028
for Synergy 2)

8030015

Take3 Micro-Volume Plate TAKE3

PCR Tube Adapter Plates 6002072, 6002076

Terasaki Adapter Plate 7330531

UV-Range (300 nm and above) excitation polarizer 7132041

3-foot (1-meter) external dispense module tubing 7112186

Empty filter wheel 7080541

Filter retainer clip 7082075

Filter wheel plug (dummy, or blank, filter) 7082073

Empty mirror holder 7130564

Empty mirror holder, FP-compatible 7130563

Handle for mirror holder
Securing screws (order 2)
Optional label

8032006
19189
8031007

Replacement tungsten lamp 7080500

Replacement shipping materials 7130016

BioCell Adapter Plate 7270512

BioCell Quartz Vessel 7272051

Synergy 2 Qualification and Maintenance (IQ/OQ/PQ) package 7130012

Additional filters, filter wheels, mirrors, and mirror holders; contact BioTek Customer Care
for availability and part numbers

The Synergy 2 is compatible with the BioStack Microplate Stacker. The BioStack rapidly and
systematically transfers a stack of microplates to and from the instrument’s microplate
carrier. Contact BioTek or visit our website to learn more.

* The diagnostics feature in Gen5 versions 2.08 and higher is compatible with the 340 nm
Absorbance Test Plate BTI #7260551. If you are using an earlier Gen5 version, the test
plate's instruction sheet explains how to manually conduct the tests and analyze results.
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Materials for Conducting Liquid Tests

Manufacturer part numbers are subject to change.

Item Part Number

Absorbance Liquid Tests

BioTek Wetting Agent Solution BTI #7773002

BioTek QC Check Solution #1 (25 mL) BTI #7120779

BioTek QC Check Solution #1 (125 mL) BTI #7120782

Phosphate-Buffered Saline (PBS) tablets, pH 7.2-7.6 Sigma #P4417

β-NADH Powder (β-Nicotinamide Adenine Dinucleotide,
reduced form)

BTI #98233 or
Sigma #N6785-10VL

Fluorescence Liquid Tests

Test Kits

Kit with microplates and test solutions for conducting
Corners/Sensitivity/Linearity (FI) tests using Sodium
Fluorescein and Methylumbelliferone, and Time-
Resolved Fluorescence (TRF) tests using Europium

BTI #7160010 (contains
7160013, 7160012, and
7160011 described below)

Kit for FI tests using Sodium Fluorescein BTI #7160013

Kit for FI tests using Methylumbelliferone BTI #7160012

Kit for TRF tests using Europium BTI #7160011

Kit for Fluorescence Polarization (FP) test BTI #7160014 or
Invitrogen #P3088

Individual Materials

Sodium Fluorescein Powder, 1-mg vial BTI #98155

Methylumbelliferone, 10-mg vial BTI #98156

Carbonate-Bicarbonate Buffer (CBB) capsules Sigma #3041

Phosphate-Buffered Saline (PBS) tablets, pH 7.2-7.6 Sigma #P4417

Sodium Borate, pH 9.18 Fisher Scientific #159532,
or equivalent

Injection System Tests

BioTek Green Test Dye BTI #7773003

Synergy 2 Operator's Manual
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Product Support & Service

See also Contact Information on page x.

Technical Assistance Center (TAC)

If your BioTek product fails to function properly, if you have questions about how to use or
maintain our products, or if you need to send an instrument to BioTek for repair or other
service, please contact our Technical Assistance Center (“TAC”). TAC is open from 8:30 AM
to 5:30 PM (EST), Monday through Friday, excluding standard U.S. holidays.

TAC@biotek.com

Phone: (800) 242-4685 or (802) 655-4740

Fax: (802) 654-0638

Please be ready with the following information:

l Your name and company, email address, daytime phone or fax number

l The product name, model, and serial number

l The onboard software part number and basecode version (available through Gen5 by
selecting System > Instrument Control > Information)

l Gen5 software version information (Help > About Gen5)

l For troubleshooting assistance or instruments needing repair, the specific steps that
led to the problem and any error codes that were reported (see also Error Codes
starting on page 163)

If you need to send an instrument to BioTek, please contact the TAC for a
Service Call Notice (SCN) number and the shipping address. Package the
instrument according to the instructions in Repackaging and Shipping
Instructions starting on page 25.

Applications Support

BioTek’s fully equipped Application Laboratory provides our on-staff scientists with the
means to assist you with the integration of our instrumentation and software with your
unique scientific applications. If you are having difficulty with optimizing fluorescence
sensitivity or integrating a unique data reduction transformation, or you are just looking for
a recommendation on an appropriate fluorophore, contact us.

Applications@biotek.com or (888) 451-5171
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Chapter 2

Installation
This chapter includes instructions for unpacking and setting up the
Synergy 2 and, if applicable, the external dispense module. Instructions
are also included for preparing the reader and dispense module for
shipment.
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Important Information 8
1: Unpack and Inspect the Synergy 2 9
2: Select an Appropriate Location 10
3: Remove the Shipping Hardware 11
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11: Verify/Set Dispenser Calibration Values 21
12: Run a System Test 22
13: Test the Injection System 23
Operational/Performance Qualification 24
Repackaging and Shipping Instructions 25



Product Registration

Please register your products with BioTek to ensure that you receive important information
and updates about the products you have purchased.

Register online through BioTek’s Customer Resource Center (CRC) at www.biotek.com or
by contacting BioTek Customer Care.

Important Information

This chapter contains installation and setup tasks for a Synergy 2 model
equipped with all of the available modules. Your model may be different;
for example, it may not have injection capability. Perform the tasks in
the order presented, skipping those that do not apply to your reader’s
configuration.

Materials: You will need a slotted screwdriver and a Phillips screwdriver
to perform some of the steps in this chapter. You will also need a small
wrench; this item is supplied with the instrument.

Remove the shipping hardware before turning on the instrument.

Reinstall the shipping hardware before repackaging the instrument for
shipment.
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1: Unpack and Inspect the Synergy 2

The Synergy 2 with all available modules weighs up to 57 pounds (25.8
kg). Use two people when lifting and carrying the instrument.

Save all packaging materials. If you need to ship the reader to BioTek for
repair or replacement, you must use the original materials. Using other
forms of commercially available packaging, or failing to follow the
repackaging instructions, may void the warranty. Improper packaging
the results in damage to the reader may lead to additional charges.

During the unpacking process, inspect the packaging, reader, and
accessories for shipping damage. If the reader is damaged, notify the
carrier and your BioTek representative. Keep the shipping boxes and the
packaging materials for the carrier’s inspection. BioTek will arrange for
repair or replacement of your reader immediately.

1. Set the outer shipping box close to the intended work surface. Open the outer
shipping box and remove the foam blocks to access the inner shipping box.

2. Open the inner shipping box. Remove the accessories that are stored inside the
cardboard shipping insert and then remove the insert.

3. The reader is attached to a shipping panel, which has two handles for lifting. With one
person on each side, locate and grasp the handles. Carefully lift the reader out of the
box. Place the reader on its back on the work surface, so the reader lies flat and the
panel hangs over the edge of the surface. See Figure 2-1 on page 10.

4. Using a screwdriver, remove the screws and washers that attach the panel to the
reader. Carefully set the reader upright.

5. Place the panel with the screws and washers into the shipping box for storage. Place
the packaging materials in the shipping boxes for reuse if the reader needs to be
shipped again.
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Figure 2-1: The reader on its back with the shipping panel
attached to the bottom (left), and removing the screws (right)

Reattach the shipping panel before repackaging the reader for shipment.

2: Select an Appropriate Location

Install the reader on a level, stable surface in an area where ambient temperatures
between 18°C (64°F) and 40°C (104°F) can be maintained.

The reader is sensitive to extreme environmental conditions. Avoid the following:

l Excessive humidity. Condensation directly on the sensitive electronic circuits can
cause the instrument to fail internal self-checks. The humidity must be in the range
of 10–85%, non-condensing.

l Excessive ambient light. Bright light may affect the reader’s optics and readings,
reducing its linear range.

l Dust. Readings may be affected by extraneous particles (such as dust) in the
microplate wells. A clean work area is necessary to ensure accurate readings.

If you will be installing the BioStack for operation with the Synergy 2, you may wish to
seat the instruments in their aligning plates now. Refer to the BioStack Operator’s
Manual for more information.
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3: Remove the Shipping Hardware

Remove all shipping hardware before turning on the reader.

1. Locate the two screws that secure the shroud, one on each side of the reader, in the
lower rear corners. Remove the screws and slide off the shroud.

Figure 2-2: Locating and removing the two side screws

Figure 2-3: Sliding off the shroud
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2. Identify the areas inside the instrument where the shipping hardware is currently
installed, and where some items will be stored.

Figure 2-4: Internal compartment, with shipping hardware

3. Use the supplied wrench to remove the carrier shipping screw. Store the screw on
the base plate as shown in Figure 2-7. Pull the shipping tube off the carrier and place
it in the storage pocket. Attach the pocket to the back of the reader.

Figure 2-5: Removing the carrier shipping screw and tube

12 | Chapter 2: Installation

BioTek Instruments, Inc.



4. Remove three screws (with washers) that hold the optic arm shipping block in place.
Turn the knob at the top of the motor clockwise to raise the optic arm. Slide the block
out from under the arm.

Figure 2-6: Removing the optic arm shipping block

5. Store the optic arm shipping block and three screws/washers on the base plate.

Figure 2-7: Carrier shipping screw and optic arm shipping block
stored on the base plate
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6. Remove the two screws that secure the mirror holder shipping bracket.

Figure 2-8: Removing the mirror holder shipping bracket

7. Turn the bracket over and replace the screws.

Figure 2-9: Mirror holder shipping bracket, in its storage position
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8. If you plan to access the mirror holder through the reader’s side door, remove two
additional shipping screws.

Figure 2-10: Mirror holder shipping screws

Replace these screws before shipping the reader. We suggest taping
them to the back of the instrument to store them.

9. Slide the shroud back onto the reader and replace the two side screws.

4: Install the Power Supply

Power Rating. The instrument must be connected to a power
receptacle that provides voltage and current within the specified rating
for the system. Use of an incompatible power receptacle may produce
electrical shock and fire hazards.

Electrical Grounding. Never use a plug adapter to connect primary
power to the instrument. Use of an adapter disconnects the utility
ground, creating a severe shock hazard. Always connect the system
power cord directly to an appropriate receptacle with a functional
ground.

1. Plug the power supply's cord into the power inlet on the rear of the reader.

2. Connect the power cord to the power supply.

3. Plug the power cord into an appropriate power receptacle.
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5: Unpack and Inspect the Dispense Module

Applies only to models equipped with injectors

Save all packaging materials. If you need to ship the dispense module to
BioTek for repair or replacement, you must use the original materials.
Using other forms of commercially available packaging, or failing to
follow the repackaging instructions, may void your warranty.

During the unpacking process, inspect the packaging, module, and
accessories for shipping damage. If the dispense module is damaged,
notify the carrier and your BioTek representative. Keep the shipping
boxes and the packaging materials for the carrier’s inspection. BioTek
will arrange for repair or replacement of your dispense module
immediately.

Refer to Figure 2-15 and Figure 2-16 starting on page 28.

1. Open the outer shipping box. Remove the foam cap, inner shipping box, and
accessories box.

2. Using no sharp tools, open the box containing the dispense module. Remove the two
reagent bottle holders and the cardboard shipping insert. Lift out the module and
place it on a level surface.

3. Open the accessories box and remove its contents. Refer to Package Contents
& Accessories on page 3 for the expected items.

4. Place all packaging materials into the shipping box for reuse if the dispense module
needs to be shipped again.
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6: Install the Dispense Module

Applies only to models equipped with injectors

1. Place the dispense module on top of the reader.

i Do not place the dispense module next to the reader.

Figure 2-11: Dispense module on top of the reader

2. On the rear panel of the reader, identify the SYRINGE 1 and SYRINGE 2 tubing ports.
Remove the nylon screws from both ports.

3. Open two of the plastic bags containing the outlet tubes. Remove the clear plastic
shrouds from the tubes. Put the other two bags in a safe place; they are spares.

4. Place the nylon screws and the shrouds in the plastic tool storage bag. Use the
supplied fastener strips to attach the bag to the rear panel of the dispense module.

5. Remove the two inlet tubes from their canisters.

6. Identify the two syringe valves on the dispense module (see below). Each is labeled
with a left-pointing arrow.

iWhen installing the tubes, do not use any tools. Finger-tighten only!
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7. Screw the fitting of one inlet tube into the right side of the Syringe 1 valve.

8. Screw one end of one outlet tube into the left side of the Syringe 1 valve.

9. Screw the other end of the outlet tube into the SYRINGE 1 port on the reader.

10. Repeat these steps to attach the inlet and outlet tubing for Syringe 2.

11. Seat the outlet tubes in the clip to the left of the Syringe 2 valve.

Figure 2-12: Dispense module components

It is critical that the outlet tubes are correctly connected
between the syringe valves and the ports on the instrument's
rear panel. Otherwise, injected fluid may miss the
intended well.

12. Remove the two syringes from their boxes. They are identical and interchangeable.
Each should already be assembled in one piece, but if for some reason there are two
separate pieces, assemble them now: insert the white tip of the syringe plunger into
the barrel of the syringe and gently push it all the way into the barrel.

13. Install the syringes:

l Hold the syringe vertically with the threaded end at the top.

l Screw the top of the syringe into the bottom of the syringe valve. Finger-tighten
only.

l Carefully pull down the bottom of the syringe until it rests inside the hole in the
bracket.
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l Pass a thumbscrew up through this hole and thread it into the bottom of the
syringe. Hold the syringe to prevent it from rotating while tightening the
thumbscrew. Finger-tighten only.

Figure 2-13: Dispense module, close-up view of syringes

14. Locate the dispense module cable. Plug one end into the port on the left side of the
dispense module. Plug the other end into the “Dispenser Port” on the rear of the
reader.

15. Locate the injector-tip-cleaning stylus, packaged in a small cylinder. Attach the
cylinder to the back of the dispense module for storage.
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7: Connect the Host Computer

The Synergy 2 is equipped with two communication ports, "USB" and "RS232" (serial),
located on the back of the reader. Connect one end of the supplied communication cable to
the appropriate port on the reader, and the other end to an appropriate port on the host
computer.

8: Install Gen5 Software

The Synergy 2 is controlled by Gen5 software running on a host
computer. There is a certain sequence of events that must be followed to
ensure that the software is properly installed and configured. Please
follow the instructions provided in the Gen5 Getting Started Guide to
install the software.

9: Turn on the Reader

1. If Gen5 is open, close it now.

2. The power switch is located on the lower-left corner of the front panel; turn on the
Synergy 2. The reader performs a System Test. When the test is completed, the
reader extends the microplate carrier.

The carrier eject button, located next to the reader’s power switch, can be used to
extend/retract the microplate carrier.

10: Establish Communication

If using the USB cable, refer to the instructions that shipped with the USB drivers on the
Gen5 software media to install the necessary drivers.

1. Start Gen5 and log in if prompted.

2. From the main screen select System > Instrument Configuration.

3. Click Add Reader and select Synergy 2. Click OK.

4. Set the Com Port to the computer’s COM port to which the reader is connected. (If
using the USB cable, the information can be found via the Windows Control Panel,
under Ports in the Hardware/Device Manager area of System Properties.)
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5. Click Test Comm. Gen5 attempts to communicate with the reader. If the
communication attempt is successful, return to Gen5’s main screen.

If the communication attempt is not successful, try the following:

l Is the reader connected to the power supply and turned on?

l Is the communication cable firmly attached to both the reader and the computer?

l Did you select the correct Reader Type in Gen5?

l Try a different Com port.

l Did you install the USB driver software?

l If you remain unable to get Gen5 and the reader to communicate with each other,
contact BioTek’s Technical Assistance Center.

11: Verify/Set Dispenser Calibration Values

Applies only to models equipped with injectors

Confirm that the reader is configured with calibration values for the dispense module.

i The calibration values for both dispensers (#1 and #2) are printed on labels affixed to
the rear of the dispense module. Each label lists six target calibration values (e.g., 200,
80, 40) with their actual measured values (e.g., 199.3, 79.7, 39.9). Gen5 should display
themeasured calibration values.

1. If you have not already done so, turn on the instrument and establish communication
with Gen5.

2. In Gen5, go to System > Instrument Configuration, select the Synergy 2, and
click View/Modify.

3. Click Setup and select the Dispenser 1 tab.

4. Click Get Volumes.

5. Compare the Calibration Volumes in the dialog with the Syringe #1 values on the
rear panel of the dispense module.

If the values match, skip to step 6.

If there is a mismatch:

l Press CTRL+SHIFT+M to enter maintenance mode for the Dispenser 1 window.

l Enter the syringe calibration values from the corresponding label on the rear of
the dispense module.

l Click Send Volumes and then Get Volumes to verify that the entered values
were sent to the reader.

6. Select the Dispenser 2 tab and repeat steps 4–5 for Dispenser 2.
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12: Run a System Test

Running a System Test will confirm that the reader is set up and operating properly, or will
provide an error code if a problem is detected.

If applicable, adjust Gen5’s Absorbance Wavelengths table to values that will confirm
operation of the reader at its limits. We recommend 200 and 999 nm (the lower and
upper limits of the monochromator), and four wavelengths in between that best
represent your assays and/or the lowest and highest values typically used in your lab.

1. Turn on the incubator:

l In Gen5, select System > Instrument Control > Synergy 2.

l Click the Pre-Heating tab. Enter a Requested temperature of at least 37°C and
then click On.

Wait until the incubator temperature reaches the set point before continuing.

2. Select System > Diagnostics > Run System Test. Select your reader if
prompted and click OK.

3. When the test is complete, a dialog requesting additional information appears. Enter
the information and click OK.

If a message appears stating that the reader has a pending system test report,
view the report and then repeat steps 2 and 3.

4. The results report appears and should contain the text “SYSTEM TEST PASS”.

l If required, print the report and store it with your installation records. Note: Gen5
stores results in its database; you can print a report at any time.

If an error code is returned, refer to Error Codes starting on page 163. If the
problem is something you can fix, do so now and run another System Test. If
the problem is something you cannot fix, or if the test continues to fail, contact
BioTek’s Technical Assistance Center.

5. Turn off the incubator.

Models with injectors: Keep Gen5 open and proceed to the next section.

All other models: The installation and setup process is complete. Close Gen5 and proceed
to Operational/Performance Qualification on page 24.
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13: Test the Injection System

Applies only to models equipped with injectors

1. If necessary, press the carrier eject button to eject the microplate carrier.

2. Place the tip priming trough in its pocket in the carrier.

3. Place the priming plate on the carrier.

Figure 2-14: Priming trough and plate installed on the carrier

4. Fill the two reagent bottles with distilled or deionized water. Place the bottles in their
holders, and place the holders directly in front of the syringes. Insert the inlet tubes
into the bottles.

5. In Gen5, select System > Instrument Control > Synergy 2 and click the Prime
tab.

6. With Dispenser set to 1, set the Volume to 5000 µL and click Prime. The syringe
should move down and up repeatedly, drawing fluid from the bottle and pumping it
through the tubing and into the priming plate. Examine the fittings; no leaks should
be detected. If leaks are detected, tighten all fittings and repeat the prime. If leaks
are still detected, contact BioTek’s Technical Assistance Center.

7. When finished, set the Volume to 2000 µL and click Purge to clear the fluid lines.

8. Set the Dispenser to 2 and repeat steps 6 and 7.

9. Remove and empty the priming plate.
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Operational/Performance Qualification

Your Synergy 2 was fully tested at BioTek prior to shipment and should operate properly
following the successful completion of the installation and setup procedures described in
this chapter.

If you suspect that problems occurred during shipment, if you received the reader back
from BioTek following service or repair, or if regulatory requirements dictate that
Operational/Performance Qualification is necessary, turn to Instrument Qualification
Procedures starting on page 123 to learn about BioTek’s recommended OQ/PQ procedures
for the Synergy 2.

A Product Qualification & Maintenance (IQ/OQ/PQ) package for the Synergy 2 is
available for purchase (BTI #7130566). Contact your local BioTek dealer for more
information.
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Repackaging and Shipping Instructions

If the equipment has been exposed to potentially hazardous material,
decontaminate it to minimize the risk to all who come in contact with the
reader during shipping, handling, and servicing. Decontamination prior
to shipping is required by the U.S. Department of Transportation
regulations. See page 88 for decontamination instructions for the reader
and dispense module.

Remove the microplate and tip prime trough (if equipped) from the
carrier before shipment. Spilled fluids can contaminate the optics and
damage the instrument.

The Synergy 2 with all available modules weighs up to 57 pounds (25.8
kg). Use two people when lifting and carrying the instrument.

The instrument’s packaging design is subject to change. If the
instructions in this section do not apply to the packaging materials you
are using, please contact BioTek’s Technical Assistance Center.

Replace the shipping hardware before repackaging the reader. Please
contact BioTek and order part number 7130016 if you need a carrier
shipping tube, carrier shipping screw/o-ring, optic arm shipping
block/screws, or mirror holder shipping bracket/screws.

When preparing to ship the Synergy 2 and/or the dispense module to
BioTek, be sure to use the original packaging materials. Other forms of
commercially available packaging are not recommended and can void
the warranty.

The shipping materials are designed to be used no more than five times.
If the original materials have been damaged, lost, or used more than
five times, contact BioTek to order replacements.

1. Contact BioTek’s Technical Assistance Center for a Service Call Notice (SCN) number
and the shipping address before returning equipment for service.

2. Decontaminate the reader and, if attached, the dispense module, according to the
instructions provided under Decontamination starting on page 88.

3. If you will also be shipping the dispense module, perform the steps described on
page 26.

If you are not shipping the dispense module, disconnect it from the reader now.

4. If applicable, remove the tip priming trough from the microplate carrier.

5. Retract the microplate carrier. Turn off and unplug the reader.
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6. Remove the shroud and replace the shipping hardware (see the photos in Remove the
Shipping Hardware starting on page 11). Replace the shroud when finished.

7. Carefully tip the reader onto its back. Attach the shipping panel to the bottom of the
reader using the four mounting screws and washers (see the photos in Unpack and
Inspect the Synergy 2 starting on page 9).

8. Locate the original outer shipping box. Place four foam blocks in the four bottom
corners of the box. Place the inner shipping box inside the outer box.

9. Using two people, grasp the handles on the shipping panel and carefully lower the
reader into the inner shipping box.

10. Slide the cardboard insert straight down into place around the reader. Place the
accessories inside the pockets in the insert.

11. Close and seal the inner box with tape.

12. Place four foam corner blocks around the inner shipping box. Close and seal the outer
box with tape.

13. Write the SCN number on the outside of the box. Ship the box to BioTek.

Prepare the Dispense Module for Shipment

Refer to the illustrations on the next two pages when performing these steps.

1. If you have not already done so, contact BioTek’s Technical Assistance Center for a
Service Call Notice (SCN) number and the shipping address before returning
equipment for service.

2. Decontaminate the module according to the instructions starting on page 88. Be sure
to purge the dispense module of all fluid when finished.

3. With the reader on, start Gen5 and select System > Instrument Control >
Synergy 2.

4. Perform this step twice, once per dispenser: Click the Prime tab (or Dispenser tab,
if using Gen5 v2.05 or lower) and set the number (1 or 2). Click Maintenance. The
syringe bracket lowers. Remove the thumbscrew from underneath the bracket.
Carefully unscrew the top of the syringe from the syringe valve. Lift out the syringe
and store it in its original box.

5. Fully detach the dispense module from the reader. Replace the two nylon screws into
the Syringe 1 and 2 tubing ports on the rear of the reader.

6. Remove the two inlet tubes from the syringe valves and store them in their plastic
canisters.

7. Remove the two outlet tubes from the syringe valves. Attach the clear plastic fitting
shrouds to the fittings of the outlet tubes. Place the tubes in a plastic bag.

8. Place the dispense module inside the inner shipping box. Slide the cardboard shipping
insert down around the module. Pack the reagent bottle holders in bubble wrap and
place them on top of the module. Seal the box with tape.
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9. Locate the original accessories shipping box and foam end caps. Place the bottom
foam end cap into the box.

10. Place the syringes, the inlet tubes, and the outlet tubes inside the cutouts of the
bottom foam end cap in the accessories box. Place the dispense module shroud on
top of the accessories.

11. Cover the accessories with the top foam end cap, place the dispense module cable
inside the top of the end cap, and seal the box with tape.

12. Locate the original outer shipping box and foam end caps. Insert the bottom foam
end cap. Lower the dispense module box into the end cap.

13. Insert the accessories box alongside the dispense module box.

14. Insert the top foam end cap. Close and seal the outer box with tape.

15. Write the SCN number on the outside of the box. Ship the box to BioTek.
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Figure 2-15: Packing the dispense module accessories
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Figure 2-16: The inner (top) and outer (bottom) shipping boxes
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Chapter 3

Getting Started
This chapter describes some of the Synergy 2's external and internal
components, and provides an introduction to using Gen5 software to
control the instrument and, if equipped, dispense module.
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Modular Design

The Synergy 2 is a multi-mode microplate reader, with a design that allows you to initially
purchase only the modules you need and then upgrade later as your requirements expand.
Please contact BioTek Customer Care to learn more about your upgrade options.

Gen5 software is used to control the reader. If the reader is connected and turned on, Gen5
will present you with only those options that apply to your reader model. For example, if
your model is not equipped with injectors, Gen5 will not provide the option to add a
Dispense step to your assay protocol.

The table below briefly describes the available modules. The module letters form the part
number for each Synergy 2 model; for example, a reader with all modules installed is an
SLFPTAD.

Module Description

S Synergy 2 base model. Includes incubation control, shaking,
and Gen5 software.

L Luminescence

F Fluorescence Intensity, top and bottom. Includes the Tungsten-
Halogen light source.

P Fluorescence Polarization. Requires the “F” module.

T Time-Resolved Fluorescence. Requires “F” module. Includes the
high energy DPR Xenon Flash Lamp.

A UV-Visible Absorbance (monochromator-based). Includes the
SQ Xenon flash lamp.

D Dual-reagent dispenser

32 | Chapter 3: Getting Started

BioTek Instruments, Inc.



External Components

Figure 3-1: Synergy 2, front view
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Internal Components

This section introduces some internal components that may require replacement and/or
cleaning over time. Each topic provides references to other sections of this manual for
more detailed information and instructions. As discussed on page 33, not all of these
components exist in all Synergy 2 models.

Component Comments Page

Tungsten Lamp Used with the Fluorescence Intensity (F) and Fluorescence
Polarization (P) modules. May require replacement over
time.

35

Excitation and
Emission filters

The filters and filter wheels can be changed to accommodate
your assays, and filters should be cleaned periodically. Used
with the Fluorescence Intensity (F), Fluorescence
Polarization (P), Time-Resolved Fluorescence (T), and
Luminescence (L) modules.

36

Mirrors The mirrors and mirror holder can be changed to
accommodate your fluorescence assays. Mirrors may
require cleaning over time. Applies to the filter-based
Fluorescence Intensity (F), Time-Resolved Fluorescence (T),
and Fluorescence Polarization (P) modules. The mirror
holder is accessible via a door on the left side of the reader.

Warning! Do not put your hand in the
side door during operation; doing so
presents a potential pinch hazard.

37

Injection System The syringes may require replacement over time. The tubing
and internal reading chamber may require cleaning over
time. Applies to models with the dual reagent dispense
module.

38
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Tungsten Lamp

Synergy 2 models with the Fluorescence Intensity and/or Fluorescence Polarization
modules are equipped with a Tungsten lamp. The lamp is accessed through a hinged door
on the front of the instrument. To open the door, press on its lower left and right corners
until the door opens downward. The lamp is on the left, behind a light shield with a hot
surface warning label.

Figure 3-2: Locating the replaceable Tungsten lamp

The Tungsten lamp is expected to operate without replacement for a minimum of 1000
hours. The intensity of the bulb will slowly drop over time until the reader’s System Test
detects a low signal and displays an error message. In addition, error code 2901 may be
displayed during normal operation. The lamp should be replaced at this time; contact
BioTek and order part number 7080500. Turn to page 93 for replacement instructions.

Keep the front door closed during operation. The intense broad spectrum
light of the xenon lamp can cause eye damage. The light shield shown
above mitigates the risk.
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Excitation/Emission Filters

Synergy 2 models with the Fluorescence Intensity module are equipped with Excitation and
Emission filter wheels. (Models with the Luminescence module without Fluorescence
Intensity have an Emission filter wheel only.) The filter wheels are labeled as “EX” or “EM”
and are accessed through a hinged door on the front of the instrument. To open the door,
press on its lower-left and -right corners until the door opens downward.

Figure 3-3: Locating the excitation and emission filter wheels

Each filter wheel contains four equal-sized positions. Each position can contain a glass filter
or a light-blocking plug, or can be left empty. Filter wheel contents can be changed, as well
as entire filter wheels. See Filters and Mirrors starting on page 47 for information on
working with the filter wheels, and for a list of filters available from BioTek.

The Synergy 2 is shipped with a set of excitation and emission filters
installed, and the reader’s onboard software is preconfigured with the
filter values and their locations.

If you change the contents of a filter wheel, you must update
Gen5’s filter table and then download the information to the
reader. The Synergy 2 does not automatically detect which filters are
installed.

See page 41 for information on updating Gen5’s filter table.
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EX/EM Configuration for Luminescence

For best results when taking luminescence measurements, the Excitation filter wheel (if
equipped) should have no empty locations.

If your tests require that the light emitted from the samples remain unfiltered, the
Emission filter wheel should have an empty location in it. When selecting a filter set for
a read in Gen5, selecting "Hole" indicates the empty location.

Mirrors

When taking fluorescence (FI, FP, or TRF) measurements from the top, the Synergy 2 uses
mirrors to direct the excitation and emission light paths. The mirrors are stored in a mirror
holder, which is a rectangular box located inside the reader. The holder stores up to three
mirrors. There are two possible mirror types:

l A 50%mirror is a glass slide with silver dots (see #1 below). It works with any
wavelength in the range of 200 to 850 nm.

l A dichroic mirror is wavelength specific; it requires the excitation and emission
filters to fall within specific ranges. Dichroic mirrors provide better sensitivity than
50% mirrors, but they are dye-specific.

The default mirror configuration is shown below (any changes should be reflected in your
sales order). A 50% mirror is easily identified by its “dots,” and each dichroic mirror is
etched or labeled with its wavelength value.

Figure 3-4: Identifying the mirrors in the mirror holder (default
configuration shown). Models with the Fluorescence Polarization
module also have EX polarizing filters in the mirror holder, as

shown inside the oval above.

The entire mirror holder and the individual mirrors are user-changeable. Because the
mirrors can be easily smudged or even damaged, however, BioTek strongly recommends
changing the entire mirror holder. Contact BioTek for more information on purchasing
additional mirrors and holders.
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To learn more about how mirrors are used, and how to change or clean them, see Filters
and Mirrors starting on page 47.

Do not open the side door to access the mirror holder during instrument
operation. Doing so may result in invalid data.

The Synergy 2 is shipped with a mirror holder installed, and the reader’s
onboard software is preconfigured with the mirror values and their
locations.

If you change the contents of a mirror holder, you must update
Gen5’s mirror table and then download the information to the
reader. The Synergy 2 does not automatically detect which mirrors are
installed.

See page 41 for information on updating Gen5’s mirror table.

Injection System

External Dispense Module

If a syringe is leaking, it may need to be replaced. See As-Needed Maintenance
starting on page 87 for instructions.

The dispense module pumps fluid from the supply bottles to injector heads located inside
the instrument. Fluid is injected into one well at a time.
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Figure 3-5: Dispense module components

1 Two 250-µL syringes draw fluid from the supply bottles.

2 Inlet tubes transport fluid from the supply bottles to the syringes. These tubes
are short pieces of opaque PTFE (Teflon) tubing connected to stainless-steel
probes on one end and threaded fittings on the other end.

3 Valves switch the syringe flow from the inlet tubes to the outlet tubes.

4 Outlet tubes transport fluid from the syringes into the instrument, through the
tubing ports on the reader's rear panel. The outlet tubes are opaque PTFE
tubes with threaded fittings on each end.

Avoid continuous contact with harsh chemicals. Rinse the fluid path with
deionized water after contact with any strong acid, base, or solvent.

For information on the materials used in the injection system, refer to
Injection System—Chemical Compatibility Technical Note on the
USB flash drive supplied with the Synergy 2.
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Internal Tubing

Inside the reader, two Teflon tubes transport fluid from the tubing ports on the rear of the
instrument to the two injectors. As shown below, both injectors are positioned directly above
the bottom fluorescence optical probe.

Figure 3-6: Injectors inside the reader

The tubing and injectors should be cleaned at least quarterly. See Preventive
Maintenance starting on page 65 for more information.

Priming the Injection System

Before running a Dispense assay, prime the system with the reagent or dispensing fluid.
Additionally, tip priming can be performed at the start of the assay and, sometimes, just
before each dispense to a well. The tip prime compensates for any fluid loss at the injector
tip due to evaporation since the last dispense. All priming activities are controlled via
Gen5.

Both types of primes require a fluid reservoir to be present on the microplate carrier (see
Figure 2-14 on page 23):

l The priming plate is placed on the microplate carrier for a Prime operation (to prime
the dispense system with fluid).

l The tip priming trough is a small, removable cup located in the left rear of the
carrier, and is used for performing the tip prime before dispensing. The trough holds
up to 1.5 mL of liquid and must be periodically emptied and cleaned by the user.

i Do not perform tip priming when using tall plates. Generally, plates with fewer than
96 wells are too tall for error-free tip priming; tip priming is rarely required for these
larger-volume plates.
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Gen5 Software

Gen5 supports all Synergy 2 models. Use Gen5 to control the reader, the dispense module
(if equipped), and the BioStack (if equipped); perform data reduction and analysis on the
measurement values; print or export results; and more. This section provides brief
instructions for working with Gen5 to create protocols and experiments and read plates.
Refer to the Gen5 Getting Started Guide and the Help system for more information.

Define Excitation/Emission Filters in Gen5 and on the Reader

For models equipped with filter wheels, the reader’s onboard software is configured with
the filter values and their locations in the installed filter wheels. When Gen5 communicates
with the reader, it "asks" for this information and then stores the values in a Filter Table.

Important! It is critical that the values in the Gen5 Filter Table and in
the reader's software exactly match the contents of the installed filter
wheels.

If you exchange or modify the filter wheels, update the Gen5 Filter Table and send the
information to the reader:

1. In the Gen5 main view, select System > Instrument Configuration. Highlight the
Synergy 2 reader, click View/Modify and then click Setup.

2. In the Fluorescence / Luminescence tab, define/modify information for the Excitation
and Emission filter wheels. For each position (1–4) in each filter wheel:

l Select Band Pass to indicate a filter and then enter the Wavelength and
Bandwidth (printed on the side of the filter)

l Select Plug to indicate a Plug ("dummy filter")

l Select Hole to indicate an empty position

3. When finished, click Send Values to transfer the information to the reader.

Define the Mirrors in Gen5 and on the Reader

For models equipped with a mirror holder, the reader’s onboard software is configured with
the mirror types, their characteristics, and their position in the installed mirror holder.
When Gen5 communicates with the reader, it "asks" for this information and then stores
the values in a Mirror Table.

Important! It is critical that the values in the Gen5 Mirror Table and in
the reader's software exactly match the contents of the installed mirror
holder.
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If you exchange or modify the mirror holder, update the Gen5 Mirror Table and send the
information to the reader:

1. In the Gen5 main view, select System > Instrument Configuration. Highlight the
Synergy 2 reader, click View/Modify and then click Setup.

2. In the Mirrors tab, define/modify information for the mirror holder. For each mirror
position (1, 2, 3; see Figure 4-3 on page 54), use the drop-down list to select the
Type of mirror. For dichroic mirrors, enter the excitation and emission wavelength
ranges.

3. When finished, click Send Values to transfer the information to the reader.

Protocols and Experiments

In Gen5, a protocol contains instructions for controlling the reader and (optionally) for
analyzing data retrieved from the reader. At a minimum, a protocol must specify the
procedure for the assay you wish to run. After creating a protocol, create an experiment
that references the protocol. You’ll run the experiment to read plates and analyze the data.

These instructions briefly describe how to create a protocol in Gen5. See the Gen5 Help
system for complete instructions.

1. In the Gen5 Task Manager, select the Protocols icon and click Create New.

2. Open the Procedure dialog (double-click Procedure in the menu tree).

3. Select an appropriate Plate Type.

4. Add steps to the procedure to shake or heat the plate, dispense fluid, read the plate,
and more.

5. Click Validate to verify that the attached reader supports the defined steps, and
then close the Procedure dialog.

6. Optionally, perform any of these steps to analyze and report the results:

l Open the Plate Layout dialog and assign blanks, samples, controls, and/or
standards to the plate.

l Open the Data Reduction dialog to add data reduction steps. Categories include
Transformations, Well Analysis, Curve Analysis, and Qualitative Analysis.

l Create a report or export template via the Report/Export Builders.

7. Select File > Save and give the protocol an identifying name.

These instructions briefly describe how to create an experiment and then read a plate in
Gen5. See the Gen5 Help system for complete instructions.

1. In the Gen5 Task Manager, select the Experiments icon and click Create using an
existing protocol.

2. Select the desired protocol and click OK.

3. Select a plate in the menu tree and select Plate > Read Plate # or click the Read
New icon.
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4. When the read is complete, measurement values appear in Gen5.

5. Select File > Save and give the experiment an identifying name.

Dispense Module Control

Applies only to models equipped with injectors

Gen5 is used to perform several dispense functions, such as initialize, dispense, prime, and
purge. The Prime and Purge functions are introduced here; refer to the Gen5 Help system
for additional information.

Prime

Before running an experiment with a Dispense step, prime the system with the fluid to
be used.

1. Place the priming plate on the carrier.

2. Fill the supply bottle with a sufficient volume of the fluid to be used for the prime
and the assay. Insert the appropriate inlet tube into the bottle.

3. Select System > Instrument Control > Synergy 2 and click the Prime tab.

4. Select the Dispenser number (1 or 2) associated with the supply bottle.

5. Enter the Volume to be used for the prime. The minimum recommended prime
volume is 2000 μL.

6. Select a prime Rate, in μL/second.

7. Click Prime to start the process. When finished, carefully remove the priming
plate from the carrier and empty it.

If the priming plate is empty, the prime volume was too low.

Purge

To conserve reagent, Gen5 provides the option to purge fluid from the system back into
the supply bottle.

1. Select System > Instrument Control > Synergy 2 and click the Prime tab.

2. Select the Dispenser number (1 or 2) associated with the supply bottle.

3. Enter the desired purge Volume in μL (e.g., 2000).

4. Select a prime Rate in µL/secon.

5. Click Purge to start the process.
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Recommendations for Optimum Performance

General

Microplates should be clean and free from dust or bottom scratches. Use new
microplates from sealed packages. Do not allow dust to settle on the surface of the
solution; use microplate covers or seals when not reading the plate. Filter solutions to
remove particulates that could cause erroneous readings.

Before preparing your microplates, make sure the reader is on and communicating with
Gen5. You may want to run a System Test if the reader has not been turned off/on in a
few days. Design your Gen5 protocol in advance as well, to ensure that the intended
reading parameters are used and to avoid any last-minute corrections.

Although the Synergy 2 supports standard flat, U-bottom, and V-bottom microplates,
the reader achieves optimum performance with flat-bottomed wells. See
Specifications starting on page 155 for more information on the supported plates.

Non-uniformity in the optical density of the well bottoms can cause loss of accuracy,
especially with U- and V-bottom polyvinyl microplates. Check for this by reading an
empty microplate. Dual wavelength readings can eliminate this problem, or bring the
variation in density readings to within acceptable limits for most measurements.

Inaccuracy in pipetting has a large effect on measurements, especially if smaller
volumes of liquid are used. For best results in most cases, use at least 100 µL per well
in a 96-well plate, 25 µL in a 384-well plate, and 5 µL in a 1536-well plate (if supported).

Pipetting solution into 384- [and greater] well plates often traps air bubbles in the wells,
which may result in inaccurate readings. A dual-wavelength reading method usually
eliminates these inaccuracies. For best results, however, remove the air bubbles by
degassing the plate in a vacuum chamber or spinning the plate in a centrifuge before
reading.

The inclination of the meniscus can cause loss of accuracy in some solutions, especially
with small volumes. Shake the microplate before reading to help bring it within
acceptable limits. Use Tween 20, if possible (or some other wetting agent) to normalize
the meniscus for absorbance measurements. Some solutions develop menisci over a
period of several minutes. This effect varies with the brand of microplate and the
solution composition. As the center of the meniscus drops and shortens the light path,
the density readings change. The meniscus shape will stabilize over time.

Use of liquids with concentrations of acids, corrosives, or solvents of 3% and greater
can begin attacking the materials inside the instrument’s chamber. Running multiple
plates with concentrations <3% in long kinetics may also have a destructive effect. If
the experiment is incubated, deterioration of chamber components will be accelerated.
When in doubt about the use of acids, corrosives, or solvents; please contact
TAC@biotek.com.
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It is the user’s responsibility to understand the volumetric limits of the plate type in use
as it applies to the assay being run.

Luminescence Measurements

For highly sensitive Luminescence assays using white plates, add a Delay step to your
Procedure to “dark adapt” the plates in the reading chamber before taking
measurements.

Models with Injectors

To keep the dispense system in top condition, flush and purge the fluid lines with
deionized (DI) water every day or upon completion of an assay run, whichever is more
frequent. Some reagents may crystallize or harden after use, clogging the fluid
passageways. Flushing the tubing at the end of each day, letting the DI water soak, and
then purging the lines at the beginning of each day ensures optimal performance of the
dispense system. See the Preventive Maintenance chapter for more information.

When dispensing volumes less than or equal to 20 µL/well, we recommend specifying a
tip prime volume that is equal to the dispense volume. For dispense volumes greater
than 20 µL/well, we recommend a tip prime volume of 20 µL.

To avoid spillage and possible contamination of the instrument, empty the tip prime
trough frequently and do not exceed the total fluid volume of the plate well when
dispensing.

Incubation and Partial Plates

When performing a partial plate read that includes an incubation step, the following
recommendations can reduce the effects of evaporation of your samples:

l Use microplate lids.

l Fill unused wells with liquid.

l Cluster your sample wells rather than spacing them throughout the plate.

l Place your sample wells in the center of the plate. This placement may lead to less
evaporation than if you place the samples in wells on the edge of the plate.
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Chapter 4

Filters and Mirrors
The Getting Started chapter provided an overview of the filters and
mirrors installed in some Synergy 2 models. This chapter provides more
detailed information on working with these components.
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Clean the Filters 50
Filters Available from BioTek 51

Mirrors 53
Change the Mirror Holder and Mirrors 56
Clean the Mirrors 63
Mirrors Available from BioTek 64



Excitation/Emission Filters

As described on page 36, Synergy 2 models with the Fluorescence Intensity module are
equipped with Excitation and Emission filter wheels. (Models with the Luminescence
module without Fluorescence Intensity have only an Emission filter wheel.) The Excitation
filter selects the band of light to which the sample will be exposed. The Emission filter
selects the band of light with the maximum fluorescence signal of the sample, to be
measured by the photomultiplier tube (PMT). The filter wheels are accessed by opening the
hinged door on the front of the reader, as shown in Figure 3-3 on page 36.

Each filter wheel is labeled EX or EM, and can contain up to four filters and/or black plugs
(also referred to as "dummy filters"). A filter can be used in either wheel, but it must be
oriented properly, as described below. Each filter and plug is held securely in place with a
C-clip filter retainer. Each filter has its wavelength and bandpass values printed on its side,
with an arrow to indicate the proper direction of light through the filter.

Figure 4-1: Diagram showing the proper orientation of the filters
in their wheels
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Change the Filter Wheels and Filters

The filter wheels are easily exchanged or modified to meet your assay requirements. If
you regularly need to change the filters on the reader, consider purchasing additional filter
wheels from BioTek to make the process easier and faster.

As shown in Figure 3-3, labels on the front of the filter wheels can be marked with the
central wavelength and band pass of each filter.

When exchanging/modifying filter wheels:

l The Excitation and Emission filter wheels are not interchangeable and are labeled EX
= Excitation, EM = Emission.

l Filter direction within each filter wheel is important, and the direction differs
depending on the filter wheel type. A diagram on the inside of the reader’s front
panel door indicates orientation.

l Each filter is marked with an arrow indicating the correct direction of light through
the filter. Filters are not specific to either excitation or emission.

l We recommend placing filters in the wheels in ascending wavelength order from
position 1 to 4 (no holes in EX2 or EM3), particularly if the reader has generated a
0508 (saturation) error.

Important! It is critical that the filter wheel characteristics defined in
Gen5 and on the reader exactly match the contents of the installed filter
wheels. If you exchange or modify a filter wheel, update its definition in
Gen5 and send the new values to the reader. Instructions are provided
on page 41.

To remove a filter wheel:

1. Using your thumbs, push down on the bottom corners of the hinged door on the front
of the reader to open the door.

2. Observe the two thumbscrews within the compartment. The left thumbscrew secures
the Excitation filter wheel; the right secures the Emission filter wheel.

3. Remove the thumbscrew and slide the filter wheel’s supporting metal bracket
straight out of the compartment. Note: The Emission filter wheel “springs” out when
removed (a shutter behind the wheel closes quickly to protect the PMT).

To install a filter wheel:

1. Ensure that all filters and/or plugs are inserted properly (see Figure 4-1).

2. Slide the filter wheel into its chamber.

3. Replace the thumbscrew and close the front door.

4. Important! If you modified the filter wheel's contents, use Gen5 to update the
reader’s internal software with the new configuration; see instructions on page 41.
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When removing or replacing a filter or C-clip retainer, do not use a sharp
tool. Use several layers of lens paper and your finger to remove and
replace filters and clips. Using a sharp object, such as a flat screwdriver,
will scratch the filter surface and make it unusable. Do not touch the
filters with your bare fingers.

To remove a filter or plug:

1. Remove the filter wheel as instructed above.

2. Turn the filter wheel to align the desired filter with the hole in the supporting bracket.

3. Place the bracket on a flat surface, with the filter wheel facing down.

4. Prepare a multi-layered “cushion” of lens paper. Using your finger covered with the
lens paper, gently push against the filter and its retainer until they pop out.

To replace a filter or plug:

1. Hold the metal bracket with the filter wheel facing up.

2. Orient the filter or plug (see Figure 4-1): Observe the arrow on the filter indicating
the light direction. Align the filter’s wavelength number with the window in each filter
holder, then drop it into the desired location.

Make note of the filter position number, 1–4.

3. Using your fingers, squeeze the sides of the C-clip retainer, and then insert it into the
top of the hole containing the new filter. Cover your finger with several layers of lens
paper, and then push down on all sides of the retainer until it sits flush against the
filter.

4. Gently wipe both sides of the filter with lens paper.

5. When finished, install the filter wheel.

Clean the Filters

Instructions are provided in Chapter 5, Preventive Maintenance.
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Filters Available from BioTek

Bandpass filters are available for purchase from BioTek. Please note that part numbers are
subject to change, and new filters may become available. Custom filters are also available.
Contact BioTek Customer Care with any questions.

PN Wavelength Main Application

7082259 284/10 Tryptophan excitation

7082248 310/20 Tyrosine emission, O-aminobenzoyl excitation

7082250 320/20 7-methoxycoumarin and Quanta Blu excitation

7082263 330/80 HTRF excitation

7082254 340/11 Fura-2 excitation

7082230 340/30 NADH excitation and tryptophan emission

7082220 360/40 MUB, caspace-3, europium chelate excitation

7082228 380/20 Fura-2 and EBFP excitation

7082242 400/10

7082205 400/30 Porphyrin excitation, O- aminobenzoyl and 7-methoxycoumarin
emission

7082206 420/50 CFP excitation and Quanta-Blu emission

7082227 440/30 Attophos excitation and caspace-3 emission

7082207 440/40 NADH emission

7082208 450/50 CBQCA excitation

7082222 460/40 NanoOrange excitation and EBFP and MUB emission

7082221 485/20 Fluorescein, EGFP excitation and CFP emission

7082209 485/40 Propidium Iodide excitation

7082256 500/27 YFP excitation

7082218 508/20 Fura-2 emission

7082246 516/20 EGFP emission

7082247 528/20 VIC excitation and Fluorescein and EGFP emission

7082223 530/25 5-Tamra excitation

7082249 540/25 Alexa Fluor 546, CY3, and rhod2 excitation and EYFP emission

7082253 540/35 Alamar Blu, Amplex red, RFP excitation

7082210 545/40 Rhodamine B excitation

7082215 560/15 Cell Titer Blue excitation

7082211 560/20 VIC emission

7082212 560/40 Attophos and CBQCA emission

Synergy 2 Operator's Manual

Excitation/Emission Filters | 51



PN Wavelength Main Application

7082264 570/100 AlphaScreen emission

7082245 575/15 ROX excitation and CY3 and 5-Tamra emission

7082244 580/50 NanoOrange and Attophos emission

7082225 590/20 Alexa Fluor 594 and Texas Red excitation and Cell Titer Blue
emission

7082224 590/35 Rhod-2, Alexa Fluor 546, and CY3 emission

7082252 600/40 Alamar Blu, Amplex Red, RFP and porphyrin emission

7082265 620/10 HTRF / LANCE emission

7082251 620/15 ROX and Alexa Fluor 594 emission and Alexa Fluor 633 excitation

7082213 620/40 Rhodamine B, europium chelate emission, CY5 excitation

7082214 635/32 Texas Red emission

7082257 645/15 Alexa Fluor 633 emission

7082266 665/7.5 HTRF / LANCE emission

7082226 645/40 Texas Red and Propidium iodide emission

7082229 680/30 CY5 emission, AlphaScreen excitation

The fluorescence ratio associated with the HTRF readout is a correction method developed
by CIS bio and covered by the US patent 5,527,684 and its foreign equivalents, for which
CIS bio has granted a license to BioTek. Its application is strictly limited to the use of HTRF
reagents and technology, excluding any other TR-FRET technologies.
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Mirrors

For top-reading fluorescence analysis, the Synergy 2 uses mirrors to direct the excitation
and emission light paths. Mirrors are required for fluorescence polarization (FP)
measurements to direct light to the sample, because fibers cannot carry polarized light.
Mirrors also provide increased gain/sensitivity for fluorescence intensity (FI) and time-
resolved fluorescence (TRF) measurements when compared to mapped fiber optics.

Mirrors are stored in a three-mirror holder (additional mirror holders and mirrors can be
purchased as accessories). The holder and individual mirrors can be changed to meet your
requirements. You can replace the entire holder with a different one; this is the BioTek
recommended option. Alternatively, you can install different mirrors in the holder. Contact
BioTek for more information on purchasing mirrors and holders.

For Synergy 2 models with the FP module, the reader is equipped with three polarizers:

l Excitation polarizer (visible-range or UV-range)

l Emission polarizer, parallel to excitation polarizer

l Emission polarizer, perpendicular to excitation polarizer

Inside the reader, the mirror holder is labeled with five position numbers which translate to
three possible measurement positions. See Figure 4-2 and Figure 4-3.

The third measurement position is dedicated to FP, because it holds the polarizers. It is
twice the size of positions 1 and 2, and it is numbered 3, 4, 5 in the reader. Gen5
recognizes only the three measurement positions. FI and TRF can be performed using
position 3 as well. See Figure 4-4 for a close-up view of measurement position 3.

When running an experiment, Gen5 communicates with the reader to move the holder to
the proper position based on the mirror you define in a Read step in the Gen5 protocol.
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Figure 4-2: Mirror holder disengaged from the reader

Figure 4-3: Mirror holder diagram; the three reading positions
are indicated

Position 1 in the mirror holder has an emission UV-blocking filter. It
transmits light above 380 nm and blocks light below 360 nm. If you are
using a 50% mirror and an excitation above 360 nm, for best results
place the 50% mirror in position 1 (the default location). If emission of
your assay is below 380 nm, do not use position 1 for these
measurements; move the 50% mirror to position 2.
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Models with the FP module: The polarizers are always installed in positions 4 and 5,
which translates to Mirror #3 in Gen5.

This diagram shows Position 3 in
the mirror holder. It holds the
polarizer filters required for
Fluorescence Polarization. It is the
only mirror position that can be
selected for an FP read. It can also
be selected for FI and TRF, which
use the open positions.

Figure 4-4: Mirror holder, Position 3 diagram

Two types of excitation (EX) polarizers are available: visible-range (400 nm and above, the
default) or UV-range (300 nm and above, available from BioTek). The visible-range
polarizer’s bracket is etched with “400 nm”. The emission (EM) polarizers are installed
inside the reader, in the mirror holder’s top plate.

The default mirror holder configuration is described here; your reader may be configured
differently. Turn to page 64 for a list of mirrors available from BioTek.

Position
#

Mirror
#

Mirror
Type Polarizers EX Range

(nm)
EM Range
(nm) Use

1 1 50% none 200–850 200–850 FI, TRF

2 2 400 nm
dichroic none 320–390 410–800 FI, TRF

3

3 510 nm
dichroic

none

440–505 515–640

FI, TRF

4 EX (visible-range)
parallel EM

FP
5 EX (visible range)

perpendicular EM
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Change the Mirror Holder and Mirrors

Do not touch the mirrors with your bare fingers, and only touch them
along their edges. These optical elements are delicate and must be
handled carefully. The glass and anti-reflective (AR) coated surfaces are
damaged by any contact, especially by abrasive particles. Wear cloth
gloves to reduce the risk of damaging the mirrors and polarizing filters.
For cleaning instructions see Inspect/Clean Mirrors on page 71.

Important! It is critical that the mirror holder characteristics defined in
Gen5 and on the reader exactly match the contents of the installed
mirror holder. If you exchange or modify the mirror holder, update its
definition in Gen5 and send the new values to the reader. Instructions
are provided on page 41.

Because dichroic mirrors are wavelength-specific, it may be necessary to change the
mirror holder before performing certain assays. BioTek offers additional mirror holders
and mirrors as separate accessories.

Mirrors and polarizing filters are easily damaged. If more than three unique mirrors are
used in your lab, the preferred method is to use multiple mirror holders, which can be
exchanged as needed. BioTek offers additional mirror holders and mirrors as separate
accessories.

Removing the mirror holder from the reader is required in either scenario. Before
removing the holder, take a moment to identify the reader’s components that are
described in the following procedures; see Figure 4-5.
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Figure 4-5: Mirror holder positioned for removal

To remove the mirror holder

The mirror holder is held in place by two shipping screws. These screws can be
removed and stored for easy replacement of the mirror holder through the
side-access door. For more information on using the side-access door, see
page 62.

1. Turn off the reader and remove its shroud (see instructions and photos on page 11).

2. The mirror holder will likely be stored in its “home” position; you’ll need to move it to
an accessible position. Use the holder’s belt drive (see Figure 4-6) to roll the holder
(to the left) away from the optics armature. Use your thumb to turn the belt
counterclockwise.
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Figure 4-6: Turning the belt drive to position the holder for
removal

3. When the mirror holder is fully exposed, carefully remove the two screws and
washers on top (see Figure 4-5), and set them aside. The holder will continue to be
held in place by its magnetized frame.

4. Grasp the handle (if equipped), or the sides of the holder underneath the top plate.
Pull the holder down and toward the back of the reader to remove it.

Figure 4-7: Mirror holder removed from reader
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If you accidentally touch the mirrors or polarizing filters with your bare
fingers, see Inspect/Clean Mirrors starting on page 71 for cleaning
instructions.

To change a mirror in the mirror holder

Gather these tools:

l Linen or cloth gloves

l Small screwdriver

i Touch the mirrors as minimally as possible; hold them by their edges only.
The mirrors are easily damaged.

1. Remove the mirror holder from the reader.

2. The holder has a light shield to protect the mirrors (Figure 4-8). Use a screwdriver to
remove the four screws and washers that attach this shield to the holder.

3. Use the screwdriver to remove the bracket that secures the mirrors (Figure 4-9). Set
aside the screws. Lift the bracket away from the holder and set aside.

4. Grasping the mirror by its edges, remove it from the holder and store it properly.

5. Holding the replacement mirror by its edges, turn the mirror so its label is face-up
and readable. Align it in this orientation when you insert it into the holder.

6. Replace the metal bracket to secure the mirror. The bend in the bracket’s arms
should point away from the holder.

7. Replace the light shield.

i The light shield fits the holder in only one way. Check its alignment when
reattaching it to the mirror holder.

8. Reinstall the mirror holder (see instructions in the next section).

9. Important! Update Gen5 and the reader with the new mirror configuration.
Instructions are provided on page 41.
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Figure 4-8: Removing the light shield from the mirror holder

Figure 4-9: Mirror orientation; labels are face-up and readable
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Figure 4-10: Mirror holder with shield removed

To reinstall the mirror holder

1. Hold the mirror holder with the alignment pins on top and the filter windows facing
you. This is the holder’s orientation inside the reader.

2. Inside the reader, put the mirror holder underneath its top plate (see Figure 4-5).
The holder’s alignment pins will help guide it into place and because it is magnetized
the holder will stay in place.

3. (Optional) Reinstall the two sets of screws and washers that secure it in the reader.
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Figure 4-11: Mirror holder positioned for reinstallation

To exchange the mirror holder through the side-access door

The mirror holder shipping screws must be removed and stored before the holder can be
removed through the side-access door. See page 57.

1. If the instrument is off, turn it on. Otherwise, perform a System Test.

2. If the carrier is extended outside the instrument, press the carrier eject button to
retract the carrier.

3. Open the side-access door and pull the mirror holder (using the handle, if equipped)
toward the door. You will detect a rough vibration as you pull against the stepper
motor holding torque. This will not damage any components.

4. Pull down on the mirror holder to disengage it from the magnets and then pull it out
of the instrument.

5. Re-install the replacement mirror holder in the reverse order. The holder has
alignment pins to guide it into position. Once the holder is seated, you do not need to
push it back into place.

6. Important! Update Gen5 and the reader with the new mirror configuration. See
instructions on page 41.

7. Run a System Test. When finished, the new mirror holder is ready for use.
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To install the mirror block handle

If your mirror holder is not equipped with a handle, you can order one from BioTek (see
Optional Accessories on page 4). The handle ensures that you do not damage or get
fingerprints on the mirrors and polarizers. Attach the handle as shown below. The
optional label can be used to identify the mirror types.

Figure 4-12: Attaching the handle to the mirror block

Clean the Mirrors

Instructions for cleaning the mirrors and polarizers (if equipped) are provided on page 71.
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Mirrors Available from BioTek

Part numbers are subject to change, and new mirrors may become available. Contact
BioTek Customer Care with any questions.

l Half-Size mirrors fit into positions 1 and 2 of the mirror holder

l Full-Size mirrors fit into position 3

Half-Size
Part #

Full-Size
Part #

Cut-off
(nm)

Excitation
Range

Emission
Range

Applications

7132121 n/a 50% 200–850 200–850 All except FP

7138365 n/a 365 290–350 380–800 HTRF, MMP, Quanta Blu

7138400 7137400 400 320–390 410–800 MUB, Europium, Hoechst 33258

7138455 7137455 455 400–450 460–710 Attophos, CFP, Fluo-3

7138510 7137510 510 440–505 515–640 Fluorescein, Picogreen, FAM

7138525 7137525 525 475–520 530–670 Rhodamine 123, YFP

7138550 7137550 550 415–540 560–850 CY3, HEX, Rhodamine 6G

7138570 7137570 570 515–565 575–735 Alamar Blu, Amplex Red, TAMRA

7138595 7137595 595 540–590 600–770 ROX, Texas Red

7139635 n/a 635 640–780 400–630 AlphaScreen

7138660 7137660 660 580–655 665–850 CY5
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Chapter 5

Preventive Maintenance
This chapter provides instructions for maintaining the Synergy 2 and
external dispense module (if used) in top condition, to ensure that they
continue to perform to specification.

Overview 66
Recommended Maintenance Schedule 67
Warnings and Precautions 68
Clean Exposed Surfaces 69
Inspect/Clean Excitation and Emission Filters 70
Inspect/Clean Mirrors 71
Flush/Purge Fluid Path 73
Run a Dispense Protocol (Optional) 74
Empty/Clean the Tip Priming Trough 75
Clean the Priming Plate 75
Clean the Internal Components 75



Overview

A general Preventive Maintenance (PM) regimen for the Synergy 2 includes periodically
cleaning all exposed surfaces and inspecting/cleaning the excitation and emission filters.
For models with the external dispense module, additional tasks include flushing/purging
the fluid path and cleaning the tip prime trough, priming plate, supply bottles, internal
dispense tubing, and injector heads.

Daily Cleaning for the Dispense Module

To ensure accurate performance and a long life for the dispense module and injectors,
flush and purge the fluid lines with deionized (DI) water every day or after completing an
assay run, whichever is more frequent. Some reagents may crystallize or harden and then
clog the fluid passageways. Take special care when using molecules that are active at very
low concentrations (e.g., enzymes, inhibitors). Remove any residual reagent in the
dispense lines using a suitable cleaning solution (review the reagent’s package insert for
specific recommendations).

Flushing the tubing at the end of each day, letting the DI water soak overnight, and then
purging the lines at the beginning of each day ensures optimal performance of the dispense
system. BioTek recommends performing a visual inspection of the dispense accuracy
before running an assay protocol that includes dispense steps.

BioTek also recommends flushing the module with DI water before conducting the
decontamination procedure described in the As-Needed Maintenance chapter.

Models with injectors: Accumulated algae, fungi, or mold may require
decontamination. See the As-Needed Maintenance chapter for
instructions.
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Recommended Maintenance Schedule

The table below contains the recommended Preventive Maintenance tasks for Synergy 2
and the frequency with which each task should be performed.

The risk and performance factors associated with your assays may
require that some or all of the Preventive Maintenance procedures be
performed more frequently than shown here.

Task Daily Quarterly As Needed

All models:

Clean exposed surfaces ü

Inspect/clean excitation and emission filters (if
equipped)

ü

Inspect/clean mirrors (if equipped) annually

Decontaminate the instrument before shipment or storage

Models with injectors and an external dispense module:

Flush/purge the fluid path ü

(Optional) Run a Dispense protocol ü

Empty/clean tip prime trough ü

Clean priming plate ü

Clean internal components ü ü
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Warnings and Precautions

Warning! Internal Voltage. Turn off and unplug the instrument for all
maintenance and repair operations.

Warning!Wear protective gloves when handling contaminated
instruments. Gloved hands should be considered contaminated at all
times; keep gloved hands away from eyes, mouth, nose, and ears.

Warning! Mucous membranes are considered prime entry routes for
infectious agents. Wear eye protection and a surgical mask when there
is a possibility of aerosol contamination. Intact skin is generally
considered an effective barrier against infectious organisms; however,
small abrasions and cuts may not always be visible. Wear protective
gloves when handling contaminated instruments.

Caution! The buildup of deposits left by the evaporation of spilled fluids
within the read chamber can impact measurements. Be sure to keep
System Test records before and after maintenance so that changes can
be noted.

Warning! The Tungsten lamp assembly is hot when the instrument is
powered on. If the instrument is on, turn it off and allow the lamp to
cool down before attempting to replace it.

Warning! The instrument with all available modules weighs up to 57
pounds (25.8 kg) depending on the model. Use two people when lifting
and carrying the instrument.

Important! Do not immerse the instrument, spray it with liquid, or use
a dripping-wet cloth on it. Do not allow water or other cleaning
solution to run into the interior of the instrument. If this
happens, contact BioTek’s Technical Assistance Center.

Important! Do not apply lubricants to the microplate carrier or carrier
track. Lubricant attracts dust and other particles, which may obstruct
the carrier path and cause errors.
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Clean Exposed Surfaces

Exposed surfaces may be cleaned (not decontaminated) with a cloth moistened (not
soaked) with water or water and a mild detergent.

You will need:

l Deionized or distilled water

l Clean, lint-free cotton cloths or paper towels

l Mild detergent (optional)

Procedure:

1. Important! Turn off and unplug the instrument.

2. Wet a cloth or paper towel with water, or with water and mild detergent, and then
thoroughly wring it out so that liquid does not drip from it.

3. Wipe the plate carrier and all exposed surfaces of the instrument.

4. Wipe all exposed surfaces of the dispense module (if used).

5. If detergent was used, wipe all surfaces with a cloth moistened (not soaked) with
water.

6. Use a clean, dry cloth to dry all wet surfaces.

Models with injectors: If the tip priming trough overflows or other spills occur inside
the instrument, wipe the carrier and the surface beneath the carrier with a dry cotton
cloth. If overflow is significant, you may need to remove the reader's shroud and the
incubator housing to better access the interior; see instructions starting on page 75.
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Inspect/Clean Excitation and Emission Filters

Applies only to models with fluorescence and/or luminescence capability

BioTek recommends inspecting the filters for dust and other debris every three months. To
clean them, you will need:

l Isopropyl, ethyl, or methyl alcohol

l 100% pure cotton balls or high-quality lens-cleaning tissue

l Cloth gloves

l Magnifying glass

Do not touch the filters with your bare fingers.

1. Turn off and unplug the instrument.

2. Pull down the hinged door on the front of the instrument. Observe the two
thumbscrews within the compartment. The left thumbscrew holds the excitation (EX)
filter wheel in place; the right secures the emission (EM) filter wheel. Remove each
thumbscrew and pull the filter wheel out of the compartment.

The Filters and Mirrors chapter contains illustrations for identifying the
filters and their unique characteristics. It also contains instructions for
replacing filters, if necessary.

3. Inspect the glass filters for speckled surfaces or a “halo” effect. This may indicate
deterioration due to moisture exposure over a long period of time. If you have any
concerns about the quality of the filters, contact your BioTek representative.

4. Using cotton balls or lens-cleaning tissue moistened with a small amount of high-
quality alcohol, clean each filter by lightly stroking its surface in one direction.
Ensure that the filters remain in their current locations.

5. Use a magnifying glass to inspect the surface; remove any loose threads left by the
cotton ball.

6. Replace the filter wheels in their respective positions and replace the thumbscrews.
Close the hinged door.
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Inspect/Clean Mirrors

Applies only to models with fluorescence and/or luminescence capability

BioTek recommends inspecting/cleaning the mirrors and polarizing filters (if equipped)
annually, especially if the mirror holder has been handled or changed.

The mirrors (especially the dichroic) and polarizing filters can be easily
damaged. Perform the cleaning steps only when necessary and always
handle the mirror and filters carefully.

These optical elements are delicate and must be carefully handled. The glass and anti-
reflective (AR) coated surfaces will be damaged by any contact, especially by abrasive
particles. In most cases, it is best to leave minor debris on the surface. If
performance indicators or obvious defects in the mirrors or filters suggest cleaning them,
however, here are some guidelines:

l Use of oil-free dry air or nitrogen under moderate pressure is the best method for
removing excessive debris from an optical surface. If the contamination is not
dislodged by the flow of gas, please follow the cleaning instructions below.

l The purpose of the cleaning solvent is only to dissolve any adhesive contamination
that is holding debris on the surface. The towel needs to absorb both the excessive
solvent and entrap the debris so that it can be removed from the surface. Surface
coatings on dichroics are typically less hard than the substrate. It is reasonable to
expect that any cleaning will degrade the surface at an atomic level. Consideration
should be given as to whether the contamination in question is more significant to the
application than the damage that may result from cleaning the surface. In many
cases, the AR coatings that are provided to give maximum light transmission amplify
the appearance of contamination on the surface.

Materials

Linen or cloth gloves

Anhydrous reagent-grade ethanol

Kimwipes

Magnifying glass

100% pure cotton balls (for the polarizing filters)

Procedure

1. Turn off and unplug the reader. Remove its shroud if you do not normally use the
side-access door to remove the mirror holder.

2. Remove the mirror holder (see instructions on page 57).
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3. Use absorbent towels such as Kimwipes, not lens paper, and wear gloves or use
enough toweling so that solvents do not dissolve oils from your hands which can seep
through the toweling onto the coated surface.

4. Wet the towel with an anhydrous reagent grade ethanol.

5. Drag the trailing edge of the ethanol-soaked Kimwipe across the surface of the
mirror, moving in a single direction. A minimal amount of pressure can be applied
while wiping. However, too much pressure will damage the mirror.

6. Use the magnifying glass to inspect the surface; if debris is still visible, repeat with a
new Kimwipe.

7. If equipped, clean the polarizing filters. Dampen a cotton ball with alcohol and gently
stroke the surface of the filter to remove dust or fingerprints.

8. Reinstall the mirror holder and replace the shroud.
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Flush/Purge Fluid Path

Applies only to models equipped with injectors

At the end of each day that the dispense module is in use, flush the fluid path using the
Gen5 priming utility. Leave the fluid to soak overnight or over a weekend, and then purge
the fluid before using the instrument again.

This flushing and purging routine is also recommended before disconnecting the outlet
tubes from the reader, and before decontamination to remove any assay residue prior
to applying isopropyl alcohol or sodium hypochlorite.

i If using Gen5 version 2.05 or earlier, the Prime and Purge options are found under
the Dispenser tab in the Reader Control dialog.

To flush the fluid path:

1. Fill two supply bottles with deionized or distilled water. Insert the supply (inlet) tubes
into the bottles.

2. Place the priming plate on the carrier.

3. Select System > Instrument Control > Synergy 2.

4. Click the Prime tab and select Dispenser 1.

5. Set the Volume to 5000 µL. Keep the default prime rate.

6. Click Prime to start the process. When the process is complete, carefully remove
the priming plate from the carrier and empty it.

7. Repeat the process for Dispenser 2.

Leave the water in the system overnight or until the instrument will be used again.
Purge the fluid from the system (see below) and then prime with the dispense
reagent before running an assay.

To purge the fluid from the system:

1. Place the inlet tubes in empty supply bottles or a beaker.

2. Select System > Instrument Control > Synergy 2.

3. Click the Prime tab and select Dispenser 1.

4. Set the Volume to 2000 µL.

5. Click Purge to start the process.

6. When the purge is complete, repeat the process for Dispenser 2.

After purging the system, you may wish to run a quick Dispense protocol to visually
verify the dispense accuracy (see the next section) or the more thorough Dispense
Accuracy and Precision Tests (see Injection System Tests starting on page 149).
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Run a Dispense Protocol (Optional)

Applies only to models equipped with injectors

After flushing/purging the system (described on page 73) and before running an assay that
requires dispense, take a moment to visually inspect the dispense accuracy.

Use a DI H2O–Tween solution to visually inspect the dispense accuracy
following maintenance: e.g., add 1 mL Tween 20 to 1000 mL of deionized
water.

1. Create a new protocol in Gen5. Select a Plate Type that matches the plate you are
using.

2. Add a Dispense step with the following parameters:

l Select Dispenser 1

l Set Tip Priming to "Before this dispense step" and Volume to 10 µL

l Set the Dispense Volume to 100 µL (or an amount to match your assay protocol)

l Adjust the Rate to support the dispensing volume

3. Add another Dispense step with the same parameters, selecting Dispenser 2.

4. Add a quick Read step with parameters relevant to your reader model (this is
necessary because Gen5 requires that a Read step follow the Dispense step).

5. Save the protocol with an identifying name, such as “Dispense Observation.”

6. Fill the supply bottles with the DI H2O–Tween solution mentioned above.

7. Create and run an experiment based on the Dispense Observation protocol.

8. When the experiment is complete, visually assess the fluid level in the wells. Well
volumes should appear evenly distributed across the plate.

If the well volume appears to be unevenly distributed, clean the internal dispense
tubes and injector heads as described in Clean the Internal Components starting on
page 75 and run the protocol again.
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Empty/Clean the Tip Priming Trough

Applies only to models equipped with injectors

The tip priming trough is a removable cup located in the rear pocket of the microplate
carrier, used for performing the tip prime. The trough holds about 1.5 mL of liquid and
must be periodically emptied and cleaned.

1. Extend the microplate carrier and carefully remove the tip priming trough from its
pocket in the left rear of the carrier.

2. Wash the trough in hot, soapy water. Use a small brush to clean in the corners.

3. Rinse the trough thoroughly and allow it to dry completely.

4. Replace the trough in the microplate carrier.

At the start of an experiment that requires dispensing, Gen5 prompts the user to empty
the tip prime trough.

Clean the Priming Plate

Applies only to models equipped with injectors

Clean the priming plate regularly to prevent bacteria growth and residue buildup. Wash the
plate in hot, soapy water, using a small brush to clean in the corners. Rinse thoroughly and
allow it to dry completely.

Clean the Internal Components

Applies only to models equipped with injectors

For models without injectors, the internal chamber and probes are not
customer-accessible. Contact BioTek’s Technical Assistance Center with
any questions about your particular model.

The reader’s internal dispense tubes and injector heads require routine cleaning at least
quarterly and possibly more frequently depending on the type of fluids dispensed.

Cleaning inside the reader is required when fluid has spilled inside the instrument and/or if
an unusually high background signal has been flagged by the assay controls.

Start with Remove the Reader's Shroud and execute the procedures that meet your needs,
in the order in which they are presented. Finish with Reassemble the Components.
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The buildup of deposits left by the evaporation of spilled fluids within the
read chamber can impact performance of the fluorescence,
luminescence, and absorbance functions. Perform a System Test before
and after maintenance so that any changes in performance can be noted.

Wear protective gloves and safety glasses when performing the
procedures.

Required Materials

Protective gloves and safety glasses

Screwdriver

Mild detergent or isopropyl alcohol

Clean, lint-free cotton cloths

Deionized or distilled water

Stylus (stored in a cylinder affixed to the back of the dispense module or reader; BioTek
PN 2872304)

Procedure

Remove the Reader's Shroud

Before removing the shroud, purge the system of fluid, and then turn off
and disconnect the reader from its power supply, the computer, and the
dispense module.

1. Purge the injection system of all fluid.

2. Disconnect power and all cables. Set the external dispense module aside.

3. Clear the work surface around the reader so you can easily access all sides of the
instrument.

4. Remove two screws: one on each side of reader at the lower-rear corner. See Figure
2-2 on page 11.

5. Stand facing the front of the instrument. Grasp both sides of the shroud, slide it
toward you, and pull it straight off the instrument. Set the shroud aside. See Figure
2-3 on page 11.
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To reinstall the shroud, rest its bottom on the table in front of the reader and
gently slide it into place. Internal wheels roll along the reader’s bottom track to
properly reposition the shroud.

Clean the Shroud's Air Filters

If dust has accumulated on the shroud’s air filters, use a vacuum cleaner to clean the
filters in place, or remove the grate holding the filters and soak the filters in mildly
soapy water. Rinse well and reinstall.

Remove the Internal Dispense Tubes and Injector Heads

1. Locate the tubing ports on the reader’s back wall. Turn each tube’s thumbscrew
counterclockwise and gently pull the tube from the port (Figure 5-2).

2. Locate the injector heads. Turn each tube’s thumbscrew counterclockwise and gently
pull the tube from its injector tip (Figure 5-3).

3. Turn each injector head counterclockwise and gently pull it out of the socket (Figure
5-4).

Figure 5-1: Internal components for the injection system
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Figure 5-2: Disconnecting the dispense tubes from the back wall

Figure 5-3: Disconnecting the tubes from the injector heads
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Figure 5-4: Removing the injector heads

Clean the Dispense Tubes and Injector Heads

As discussed on page 66, some reagents can crystallize and clog the tubing and injector
heads. Daily flushing and purging can help to prevent this, but more rigorous cleaning
may be necessary if reagent has been allowed to dry in the tubing and/or injectors.
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Figure 5-5: Injector heads and internal dispense tubes

To clean the internal tubes, soak them in hot, soapy water to soften and dissolve any
hardened particles. Flush each tube by holding it vertically under a stream of water.

To clean the injector tips:

l Gently insert the stylus into each injector tip to clear any blockages. The stylus (BTI
#2872304) is stored in a cylinder affixed to the back of the dispense module or
reader.

l Stream water through the pipe to be sure it is clean. If the water does not stream
out, try soaking in hot, soapy water and then reinserting the stylus.

Caution: Do not bend the injector tips. A bent tip might not dispense
accurately.

Caution: Do not remove the o-rings (if equipped).

Figure 5-6: Using the stylus to clean an injector head

80 | Chapter 5: Preventive Maintenance

BioTek Instruments, Inc.



Clean Inside the Reader

The internal surface and some components should be cleaned if reagent has spilled or if
an unusually high background signal has been identified.

BioTek recommends performing this process in conjunction with the previously defined
steps for cleaning the dispense tubes and injectors.

For this procedure you will need:

l Deionized or distilled water and mild detergent (optional)

l Two or more lint-free cotton cloths

Figure 5-7: Locating the components described in this section
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Remove the Incubator Housing

1. If you have not already done so, unplug the reader and remove its shroud.

2. Disconnect two heater wires located on the reader’s back wall. The two wires are
in the first and third positions in the top row (see below). To disconnect a wire,
depress the tab and slide it off the board.

Figure 5-8: Disconnecting heater wires 1 and 3 in the top row

3. Refer to Figure 5-7 and remove the three knobs that secure the incubator housing.

4. Turn the optics armature knob clockwise to raise the mechanism as high as it will
go.
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Figure 5-9: Raising the optics armature

5. Lift the left side of the incubator housing and carefully slide it out (see Figure 5-
10).

6. Turn over the incubator housing and clean the surface with water and mild
detergent. Set it aside and let it dry completely.

When replacing the incubator housing, the two “forks” on its right side should
wrap around the holding screws. The forks should not slide under the fixed
foam.
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Figure 5-10: Removing the incubator housing

Clean the Reader's Surface

1. After you remove the incubator housing, slide the microplate carrier to the left to
engage the support pin and then pull it toward the front of the reader.

2. Moisten (do not soak) a clean cotton cloth with water, or with water and mild
detergent, or alcohol. Wipe all sides of the plate carrier. Wipe the instrument’s
horizontal surface. See Figure 5-11.

If the injector heads were removed from the reader, use the cloth to gently clean
the underside of the optical armature around the injector head holders.

i Do not apply pressure. Components are easily damaged.

3. If detergent was used, wipe the surfaces with a cloth moistened with water.

4. Use a clean, dry, lint-free cloth to dry all wet surfaces.
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Figure 5-11: Cleaning the inside of the reader

Reassemble the Components

1. Slide the microplate carrier all the way into the instrument.

2. If the incubator housing was removed, reinstall it.

o Observe the two forks on the right side of the housing; they must wrap around
the screws on either side of the optics armature. Do not slide the forks under
the foam. See Figure 5-12.

o Secure the incubator housing with the three knobs (Figure 5-7).

o Reconnect the two heater wires to the rear wall of the reader: the white wire
fits into position 1 (Figure 5-8) in the top row of wires; the black wire fits into
position 3.
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Figure 5-12: Positioning the incubator housing fork

3. Insert the two injector heads into their sockets. Ensure that they are properly
seated; the knurled plastic should sit flush against the surface, as shown below.

Figure 5-13: Seating the injector head

4. Attach the two internal dispense tubes to the injector heads (Figure 5-3 on page
78). Do not overtighten the thumbscrews!

5. Attach the other end of the two dispense tubes to the tubing ports on the rear wall
of the reader. They can go into either port.

6. Review the steps you just performed to make sure the components have been
properly reassembled.

7. Slide the shroud onto the instrument.

8. Replace the two side screws to secure the shroud to the base.

Verify Performance

After reassembling the instrument, verify that the instrument is functioning properly:

l Connect power to the reader and turn it on. Allow the startup system test to
complete. Run a System Test using Gen5; all tests should pass.

l Run any required OQ/PQ tests.
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Chapter 6

As-Needed Maintenance
This chapter contains maintenance and component-replacement
procedures that need to be performed only occasionally.

Decontamination 88
Required Materials 88
Procedure for Models without the Dispense Module 89
Procedure for Models with the Dispense Module 90

Replace the Tungsten Lamp 93
Dispense Module, Syringe Replacement 95

Syringe Maintenance Position 95
Replace the Syringe 95



Decontamination

Any laboratory instrument that has been used for research or clinical analysis is considered
a biohazard and requires decontamination prior to handling.

Decontamination minimizes the risk to all who come into contact with the instrument
during shipping, handling, and servicing. Decontamination is required by the U.S.
Department of Transportation regulations.

Persons performing the decontamination process must be familiar with the basic setup and
operation of the instrument.

BioTek Instruments, Inc., recommends the use of the following
decontamination solutions and methods based on our knowledge of the
instrument and recommendations of the Centers for Disease Control and
Prevention (CDC). Neither BioTek nor the CDC assumes any liability for
the adequacy of these solutions and methods. Each laboratory must
ensure that decontamination procedures are adequate for the biohazards
they handle.

Wear prophylactic gloves when handling contaminated instruments.
Gloved hands should be considered contaminated at all times; keep
gloved hands away from eyes, mouth, and nose. Eating and drinking
while decontaminating instruments is not advised.

Mucous membranes are considered prime entry routes for infectious
agents. Wear eye protection and a surgical mask when there is a
possibility of aerosol contamination. Intact skin is generally considered
an effective barrier against infectious organisms; however, small
abrasions and cuts may not always be visible. Wear protective gloves
when performing the decontamination procedure.

Required Materials

For all Synergy 2 models:

l Sodium hypochlorite (NaClO, or bleach)

l 70% isopropyl alcohol (as an alternative to bleach)

l Deionized or distilled water

l Safety glasses

l Surgical mask

l Protective gloves
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l Lab coat

l Biohazard trash bags

l 125-mL beakers

l Clean, lint-free cotton cloths or paper towels

Additional materials for models with the dispense module:

l Screwdriver

l Small brush for cleaning the tip priming trough and priming plate

l (Optional) Mild detergent

Procedure for Models without the Dispense Module

The sodium hypochlorite (bleach) solution is caustic; wear gloves and
eye protection when handling the solution.

Do not immerse the instrument, spray it with liquid, or use a dripping-
wet cloth. Do not allow the cleaning solution to run into the
interior of the instrument. If this happens, contact the BioTek
Service Department.

Turn off and unplug the instrument for all decontamination and cleaning
operations.

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects of
bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial bleach is
typically 10.0% NaClO; prepare a 1:20 dilution. Household bleach is typically
5.0% NaClO; prepare a 1:10 dilution.

3. Wet a cloth or paper towel with the bleach solution or alcohol, and then thoroughly
wring it out so that liquid does not drip from it.

4. Open the plate carrier door, and slide out the plate carrier.

5. Wipe the plate carrier and all exposed surfaces of the instrument.

6. Wait 20 minutes. Moisten a cloth with deionized (DI) or distilled water and wipe all
surfaces of the instrument that have been cleaned with the bleach solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.

8. Reassemble the instrument as necessary.

9. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.
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Procedure for Models with the Dispense Module

Perform the Routine Procedure below when the equipment is functioning normally. If
you are unable to perform a prime due to a system failure, perform the Alternate
Procedure described on page 92.

i If using Gen5 version 2.05 or earlier, the Prime and Purge options are found under
the Dispenser tab in the Reader Control dialog.

Routine Procedure

If disinfecting with sodium hypochlorite (bleach), flush repeatedly with
deionized water to remove the bleach. After disinfecting with sodium
hypochlorite, perform the rinse procedure provided on page 91.

If disinfecting with alcohol, do not immediately prime with deionized
water, because the drying effect of the alcohol is an important aspect of
its disinfectant properties.

Clean Exposed Surfaces

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects
of bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial bleach is
typically 10.0% NaClO; prepare a 1:20 dilution. Household bleach is
typically 5.0% NaClO; prepare a 1:10 dilution.

3. Open the plate carrier door and slide out the plate carrier.

4. Wet a cloth or paper towel with the bleach solution or alcohol, and then
thoroughly wring it out so that liquid does not drip from it.

5. Wipe the plate carrier and the exposed surfaces of the external dispense module.

6. Wait 20 minutes. Moisten a cloth with deionized (DI) or distilled water and wipe all
surfaces that have been cleaned with the bleach solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.

8. Reassemble the instrument as necessary.

9. If the dispense module is installed, purge any fluid (see Flush/Purge Fluid Path on
page 73) and detach the outlet tubes from the instrument. If it is not installed,
attach only the dispense module’s communication cable to the instrument.
Remove the supply bottles and their holders.

10. Perform the decontamination procedures described below.
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Decontaminate the Fluid Lines

1. Place a beaker with 20 mL of 0.5% sodium hypochlorite solution or 70% isopropyl
alcohol near SYRINGE 1 on the dispense module.

2. Place the SYRINGE 1 inlet tube in the beaker.

3. If you have not already done so, detach the dispense module’s outlet tubes from
the instrument. Place the ends of the outlet tubes in an empty beaker and set the
beaker next to the dispense module.

4. Launch Gen5, select System > Instrument Control, and click the Prime tab.

5. Select Dispenser 1, enter a Volume of 5000 µL, and keep the default dispense
Rate.

6. Place the priming plate on the carrier.

7. Run two prime cycles, for a total of 10,000 µL.

8. Wait at least 20 minutes to allow the solution to disinfect the tubing.

9. Remove the inlet tube from the beaker of disinfectant solution.

10. From the Reader Control dialog, change the Volume to 1000 µL.

11. Run one prime cycle, to flush the disinfectant out of the fluid lines.

12. Empty the beaker containing the outlet tubes. Put the tubes back in the empty
beaker.

13. If sodium hypochlorite (bleach) was used, perform the next procedure, Rinse the
Fluid Lines.

Otherwise (or after performing the Rinse procedure), repeat steps 1–13 for
SYRINGE 2/Dispenser 2.

Rinse the Fluid Lines

Perform this procedure only if decontamination was performed using sodium
hypochlorite.

1. Place a beaker containing at least 30 mL of deionized water on the dispense
module.

2. Place the SYRINGE 1 or 2 inlet tube in the beaker.

3. If you have not already done so, place the outlet tubes in an empty beaker.

4. From the Reader Control dialog, select Dispenser 1 or 2, set the Volume to 5000
µL, and keep the default dispense Rate.

5. Run five prime cycles, for a total of 25,000 µL.

6. Pause for 10 minutes and then run one prime cycle with 5000 µL. This delay will
allow any residual sodium hypochlorite to diffuse into the solution and be flushed
out with the next prime.

7. Empty the beaker containing the outlet tubes.

8. Wipe all surfaces with deionized water.
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9. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Clean the Tubing and Injectors

Turn to Clean the Internal Components on page 75 for instructions on removing the
reader's shroud and removing/cleaning the internal dispense tubes and injector
heads.

Decontaminate the Tip Priming Trough and Priming Plate

1. Remove the tip priming trough from the instrument’s microplate carrier.

2. Wash the tip priming trough and priming plate in hot, soapy water. Use a small
brush or cloth to clean the corners of the trough and plate.

3. To decontaminate, soak the trough and plate in a container of 0.5% sodium
hypochlorite or 70% isopropyl alcohol for at least 20 minutes.

o If decontaminating in a bleach solution, thoroughly rinse the trough and plate
with DI water.

o If decontaminating with alcohol, let the trough and plate air dry.

4. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Alternate Procedure

If you are unable to prime the system due to an equipment failure, decontaminate the
instrument and the dispense module as follows:

1. Turn to Clean the Internal Components on page 75 for instructions on removing
the reader's shroud and removing/cleaning the internal dispense tubes and
injector heads.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects
of bleach are a concern, 70% isopropyl alcohol may be used.

Check the percent NaClO of the bleach you are using. Commercial bleach is
typically 10.0% NaClO; prepare a 1:20 dilution. Household bleach is
typically 5.0% NaClO; prepare a 1:10 dilution.

3. Slide the microplate carrier out of the instrument.

4. Wet a cloth or paper towel with the bleach solution or alcohol, and then
thoroughly wring it out so that liquid does not drip from it.

5. Use the cloth to wipe:

o All exterior surfaces of the instrument

o All surfaces of the plate carrier

o The exposed surfaces of the dispense module, including the syringe valves
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6. Remove the tubing and the syringes from the dispense module and soak them in
the bleach or alcohol solution. Wait for 20 minutes.

To remove a syringe: In Gen5, click System > Instrument Control >
Synergy 2. On the Prime tab, select a dispenser and click Maintenance.
The syringe bracket will move to its furthest-from-home position. Remove
the metal thumbscrew from underneath the bracket. Unscrew the top of the
syringe from the bottom of the syringe drive. Gently remove the syringe.

7. Moisten a cloth with DI or distilled water and wipe all surfaces that have been
cleaned with the bleach solution or alcohol.

8. Rinse all tubing and the syringes with DI water.

9. Use a clean, dry cloth to dry all surfaces on the instrument and the dispense
module.

10. Reassemble the dispense module as necessary.

11. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Replace the Tungsten Lamp

The tungsten bulb is expected to operate without replacement for a minimum of 1000
hours. The intensity of the bulb will slowly drop over time until the reader’s System Test
detects a low signal and displays an error message. In addition, error code 2901 may be
displayed during normal operation. The lamp should be replaced at this time; contact
BioTek and order part number 7080500.

When the reader’s front panel is opened, the tungsten lamp is located behind a light-
blocking panel with the hot surface warning label. The lamp is secured by a bracket that
also holds a condenser lens and a heat absorber. Two cables extend from the back of the
lamp to plug into the reader.

The lamp is hot when the instrument is on. Before replacing the lamp,
turn off the reader and allow the lamp to cool for at least 15 minutes.

Do not touch the glass lenses! Fingerprints on the condenser lens or heat
absorber may negatively affect performance.

1. Turn off and unplug the reader.Wait at least 15 minutes for the lamp to cool.

2. Remove the reader’s shroud.
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3. Remove the EX filter wheel and set aside.

4. Grasp the light-blocking panel and slide the assembly toward you, out of the reader.

Figure 6-1: The light-blocking panel and excitation filter wheel
removed for lamp replacement

5. Unplug the lamp’s cables from the reader.

6. Gently, without touching any glass components, unscrew one of the thumbscrews
holding the bulb in its wire bracket.

7. When the bracket is free, remove the old bulb.

Figure 6-2: Removing the old bulb (with cables) from the bracket
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8. Insert the new bulb, position the wire bracket, and tighten the thumbscrew.

9. Align the lamp assembly with the reader, preparing to slide its top metal plate into its
slot, and plug in the red cables. The cables can go into either plug.

10. Slide the lamp assembly into place without touching any other internal component.
You may need to move the cables slightly downward to make room for the lamp.

11. Reinstall the EX filter wheel and the reader’s shroud.

12. Plug in and turn on the reader. If the system test passes the lamp replacement was
successful. Otherwise, note any errors and consult Error Codes starting on page
163.

Dispense Module, Syringe Replacement

Refer to the Preventive Maintenance chapter for cleaning procedures you must perform
regularly and also in the case of poor performance (for example, when the Dispense
Accuracy and Precision tests fail). If cleaning the injection system does not eliminate
performance problems, or if a syringe is leaking, perform these instructions to replace a
faulty syringe. Contact BioTek TAC to order replacement syringes.

To change a syringe, first use Gen5 to put the syringe in its maintenance position.

Syringe Maintenance Position

Do not change the syringe position or calibrate the dispensers unless
instructed to do so by BioTek as part of installation, upgrade, or
maintenance.

Gen5 provides access to syringe setup functions for maintenance and calibration purposes.
When a syringe needs to be installed or replaced, it must first be moved to its
“maintenance position.”

1. In Gen5, select System > Instrument Control > Synergy 2 and click the Prime
tab (or Dispenser tab, if using Gen5 v2.05 or lower).

2. Select the appropriate Dispenser number (1 or 2) associated with the syringe.

3. Click Maintenance. The syringe plunger will move to its furthest-from-home
position. The syringe can then be disconnected from the drive bracket and unscrewed
from the valve.

Replace the Syringe

Refer to Figure 2-13 on page 19.

After using Gen5 to move the syringe into its maintenance position:
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1. Using your fingers, unscrew the bottom thumbscrew that secures the syringe,
underneath the bracket. Retain this bottom thumbscrew; it is needed for the
replacement syringe.

2. Unscrew the top thumbscrew to disengage the syringe from the valve.

3. Remove the new syringe from its protective box.

4. Hold the syringe vertically with the threaded end at the top. Screw the top of the
syringe into the bottom of the syringe valve. Finger-tighten only.

5. Carefully pull down the bottom of the syringe until it rests inside the hole in the
bracket.

6. Pass the thumbscrew (used to hold the old syringe) up through this hole and thread it
into the bottom of the syringe. Hold the syringe from rotating while tightening the
thumbscrew. Finger-tighten only.

7. In Gen5, select System > Instrument Control > Synergy 2.

8. Click the Prime tab and click Initialize.
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Chapter 7

Instrument Qualification Process
This chapter describes the tests that BioTek Instruments, Inc. has
developed for complete qualification of all models of the Synergy 2. This
chapter introduces the various test methods, describes the materials
and relevant Gen5 protocols used to execute the tests, explains how to
analyze test results, and provides troubleshooting tips in the event of a
failure.

Instrument Qualification Procedures starting on page 123 contains
the actual step-by-step test procedures.

Instrument System Test 98
Plate Shaker Test 98
Absorbance Testing 99
Luminescence Testing 107
Fluorescence Testing 110
Injection System Testing 118



Instrument System Test

Each time the Synergy 2 is turned on, it automatically performs a series of tests on the
reader’s motors, lamp(s), the PMT, and various sub-systems. The duration of this “system
test” depends on the reader model and can take a few minutes to complete. If all tests
pass, the microplate carrier will eject and the LED on the power switch will remain on and
constant. The reader is then ready for use.

If any test results do not meet the internally coded Failure Mode Effects Analysis (FMEA)
criteria established by BioTek, the reader will beep repeatedly and the LED on the power
switch will flash. If this occurs, press the carrier eject button to stop the beeping. If
necessary, initiate another system test using Gen5 to try to retrieve an error code from the
reader.

Refer to Error Codes starting on page 163 for information on error codes and
troubleshooting tips.

Refer to Sample Reports on page 173 to see a sample System Test Report for Synergy 2.

Plate Shaker Test

This test verifies that the multi-speed plate shaker is operating properly. The test involves
creating and running a protocol with shaking enabled for a duration of 30 seconds. The
sound of the carrier shaking is all that needs to be confirmed to verify that the plate shaker
is operating properly.
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Absorbance Testing

For models with absorbance capability, BioTek developed a series of tests for the
absorbance system using a combination of solid state Absorbance Test Plates and liquid
plates. The test plates and the materials used for creating the liquid plates are available for
purchase from BioTek.

To qualify the absorbance system for the Synergy 2, you should perform:

l Absorbance Liquid Test 1 and Absorbance Plate Test (using BTI #7260522) or

l Absorbance Liquid Test 2

Optionally, to qualify operation in the UV range, you should also perform:

l Absorbance Liquid Test 3 or Absorbance Plate Test at 340 nm (using BTI #7260551)

BioTek Absorbance Test Plates

Absorbance Test Plate PN 7260522 uses NIST-traceable neutral density filters to confirm
absorbance specifications in the visible range (400–800 nm). This test plate also contains
precision-machined holes to verify mechanical alignment, and a glass filter in position C6
to test the wavelength accuracy of the monochromator-based absorbance system.
Absorbance Test Plate PN 7260551 uses NIST-traceable neutral density filters to confirm
absorbance specifications in the UV range (340 nm).

Every test plate comes with a Test Plate Calibration Certificate, containing a table with
Absorbance OD Standards for each filter at each wavelength supported by the plate. The
certificate for test plate PN 7260522 also contains Wavelength Accuracy Standards tables
with Expected Peak (nm) values with Test Ranges for the C6 glass filter.

Before the Absorbance Plate Test can be performed, the OD Standard values and Expected
Peak/Test Range combinations must be entered into Gen5. Enter and save these values
once initially, and then update them annually when the test plate is recertified by BioTek.

Test Methods

The Absorbance Plate Test is conducted using Gen5 software (System > Diagnostics
> Test Plates) to confirm wavelength accuracy ("Peak Absorbance"); mechanical
alignment; and optical density accuracy, linearity, and repeatability. When complete,
Gen5 generates a results report displaying Pass or Fail for each individual test.

l Peak Absorbance: The BTI #7260522 test plate contains a glass filter in position C6
that is used to check the wavelength accuracy of the absorbance monochromator.
The filter is scanned across a specified wavelength range in 1-nm increments. The
wavelength(s) of maximum absorbance are compared to the expected peak
wavelength(s) supplied on the test plate’s data sheet. The accuracy of the
wavelength should be ± 3 nm (±2 nm instrument, ±1 nm filter allowance).
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l Alignment: The test plate has precisely machined holes to confirm mechanical
alignment. The amount of light that shines through these holes is an indication of
whether the microplate carrier is properly aligned with the absorbance optical path.
A reading of more than 0.015 OD for any of the designated alignment holes indicates
that the light is being “clipped” and the reader may be out of alignment.

l Accuracy: The test plate contains NIST-traceable neutral-density glass filters of
known OD values at one or more wavelengths. Actual measurements are compared
against the expected values provided in the test plate’s data sheet. Since there are
several filters with differing OD values, the accuracy across a range of ODs can be
established. Once it is proven that the reader is accurate at these OD values, the
reader is also considered to be linear. To further verify this, you can perform a linear
regression analysis on the test plate OD values in a program such as Microsoft Excel;
an R2 value of at least 0.9900 is expected.

l Repeatability: This test ensures the instrument meets its repeatability specification
by conducting repeated reads of each neutral-density filter on the test plate and
comparing the results.

Sample Test Report

Refer to Sample Reports on page 173 to see a sample Absorbance Plate Test Report for
Synergy 2.

Troubleshooting

If a test fails, try the troubleshooting tips below. If the test continues to fail, contact
BioTek TAC.

Important! Do not remove filters from the Absorbance Test Plate.
Do not use alcohol or other cleaning agents, and do not touch the
filters with your bare fingers.

If a higher-OD well reports "#N/A" for Min/Max Limit and Result,
the measured OD is beyond the specified range for Accuracy or
Repeatability used with this test, and therefore no pass/fail
determination is made. It does not indicate a test failure.

Peak Absorbance Test

l Check the filter in the C6 position to ensure it is clean. If needed, clean the filter with
lens paper. Do not remove the filter, and do not use alcohol or other cleaning agents.

l Verify that the Peak wavelength information entered for the plate in Gen5 matches
the information provided on the test plate's data sheet.

l Check the calibration due date on the test plate's label. If the test plate is overdue for
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recalibration, contact BioTek to schedule service.

l Check the microplate carrier to ensure it is clear of debris.

Alignment Test

l Ensure that the test plate is properly seated in the microplate carrier.

l Check the four alignment holes (A1, A12, H1, H12) to ensure they are clear of debris.

l Check the microplate carrier to ensure it is clear of debris.

Accuracy Test

l Check the neutral-density filters to ensure they clean (positions C1, D4, E2, F5, G3,
H6). If needed, clean the filters with lens paper. Do not remove any filters, and do
not use alcohol or other cleaning agents.

l Verify that the wavelength/expected OD values entered for the plate in Gen5 match
the information provided on the test plate's data sheet.

l Check the calibration due date on the test plate's label. If the test plate is overdue for
recalibration, contact BioTek to schedule service.

Repeatability Test

l Check the neutral-density filters to ensure there is no debris that may have shifted
between readings and caused changes.

l Check the microplate carrier to ensure it is clear of debris.

Absorbance Liquid Tests

BioTek Instruments, Inc. has developed a series of liquid test procedures for testing your
reader's absorbance system.

Test Methods

Absorbance Liquid Test 1 confirms repeatability and alignment of the reader when a
solution is used in the microplate. If these tests pass, then the lens placement and
optical system cleanliness are proven. For the Repeatability portion of this test, two
columns containing a color-absorbing solution are read five times at 405 nm. For each
well, an "allowed deviation" is determined based on its Mean OD and the reader's
repeatability specification. Each well's Standard Deviation must be less than its Allowed
Deviation to pass. To confirm the reader’s mechanical alignment, the plate is rotated
180 degrees in the carrier (e.g., A1 is now in the H12 position) and the same two
columns are read. The initial and new OD readings are compared, using the reader's
accuracy specification. If the two readings in the same well do not meet specification,
the reader may be out of alignment.
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If an Absorbance Test Plate is not available, Absorbance Liquid Test 2may be
conducted to test the instrument's alignment, repeatability, and accuracy by preparing a
series of solutions of varying OD values as described on page 132.

Absorbance Liquid Test 3 is an optional test offered for those sites that must have
proof of linearity at 340 nm. (Alternatively, the BioTek 340 nm Absorbance Test Plate
may be used; see page 99.) This test is optional since the Synergy 2 has good “front-
end” linearity throughout the specified wavelength range. While the absolute values of
the OD cannot be determined by this test, the results will indicate if there is adequate
repeatable absorbance and a linear slope. This method is dependent upon proper dye
dilution and a skilled pipetting technique. It is expected that the first dilution (mid-level
solution) will have an absorbance value near 75% of that of the stock (high-level)
solution, and that the second dilution (low-level solution) will have an absorbance value
near 50% of that of the stock solution.

Gen5 Protocol Parameters

The information in this section represents the recommended reading parameters for the
referenced Gen5 protocol(s). It is possible that your tests will require modifications to
some of these parameters, such as the Plate Type.

i The Plate Type setting in each Gen5 protocol should match the actual plate in use.

Synergy 2 Abs Test 1.prt

Parameter Setting

Plate Type 96 WELL PLATE

Shake Step Variable, 4 minutes

Two Read Steps

Kinetic loop (one per Read step) Set a Run time/Interval combination to read the
plate five times with minimal delay

Detection Method Absorbance

Read Type Endpoint

Optics Type Monochromator

Read wells First Read step: A1..H2
Second Read step: A11..H12

Wavelength 405 nm

Read Speed Normal

Delay after plate movement 100 msec

Plate Out,In step between loops Text "rotate the plate 180 degrees"
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Synergy 2 Abs Test 2.prt

Parameter Setting

Plate Type 96 WELL PLATE

Shake Step Variable, 4 minutes

Two Read Steps

Kinetic loop (one per Read step) Set a Run time/Interval combination to read the
plate five times with minimal delay

Detection Method Absorbance

Read Type Endpoint

Optics Type Monochromator

Step labels First Read step: "Normal"
Second Read step: "Turnaround"

Read wells Full plate

Wavelengths 2 (450 nm, 630 nm)

Read Speed Normal

Delay after plate movement 100 msec

Data Reduction Define two Delta OD transformations (450-630
nm), one per Read data set

Synergy 2 Abs Test 3.prt

Parameter Setting

Plate Type 96 WELL PLATE

Shake Step Slow, 30 seconds

Kinetic loop Set a Run time/Interval combination to read the
plate five times with minimal delay

Detection Method Absorbance

Read Type Endpoint

Optics Type Monochromator

Read wells A1..H6

Wavelength 340 nm

Read Speed Normal

Delay after plate movement 100 msec
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Results Analysis

The Absorbance Liquid Test procedures begin on page 131.

Absorbance specifications used with the liquid tests:

Accuracy:

± 1.0% ± 0.010 OD from 0.000 to 2.000 OD
± 3.0% ± 0.010 OD from 2.000 OD to 3.000 OD

Repeatability:

± 1.0% ± 0.005 OD from 0.000 to 2.000 OD
± 3.0% ± 0.005 OD from 2.000 OD to 3.000 OD

Absorbance Liquid Test 1

1. The plate is read five times in the “Normal” position at 405 nm. Calculate the Mean
OD and Standard Deviation of those five reads for each well in columns 1 and 2.

2. For each well in columns 1 and 2, calculate the Allowed Deviation using the
Repeatability specification for a 96-well plate (Mean OD x 0.010 + 0.005). For
each well, its Standard Deviation should be less than its Allowed Deviation.

Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result
in a Mean of 0.8004 and a Standard Deviation of 0.0018. The Mean multiplied by
1.0% (0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013; this is
the Allowed Deviation for well A1. Since the Standard Deviation for well A1 is less
than 0.013, the well meets the test criteria.

3. The plate is read five times in the “Turnaround” position at 405 nm. Calculate the
Mean OD of those five reads for each well in columns 11 and 12.

4. Perform a mathematical comparison of the Mean values for each well in its
Normal and Turnaround positions (that is, compare A1 to H12, A2 to H11, B1 to
G12,… H2 to A11). To pass the test, the differences in the compared Mean values
must be within the Accuracy specification for a 96-well microplate.

Example: If the Mean value for well A1 in the Normal position is 1.902 with a
specified accuracy of ±1.0% ±0.010 OD, then the expected range for the Mean of
the well in its Turnaround (H12) position is 1.873 to 1.931 OD. 1.902 x 0.010 +
0.010 = 0.029; 1.902 - 0.029 = 1.873; 1.902 + 0.029 = 1.931.

Absorbance Liquid Test 2

1. The plate is read five times at 450/630 nm ("Normal" position), resulting in five
sets of Delta OD data. Calculate results for Linearity:

o Calculate the mean absorbance for each well, and average the means for each
concentration.

o Perform a regression analysis on the data to determine if there is adequate
linearity. Since it is somewhat difficult to achieve high pipetting accuracy when
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conducting linear dilutions, an R2 value of at least 0.9900 is considered
adequate.

2. Calculate the results for Repeatability:

o Calculate the Mean and Standard Deviation for the five readings taken at each
concentration. Only one row of data needs to be analyzed.

o For each Mean below 2.000 OD, calculate the Allowed Deviation using the
Repeatability specification for a 96-well plate of ±1.0% ±0.005 OD. (If above
2.000 OD, apply the ±3.0% ±0.005 specification.)

o The Standard Deviation for each set of readings should be less than the Allowed
Deviation.

Example: Readings of 1.950, 1.948, 1.955, 1.952, and 1.950 will result in a
Mean of 1.951, and a Standard Deviation of 0.0026. The Mean (1.951)
multiplied by 1.0% (1.951 x 0.010) = 0.0195, which, when added to the 0.005
(0.0195 + 0.005) = 0.0245 OD, which is the Allowed Deviation. Since the
Standard Deviation is less than this value, the reader meets the test criteria.

3. After gathering data for the Linearity Test, the plate is read five more times with
the A1 well in the H12 position ("Turnaround" position). This results in values for
the four corner wells that can be used to assess alignment. Calculate results for
the Alignment Test:

o Calculate the means of the wells A1 and H1 in the Normal plate position (data
from Linearity Test) and in the Turnaround position.

o Compare the mean reading for well A1 to its mean reading when in the H12
position. Next, compare the mean values for the H1 well to the same well in the
A12 position. The difference in the values for any two corresponding wells
should be within the Accuracy specification for 96-well plates. If the four corner
wells are within the accuracy range, the reader is in alignment.

Example: If the mean of well A1 in the normal position is 1.902, where the
specified accuracy is ±1.0% ±0.010 OD, then the expected range for the mean
of the same well in the H12 position is 1.873 to 1.931 OD. (1.902 x 1.0% =
0.019 + 0.010 = 0.029, which is added to and subtracted from 1.902 for the
range.)

Absorbance Liquid Test 3

1. The plate is read five times at 340 nm. For each well, calculate the Mean OD and
Standard Deviation of the five readings.

2. For each Mean calculated in step 1, calculate the Allowed Deviation using the
Repeatability specification for a 96-well plate (Mean OD x 0.010 + 0.005). For
each well, its Standard Deviation should be less than its Allowed Deviation.

Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result
in a Mean of 0.8004 and a Standard Deviation of 0.0018. The Mean multiplied by
1.0% (0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013; this is
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the Allowed Deviation for well A1. Since the Standard Deviation for well A1 is less
than 0.013, the well meets the test criteria.

3. Calculate results for Linearity:

o For each of the three test solutions, calculate the average Mean OD for the
wells containing that solution (mean of wells A1 to H2, A3 to H4, and A5 to H6).

o Perform a regression analysis on the data to determine if there is adequate
linearity. The three average Mean OD values are the “Y” values. The solution
concentrations are the “X” values (1.00, 0.75, 0.50). Since it is somewhat
difficult to achieve high pipetting accuracy when conducting linear dilutions, an
R2 value of at least 0.9900 is considered adequate.

Troubleshooting

If an absorbance liquid test fails, try the following. If a test continues to fail, contact
BioTek TAC.

l Check the microwells and plate carrier for debris that may have shifted and caused
changes.

l Ensure the microplate is properly seated in the carrier.

l As applicable, confirm that the plate was properly oriented in the "Normal" and
"Turnaround" positions.

l Liquid Test 1 can fail due to the meniscus effect, which can cause readings to
decrease over time. If you suspect this may be the case, include a shake step
between the read steps in the protocol.
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Luminescence Testing

For models with luminescence capability, BioTek uses the Harta Luminometer Reference
Microplate to test the luminescence system. The test plate is LED-based and NIST-
traceable. Contact BioTek to purchase a plate (BTI #8030015; includes microplate carrier
adapters) or visit www.HartaInstruments.com to learn more.

Test Method

The Harta Luminometer Reference Microplate is used to determine a detection limit by
leveraging a known correlation of 35 photons per attomole of ATP. By using the NIST data
provided with the Harta plate in photons/s, a conversion factor of 0.02884 attomole/photon
is applied to determine an ATP concentration and subsequent limit of detection for the
instrument under test.

Gen5 Protocol Parameters

The information in this section represents the recommended reading parameters for the
referenced Gen5 protocol(s).

Synergy 2 LumTest_Harta.prt

Parameter Setting

Plate Type "Costar 96 black opaque"

Delay Step 3 minutes

READ STEP 1

Detection Method Luminescence

Read Type Endpoint

Optics Type Filters

Step Label Reference well A2

Read well A2

Filter Set 1

Emission Hole

Optics Position Top

Gain 150

Integration Time 0:10.00 MM:SS.ss

Delay After Plate Movement 350 msec

Dynamic Range Standard

Read Height 5.00 mm

READ STEP 2
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Parameter Setting

Detection Method Luminescence

Read Type Endpoint

Optics Type Filters

Step Label Background

Read wells F1–G12

Filter Set 1

Emission Hole

Optics Position Top

Gain 150

Integration Time 0:10.00 MM:SS.ss

Delay After Plate Movement 350 msec

Dynamic Range Standard

Read Height 4.00 mm

READ STEP 3

Detection Method Luminescence

Read Type Endpoint

Optics Type Filters

Step Label Battery check

Read wells A7–A8

Filter Set 1

Emission Hole

Optics Position Top

Gain 50

Integration Time 0:10.00 MM:SS.ss

Delay After Plate Movement 350 msec

Dynamic Range Extended

Read Height 5.00 mm
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Results Analysis

The Luminescence Test procedure is described on page 136.

1. Determine if the plate’s battery is functioning properly. If A8 > (0.2 * A7), the
battery is good. Otherwise, it requires replacement.

A replacement battery is included with each new and recalibrated Harta
Luminometer Reference Microplate.

2. On the Harta plate’s calibration certificate, locate the NIST measurement for the A2
position. Convert it to attomoles: (A2 NIST measurement * 0.02884)

3. Calculate the signal-to-noise ratio: (A2–Mean of the buffer cells)/(3 * Standard
deviation of buffer cells)

4. Calculate the detection limit: A2 NIST measurement in attomoles/signal-to-noise
ratio

Pass/Fail Criteria

l If the reader is equipped with the low-noise PMT, the detection limit must be <50
amol to pass.

l If the reader is equipped with the red-shifted PMT, the detection limit must be <500
amol to pass.

To determine which PMT is installed, check the label on the reader:
#49984=low-noise PMT; #49721=red-shifted PMT

Troubleshooting

If a test fails, try the suggestions below. If a test continues to fail, contact BioTek's
Technical Assistance Center (TAC).

l Ensure that the reading is performed through a hole in the EM filter wheel, not
through a glass filter.

l Verify that the filter wheel definitions in Gen5 match the physical item.

l The optical probe(s) may need to be cleaned; contact BioTek TAC for guidance.
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Fluorescence Testing

For models with fluorescence capability, BioTek has developed a series of liquid test
procedures for testing your reader's fluorescence system.

Fluorescence Liquid Tests

Test Methods

l Corners: The Corners Test uses fluorescent compounds to verify that the plate
carrier is properly aligned in relation to the fluorescence probe(s). This test may be
conducted using either the top or bottom optics (as supported by your reader model).

l Fluorescence Intensity (Sensitivity): The Sensitivity Test measures a
fluorescent compound (Sodium Fluorescein or Methylumbelliferone) and buffer
solution to test the fluorescence reading capability of the instrument. The ability to
detect specific compounds at the required limit of detection ensures that the filters,
optical path, and PMT are all in working order. This test establishes the detection
limit of the instrument, which is described as the lowest concentration that will
create a signal that is statistically distinguishable from the buffer well. This test may
be conducted using either the top or bottom optics (as supported by your reader
model).

l Linearity: The Linearity Test is conducted in conjunction with the Sensitivity Test. It
verifies that the system is linear, that is, signal changes proportionally with changes
in concentration. This test is conducted using only the top optics.

l Time-Resolved Fluorescence: The optional TRF Test measures a fluorescent
compound (Europium) and buffer solution to test the time-resolved fluorescence
reading capability of the instrument. The ability to detect specific compounds at the
required limit of detection ensures that the filters, optical path, and PMT are all in
working order. This test establishes the detection limit of the instrument, which is
described as the lowest concentration that will create a signal that is statistically
distinguishable from the buffer well. This test is conducted using only the top optics.

l Fluorescence Polarization: The optional FP Test measures high- and low-
polarized samples to verify the instrument's ability to measure polarization of a
liquid fluorophore and confirm that the excitation and emission polarizers are
properly oriented in the instrument. This test is conducted using only the top optics.
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Gen5 Protocol Parameters

The information in this section represents the recommended reading parameters for the
referenced Gen5 protocol(s). It is possible that your tests will require modifications to
some of these parameters, such as the Plate Type.

i The Plate Type setting in each Gen5 protocol should match the actual plate in use.

When performing the Fluorescence Intensity (FI) tests, if a test fails due to overranged
well(s), reduce the Gain in the protocol by 1–5 counts and try the test again.

Synergy 2 FI_T.prt

Parameter Setting

Plate Type "Costar 96 black opaque" (#3915)

Two Read Steps

Detection Method Fluorescence intensity

Read Type Endpoint

Optics Type Filters

Step Labels "Corners Read"
"Sensitivity Read"

Read wells Corners Read: Full plate
Sensitivity Read: Wells C1–F12

Filter Set 1

Excitation 485/20 nm

Emission 528/20 nm

Optics Position Top 510 nm

Gain 75

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 40

Dynamic Range Standard

Light Source Tungsten

Read Height 5.00 mm
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Synergy 2 FI_B.prt

Parameter Setting

Plate Type "Greiner SensoPlate" (#655892)

Two Read Steps

Detection Method Fluorescence intensity

Read Type Endpoint

Optics Type Filters

Step Labels "Corners Read"
"Sensitivity Read"

Read wells Corners Read: Full plate

Sensitivity Read: Wells C1–F12

Filter Set 1

Excitation 485/20 nm

Emission 528/20 nm

Optics Position Bottom

Gain Corners Read: 80
Sensitivity Read: 100

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 40

Dynamic Range Standard

Light Source Tungsten

Synergy 2 FP.prt

Parameter Setting

Plate Type "Costar 96 black opaque" (#3915)

Synchronized Mode Plate mode with timing control

Detection Method Fluorescence polarization

Read Type Endpoint

Optics Type Filters

Read wells A5–H9

Filter Set 1

Excitation 485/20 nm

Emission 528/20 nm

Optics Position Top 510 nm
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Parameter Setting

Gain 100

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 60

Dynamic Range Standard

Light Source Tungsten

Read Height 5.00 mm

Synergy 2 TRF.prt

Parameter Setting

Plate Type "Costar 96 white opaque" (#3912)

Shake Step Medium, 30 seconds

Delay Step 3 minutes

Detection Method Time-resolved fluorescence

Read Type Endpoint

Optics Type Filters

Read wells A5–H9

Filter Set 1

Excitation 360/40 nm

Emission 620/40 nm

Optics Position Top 400 nm

Gain 125

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 20

Delay before collecting data: 300 µsec

Data collection time: 1000 µsec

Light Source Xenon Flash

Read Height 5.00 mm
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Synergy 2 FI_MUB.prt

Parameter Setting

Plate Type "Costar 96 black opaque" (#3915)

Detection Method Fluorescence intensity

Read Type Endpoint

Optics Type Filters

Read wells C1–F12

Filter Set 1

Excitation 360/40 nm

Emission 460/40 nm

Optics Position Top 50%

Gain 90

Read Speed Normal

Delay after plate movement 350 msec

Measurements per data point 40

Dynamic Range Standard

Light Source Tungsten

Read Height 5.00 mm

Results Analysis

The Fluorescence Liquid Test procedures begin on page 137.

Corners Test

1. Calculate the Mean of the twelve "corner" wells (A1–A3, A10–A12, H1–H3, and
H10–H12).

2. Calculate the Standard Deviation of the same twelve wells.

3. Calculate the %CV: (Standard Deviation/Mean)*100

The %CV must be <3.0 to pass.

Sensitivity Test

Using Sodium Fluorescein

1. Calculate the Mean and Standard Deviation for the buffer wells (C10–F12).

2. Calculate the Mean for the 1000 pM (1 nM) SF solution wells (C1–F1).

3. Calculate the Detection Limit, in pM:

1000/((MeanSF-MeanBuffer)/(3*STDBuffer))
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Optic Probe The Detection Limit must be:

Bottom 5 mm <26 pM (10 pg/mL)

Bottom 3 mm <53 pM (20 pg/mL)

Bottom 1.5 mm <106 pM (40 pg/mL)

Top, with 510 nm dichroic mirror <5 pM (2 pg/mL)

Using Methylumbelliferone

1. Calculate the Mean and Standard Deviation for the buffer wells (C10–F12).

2. Calculate the Mean for the 17.6 ng/mL (100 nM) MUB solution wells (C1–F1).

3. Calculate the Detection Limit, in ng/mL:

17.6/((MeanMUB-MeanBuffer)/(3*STDBuffer)

The Detection Limit must be <0.16 ng/mL to pass.

Linearity Test

1. Calculate the Mean of the four wells for each concentration in columns 1-5.

2. Perform linear regression using these values as inputs:

Using Sodium Fluorescein

x y

1000 Mean of the 1000 pM wells

500 Mean of the 500 pM wells

250 Mean of the 250 pM wells

125 Mean of the 125 pM wells

62.5 Mean of the 62.5 pM wells

Using Methylumbelliferone

x y

100 Mean of the 100 nM wells

50 Mean of the 50 nM wells

25 Mean of the 25 nM wells

12.5 Mean of the 12.5 nM wells

6.25 Mean of the 6.25 nM wells

3. Calculate the R2 value; it must be >=0.9500 to pass.

Time-Resolved Fluorescence (TRF) Test

1. Calculate the Mean and Standard Deviation of the wells containing deionized water
(A6–H6).
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2. Calculate the Mean and Standard Deviation of the wells containing the Europium
solution (A8–B8).

3. Calculate the Detection Limit, in fM:

20000/((MeanEu–MeanDIWater)/(3*STD DIWater))

The Detection Limit must be <=250 fM to pass.

Fluorescence Polarization (FP) Test

1. Using the raw data from the Parallel read:

o Calculate the Mean Blank (wells A6–H6).

o Calculate the Signal for each HPR well: Subtract the Mean Blank from its
measurement value.

o Calculate the Signal for each LPR well: Subtract the Mean Blank from its
measurement value.

2. Using the raw data from the Perpendicular read:

o Calculate the Mean Blank (wells A6–H6).

o Calculate the Signal for each HPR well: Subtract the Mean Blank from its
measurement value.

o Calculate the Signal for each LPR well: Subtract the Mean Blank from its
measurement value.

3. Calculate the G-Factor for each LPR well:

(Parallel LPR Signal*(1-0.02))/(Perpendicular LPR Signal*(1+0.02))

4. Calculate the Mean G-Factor.

5. Calculate the Polarization value in mP for each HPR well (“PHPR”):

(Parallel HPR Signal-Mean G Factor*Perpendicular HPR Signal)/(Parallel HPR
Signal+Mean G Factor*Perpendicular HPR Signal)*1000

6. Calculate the Mean PHPR, in mP.

The Mean PHPR must be >340 mP to pass.

7. Calculate the Polarization value in mP for each LPR well (“PLPR”):

(Parallel LPR Signal-Mean G Factor*Perpendicular LPR Signal)/(Parallel LPR
Signal+Mean G Factor*Perpendicular LPR Signal)*1000

8. Calculate the Standard Deviation of the "PLPR", in mP.

The Standard Deviation of the PLPR must be <5 mP to pass.

Troubleshooting

If a fluorescence liquid test fails, try the relevant suggestions below. If a test continues
to fail, print the results and contact BioTek TAC.
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l Are the solutions fresh? Discard open/unused buffer and stock solutions after seven
days.

l Are the Excitation/Emission filters clean? Are they in the proper locations and in the
proper orientation in the filter cube or wheel?

l Are you using new/clean plates? If the base of a clear-bottom plate is touched, clean
the entire base with alcohol (95% ethanol) and then wipe with a lint-free cloth.
Before placing the plate in the instrument, blow the bottom of the plate with an
aerosol duster. If the test fails again, the optical probe(s) may need to be cleaned.
Contact BioTek TAC for instructions.

l Review the pipetting instructions to verify the plate was correctly prepared.

l Does the Plate Type setting in the Gen5 protocol match the plate you used?

l For injector models, spilled fluid inside the reader may be fluorescing, which can
corrupt your test results. If you suspect this is a problem, contact BioTek TAC for
assistance.

l When testing Fluorescence Polarization capability using a solid black plastic
microplate, if the standard deviation for the buffer wells is too high, try either
moving the buffer wells to another column, or using the Greiner SensoPlate. With
some black plastic plates, the wells in the center of the plate may be slightly
distorted due to the plate molding process, and this can affect the standard deviation.

l If the Corners Test continues to fail, the hardware may be misaligned. Contact
BioTek TAC.
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Injection System Testing

For models equipped with injectors and an external dispense module, BioTek has
developed a set of tests to ensure that the injection system performs to specification.

Test Method

The Accuracy Test is a measure of the mean volume per well for multiple dispenses. The
actual weight of the dispensed fluid is compared to the expected weight and must be within
a certain percentage to pass. Pass/Fail criteria depends on the per-well volume dispensed:
2.0% for 80 μL, 5.0% for 20 μL, and 20.0% for 5 μL.

The test uses a green dye test solution (available for purchase from BioTek, see page 5)
and one 96-well microplate per injector to test the three different volumes. The balance is
tared with the empty plate and the 80 μL dispense is performed for columns 1–4. The fluid
is weighed and the balance is tared again with the plate. This process is repeated for the 20
μL and 5 μL dispenses.

It is assumed that one gram is equal to one milliliter and the solutions used are at room
temperature. A three-place precision balance is used to weigh the plate.

The Precision Test is a measure of the variation among volumes dispensed to multiple
wells, and uses the green test dye solution. For each volume dispensed (80 μL, 20 μL, and
5 μL) to four columns, the %CV of 32 absorbance readings is calculated. Pass/Fail criteria
depends on the per-well volume dispensed: 2.0% for 80 μL, 7.0% for 20 μL, and 10.0% for
5 μL. Columns 1–4 are read at 405/750 nm and columns 5–12 at 630/750 nm.

The Accuracy and Precision tests are performed simultaneously and use the same plate.

Gen5 Parameters

The information in this section represents the recommended reading parameters for the
referenced Gen5 protocol(s). It is possible that your tests will require modifications to
some of these parameters, such as the Plate Type.

i The Plate Type setting in each Gen5 protocol should match the actual plate in use.

Synergy 2 Disp 1 Test.prt and Synergy 2 Disp 2 Test.prt (for use with models with
Absorbance capability)

Parameter Setting

Plate Type 96 WELL PLATE

Dispense Step Dispenser <1 or 2>
Wells A1–H4
Tip prime before this dispense step, 20 µL
Dispense 80 µL at 275 µL/sec
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Parameter Setting

Plate Out,In Comment: Weigh the plate (80 uL test). RECORD the weight, TARE
the balance. Place the plate back on the carrier. Click OK to
continue.

Dispense Step Dispenser <1 or 2>
Wells A5–H8
Tip prime before this dispense step, 20 µL
Dispense 20 µL at 250 µL/sec

Plate Out,In Comment: Weigh the plate (20 uL test). RECORD the weight, TARE
the balance. Place the plate back on the carrier. Click OK to
continue.

Dispense Step Dispenser <1 or 2>
Wells A9–H12
Tip prime before this dispense step, 5 µL
Dispense 5 µL at 225 µL/sec

Plate Out,In Comment: Weigh the plate (5 uL test). RECORD the weight, TARE
the balance. PIPETTE 150 µL/well of DI water into all 12 columns.
Place the plate back on the carrier. Click OK to perform the Read
steps.

Shake Step Linear, 15 seconds, default frequency

Read Step Detection Method: Absorbance
Read Type: Endpoint
Optics Type: Monochromator
Step label: 80 ul Read_Disp <1 or 2>
Wells: A1–H4
Wavelengths, 2: 405 nm, 750 nm
Speed: Normal

Read Step Detection Method: Absorbance
Read Type: Endpoint
Optics Type: Monochromator
Step label: 20 and 5 ul Read_Disp <1 or 2>
Wells: A5–H12
Wavelengths, 2: 630 nm, 750 nm
Speed: Normal

Data Reduction Define two Delta OD transformations:
405–750 nm for the 80 uL Read step, columns 1–4
630–750 nm for the 20 and 5 uL Read step, columns 5-12
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Synergy 2 Disp 1 Test No Read.prt and Synergy 2 Disp 2 Test No Read.prt (for use
with models without Absorbance capability)

Parameter Setting

Plate Type 96 WELL PLATE

Dispense Step Dispenser <1 or 2>
Wells A1..H4
Tip prime before this dispense step, 20 µL
Dispense 80 µL at 275 µL/sec

Plate Out,In Comment: Weigh the plate (80 uL test). RECORD the weight, TARE
the balance. Place the plate back on the carrier. Click OK to
continue.

Dispense Step Dispenser <1 or 2>
Wells A5..H8
Tip prime before this dispense step, 20 µL
Dispense 20 µL at 250 µL/sec

Plate Out,In Comment: Weigh the plate (20 uL test). RECORD the weight, TARE
the balance. Place the plate back on the carrier. Click OK to
continue.

Dispense Step Dispenser <1 or 2>
Wells A9..H12
Tip prime before this dispense step, 5 µL
Dispense 5 µL at 225 µL/sec

Plate Out,In Comment: Weigh the plate (5 uL test). RECORD the weight, TARE
the balance. PIPETTE 150 µL/well of DI water into all 12 columns.
Set the plate aside and click OK.

Read Step Define a brief Read step for a single well. The measurement value
will not be used. The step is only necessary because Gen5 requires
a Read step with dispense protocols.

Synergy 2 Disp Test Other Reader.prt (for use with a BioTek absorbance-capable
reader other than Synergy 2)

Parameter Setting

Shake Step <medium intensity> for 15 seconds

Read Step Detection Method: Absorbance
Read Type: Endpoint
Optics Type: <as appropriate for the reader type>
Step label: 80 ul Read
Wells: A1..H4
Wavelengths, 2: 405 nm, 750 nm
Speed: Normal
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Parameter Setting

Read Step Detection Method: Absorbance
Read Type: Endpoint
Optics Type: <as appropriate for the reader type>
Step label: 20 and 5 ul Read
Wells: A5..H12
Wavelengths, 2: 630 nm, 750 nm
Speed: Normal

Data Reduction Define two Delta OD transformations:
405-750 nm for the 80 ul Read step, columns 1-4
630-750 nm for the 20 and 5 ul Read step, columns 5-12

Results Analysis

The Injection System Test procedures begin on page 149.

When the experiment for one injector is complete, 32 delta OD values are reported for
each of the three dispense volumes. The pass/fail criteria for each set of 32 wells with the
same dispense volume is based on the calculated coefficient of variation (% CV) and
Accuracy % Error.

For each volume dispensed (80 μL, 20 μL, 5 μL), for each injector (1, 2):

1. Calculate the Standard Deviation of the 32 wells

2. Calculate the Mean of the 32 wells

3. Calculate the %CV: (Standard Deviation / Mean) x 100

4. Calculate the Accuracy % Error:

((ActualWeight–ExpectedWeight)/ExpectedWeight)* 100

Expected Weights for 32 wells: 80 μL (2.560 g), 20 μL (0.640 g), 5 μL (0.160 g).
It is assumed that one gram is equal to one milliliter.

Dispense Volume To pass, %CV
must be:

To pass, Accuracy % Error
must be:

80 µL ≤ 2.0% ≤ 2.0%

20 µL ≤ 7.0% ≤ 5.0%

5 µL ≤ 10.0% ≤ 20.0%

If any tests fail, prime the fluid lines and rerun the tests. If the tests fail again, the
injectors may require cleaning; see Clean the Internal Components starting on page 75.
If tests continue to fail, contact BioTek TAC.
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Chapter 8

Instrument Qualification Procedures
This chapter contains the step-by-step procedures for verifying that the
Synergy 2 and its various sub-systems are performing to specification.

Instrument Qualification Process starting on page 97 introduces the
various test methods, describes the materials and relevant Gen5
protocols used to execute the tests, explains how to analyze test
results, and provides troubleshooting tips in the event of a failure.
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IQ/OQ/PQ Description 125
Recommended Qualification Schedule 126
System Test 127
Plate Shaker Test 128
Absorbance Plate Tests 129
Absorbance Liquid Tests 131
Luminescence Test 136
Fluorescence Liquid Tests 137
Injection System Tests 149



Overview

This chapter contains BioTek Instrument's recommended qualification procedures for all
Synergy 2 models.

Every Synergy 2 is fully tested at BioTek prior to shipment and should operate properly
upon initial setup. If you suspect that a problem occurred during shipment, if you have
received the equipment after returning it to the factory for service, and/or if regulatory
requirements dictate that you qualify the equipment on a routine basis, perform the
procedures outlined in this chapter.

See the Recommended Qualification Schedule on page 126 to determine which qualification
tests shall be conducted for your Synergy 2 model and to meet your site's regulatory
requirements.

A Product Qualification Package (BTI #7130566) for the Synergy 2 is available for
purchase. The package contains test procedures, Gen5 protocols, checklists, and
logbooks for performing Installation Qualification, Operational Qualification,
Performance Qualification, and Preventive Maintenance. Contact your BioTek dealer for
more information.
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IQ/OQ/PQ Description

Installation Qualification confirms that the reader and its components have been
supplied as ordered and ensures that they are assembled and configured properly for your
lab environment.

l The recommended IQ procedure consists of setting up the instrument and its
components as described in the Installation chapter, and performing the System
Test. For models with injectors, a quick test with fluid is also performed, to ensure
that the dispense module is properly installed and there are no leaks.

l The IQ procedure should be performed before the reader is used for the first time.
The successful completion of the IQ procedure verifies that the instrument is
installed correctly.

Operational Qualification confirms that the equipment operates according to
specification initially and over time.

l The recommended OQ procedure consists of performing the System Test,
Absorbance Plate Test, a series of Fluorescence Tests, and, if the external dispense
module is used, Dispense Accuracy and Precision Tests.

l The OQ procedure should be performed initially (before first use) and then routinely;
the recommended interval is annually. It should also be performed after any major
repair or upgrade to the hardware or software.

l Although out-of-tolerance failures will be detected by the OQ tests, results should be
compared with those from the routine Performance Qualification tests and previous
OQ tests to monitor for trends.

l The successful completion of the OQ procedure, in combination with results that are
comparable to previous PQ and OQ tests, confirms that the equipment is operating
according to specification initially and over time.

Performance Qualification confirms that the reader consistently meets the
requirements of the tests performed at your laboratory.

l The recommended PQ procedure consists of performing the System Test, Absorbance
Plate Test, a series of Fluorescence Tests, and, if the external dispense module is
used, Dispense Accuracy and Precision Tests. Your facility’s operating policies may
also require that you routinely perform an actual assay, to confirm that the reader
will consistently give adequate results for the assays to be run on it.

l These tests should be performed routinely; the recommended interval is monthly or
quarterly, depending on the test. This frequency may be adjusted depending on the
trends observed over time.

l The successful completion of the PQ procedure confirms that the equipment is
performing consistently under normal operating conditions.
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Recommended Qualification Schedule

The schedule below defines BioTek-recommended intervals for qualifying a Synergy 2 used
two to five days a week. The actual frequency, however, may be adjusted depending on
your usage of the instrument and its various modules. This schedule assumes the reader is
properly maintained as outlined in the Preventive Maintenance chapter.

IQ OQ PQ

Tasks/Tests Initially
Initially/
Annually Monthly Quarterly

All models:

Installation, setup, and configuration of the reader,
host computer, and Gen5

ü

System Test ü ü ü

Models with absorbance capability:

Absorbance Plate Test ü ü

Absorbance Liquid Test 1 or Liquid Test 2* ü ü

(Optional) Absorbance Liquid Test 3 or 340 nm
Absorbance Plate Test (using BTI #7260551)

ü ü

Models with fluorescence capability:

Corners, Sensitivity, Linearity (FI) Tests ü ü

Fluorescence Polarization (FP) Test ü ü

Time-Resolved Fluorescence (TRF) Test ü ü

Models with luminescence capability:

Luminescence Test ü ü

Models with injectors and an external dispense module:

Installation and setup of external dispense module ü

Injection System Test ü

Dispense Accuracy and Precision Test ü ü

* If you have Absorbance Test Plate BTI #7260522, perform Liquid Test 1. Otherwise,
perform Liquid Test 2.
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System Test

Instrument System Test starting on page 98 describes this test and explains where to
find information on error codes and troubleshooting tips, as well as sample test reports
for Synergy 2.

Setup

If your assays use incubation, we recommend enabling temperature control for at least
37°C and allowing the incubator to reach its set point before running the System Test.
To access this feature, select System > Instrument Control and click the Pre-
Heating tab.

Test Procedure

1. From the Gen5 main screen, select System > Diagnostics > Run System Test.

The duration of the test depends on the reader model; it can take a few minutes
to complete.

If the test fails during execution, a message box will appear in Gen5. Close the
box; the System Test Report will contain the error code that was generated by
the failure.

2. When the test is complete, a dialog will appear, requesting additional information.
Enter any required information and then click OK.

3. The test report will appear; scroll to the bottom, it will show either “SYSTEM TEST
PASS” or “SYSTEM TEST FAIL *** ERROR (error code) DETECTED.”

If the test failed, go to page 163 to look up the error code and determine its cause. If
the cause is something you can fix, turn off the reader, fix the problem, and then turn
the reader back on and retry the test. If the test continues to fail, or if the cause is
not something you can fix, contact BioTek TAC.

4. If required, print, sign, and date the report, and store it with your test
documentation.

5. If applicable, turn off the incubator.
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Plate Shaker Test

Refer to the Gen5 Help system for complete instructions for defining a protocol and
setting the shake parameters.

1. Create a protocol with a Shake step and a Read step in its procedure.

l In the Shake step, set the Intensity to Variable and the Duration to 30 seconds.
Alternatively, choose shake parameters that mostly closely align with your
assays.

l In the Read step, define an endpoint read. You can select any detection method; it
does not affect the result of the Shake test.

2. Create an experiment based on this protocol and then read a plate. If you can hear
the plate shaking, the shaker is operating properly. If you do not hear the plate
shaker, contact BioTek.

128 | Chapter 8: Instrument Qualification Procedures

BioTek Instruments, Inc.



Absorbance Plate Tests

BioTek Absorbance Test Plates starting on page 99 describes the test methods and
provides troubleshooting tips in the event of test failure.

i The diagnostics feature in Gen5 versions 2.08 and higher is compatible with the 340
nm Absorbance Test Plate BTI #7260551. If you are using an earlier Gen5 version, refer
to the test plate's instruction sheet to manually conduct the tests and analyze results.

Requirements

To perform this test, you will need:

l Absorbance Test Plate, BTI #7260522

l (Optional) 340 nm Absorbance Test Plate, BTI #7260551

l Current Absorbance Test Plate Calibration Certificate(s)

Setup

Before an Absorbance Test Plate can be used for qualification, you must enter information
from its Calibration Certificate into Gen5. Perform these steps initially, and then repeat
them annually after the test plate is recertified by BioTek:

1. Obtain the current Test Plate Calibration Certificate.

2. Start Gen5 and select System > Diagnostics > Test Plates > Add/Modify
Plates.

3. Click Add. The Absorbance Test Plate dialog appears.

4. Select the appropriate Plate Type and then enter the plate’s serial number.

5. Enter the Last Certification and Next Certification dates from the calibration label on
the Test Plate.

6. If the wavelength values in the top row of the grid in Gen5 are appropriate for your
tests, enter the OD Standard values from the Calibration Certificate into the grid.
Make sure you enter the correct value for each well/wavelength combination.

If you need to change the wavelength values, clickWavelength List. Add,
change, or delete the values as needed and click OK.

7. If applicable: Select the number of Peak Wavelength tests to run (up to 4), based on
the desired Expected Peak wavelengths provided on the Calibration Certificate. Enter
the Expected Peak value(s) from the Certificate and set the Test Range – and +
values.
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Depending on the manufacture date of the test plate, the glass type may be
Erbium, Holmium, or Didymium. Contact BioTek TAC if you are not sure
which glass type is used in your plate.

o If the C6 filter is Erbium or Holmium glass, the certificate contains two Spectral
Bandpass tables.

Use the values in the 2.4 nm table with Synergy 2.

Erbium: Any peak value in the table can be used.

Holmium: For best results use the expected peak values closest to 242, 279,
362, 417, and 538 nm.

o If the C6 filter is Didymium glass, the certificate provides a single peak
wavelength value. Enter this value into Gen5 and set the Test Range – and +
values so the range displayed in parenthesis is "(580 to 590)".

8. Review all of the values that you entered. When finished, click OK to save the
information.

Test Procedure

1. In Gen5, select System > Diagnostics > Test Plates > Run. If prompted, select
the desired Test Plate and click OK.

2. When the Absorbance Test Plate Options dialog appears, enter any required
information.

3. If applicable, check the Perform Peak Wavelength Test box.

4. Highlight the wavelength(s) to be included in this test. Select only those wavelengths
most appropriate for your use of the reader.

5. (Optional) Enter a comment.

6. Click Start Test.

7. Place the Absorbance Test Plate on the microplate carrier, with A1 in the proper
location.

8. Click OK to run the test.

9. When the test completes, the results report will appear. Scroll down through the
report; every result should show "PASS".

l Troubleshooting tips are provided on page 100.

l Test descriptions are provided on page 99.
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Absorbance Liquid Tests

Absorbance Liquid Tests starting on page 101 describes the test methods, lists the Gen5
protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

Absorbance Liquid Test 1

The tests in this section require specific microplates, solutions, and
filters or wavelengths. Your laboratory may require a deviation from
some of these tests. For example, you may wish to use a different plate
or test solution. If deviation from the tests as presented in this section is
required, perform the following steps the first time each test is run:

Perform the tests exactly as described here.

Rerun the tests using your particular plates, solutions, and so on.

If results are comparable, then the results from these tests will be
your baseline for future tests. Document your new test procedure
and save all test results.

Materials

Manufacturer part numbers are subject to change.

l New 96-well clear flat-bottom microplate (Corning Costar #3590 recommended)

l Stock Solution A or B, which may be formulated by diluting a dye solution available
from BioTek (A) or from the materials listed below (B)

l Gen5 protocol Synergy 2 Abs Test 1.prt described on page 102

Solution A

l BioTek QC Check Solution No. 1 (PN 7120779, 25 mL; PN 7120782, 125 mL)

l Deionized water

l 5-mL Class A volumetric pipette

l 100-mL volumetric flask

1. Pipette a 5-mL aliquot of BioTek QC Check Solution No. 1 into a 100-mL volumetric
flask.

2. Add 95 mL of DI water; cap and shake well. The solution should measure
approximately 2.000 OD when using 200 μL in a flat-bottom microwell.
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Solution B

l Deionized water

l FD&C Yellow No. 5 dye powder (typically 90% pure)

l Tween 20 (polyoxyethylene (20) sorbitan monolaurate) or BioTek wetting agent (PN
7773002) (a 10% Tween solution)

l Precision balance with capacity of 100 g minimum and readability of 0.001 g

l Weigh boat

l 1-liter volumetric flask

1. Weigh out 0.092 g of FD&C Yellow No. 5 dye powder into a weigh boat.

2. Rinse the contents into a 1-liter volumetric flask.

3. Add 0.5 mL of Tween 20, or 5 mL of BioTek’s wetting agent.

4. Fill to 1 liter with DI water; cap and shake well. The solution should measure
approximately 2.000 OD when using 200 μL in a flat-bottom microwell.

Test Procedure

i Be sure to use a new microplate. Debris, fingerprints, or scratches may cause
variations in readings.

1. Using freshly prepared stock solution (Solution A or B), prepare a 1:2 dilution using
deionized water (one part stock, one part deionized water; the resulting solution is a
1:2 dilution).

2. Pipette 200 μL/well of the stock solution into column 1.

3. Pipette 200 μL/well of the diluted solution into column 2.

4. Create a Gen5 experiment based on the Synergy 2 Abs Test 1 protocol and read
the plate. When prompted, rotate the plate 180 degrees and continue.

5. When the experiment is finished:

l Save the experiment. Refer to the instructions on page 104 to perform
calculations and determine pass/fail.

l Troubleshooting tips are provided on page 106.

l Test descriptions are provided on page 101.

Absorbance Liquid Test 2

The recommended method for testing the instrument's alignment, repeatability, and
accuracy is to use Absorbance Test Plate BTI #7260522 (see page 129). If the test plate
is not available, however, Liquid Test 2 can be used for these tests.
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Materials

Manufacturer part numbers are subject to change.

l New 96-well clear flat-bottom microplate (Corning Costar #3590 recommended)

l Ten test tubes, numbered consecutively, set in a rack

l Calibrated hand pipette (Class A volumetric pipette recommended)

l Stock Solution A or B (see instructions for Liquid Test 1)

l 0.05% solution of deionized water and Tween 20

l Gen5 protocol Synergy 2 Abs Test 2.prt described on page 103

Test Procedure

1. Create a percentage dilution series, beginning with 100% of the original concentrated
stock solution (A or B) in the first tube, 90% of the original solution in the second
tube, 80% in the third tube, all the way to 10% in the tenth tube. Dilute using the
0.05% solution of deionized water and Tween 20. This solution can also be made by
diluting the BioTek wetting agent 200:1.

Tube Number 1 2 3 4 5 6 7 8 9 10

Volume of original concentrated solution (mL) 20 18 16 14 12 10 8 6 4 2

Volume of 0.05% Tween solution (mL) 0 2 4 6 8 10 12 14 16 18

Absorbance expected if original solution is
2.000 OD at 200 µL

2.0 1.8 1.6 1.4 1.2 1.0 0.8 0.6 0.4 0.2

The choice of dilutions and the absorbance of the original solution can be
varied. Use this table as a model for calculating the expected absorbances of a
series of dilutions, given a different absorbance of the original solution.

2. Pipette 200 μL of the concentrated solution from Tube 1 into each well of the first
column, A1 to H1, of a new flat-bottom microplate.

3. Pipette 200 μL from each of the remaining tubes into the wells of the corresponding
column of the microplate (Tube 2 into wells A2 to H2, Tube 3 into wells A3 to H3, and
so on).

4. Create a Gen5 experiment based on the Synergy 2 Abs Test 2 protocol and read
the plate. When prompted, rotate the plate 180 degrees.

5. When finished:

l Save the experiment. Refer to the instructions on page 104 to perform
calculations and determine pass/fail.

l Troubleshooting tips are provided on page 106.

l Test descriptions are provided on page 99.
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Absorbance Liquid Test 3

Absorbance Liquid Test 3 is provided for sites requiring proof of linearity at 340 nm. This
test is optional because the Synergy 2 has good "front end" linearity throughout its
wavelength range. As an alternative, the 340 nm Absorbance Test Plate (BTI #7260551)
may be used for this test.

Materials

Manufacturer part numbers are subject to change.

l New 96-well clear flat-bottom microplate (Corning Costar #3590 recommended)

l Calibrated hand pipette(s)

l Beakers and graduated cylinder

l Precision balance with readability to 0.010 g

l Buffer solution described below

l Gen5 protocol Synergy 2 Abs Test 3.prt described on page 103

Buffer Solution

l Deionized water

l Phosphate-Buffered Saline (PBS), pH 7.2–7.6, Sigma tablets, #P4417 (or equivalent)

l β-NADH Powder (β-Nicotinamide Adenine Dinucleotide, Reduced Form) Sigma bulk
catalog number N 8129, or preweighed 10-mg vials, Sigma number N6785-10VL (or
BioTek PN 98233). Store the powder according to the guidelines on its packaging.

1. Prepare a PBS solution from the Sigma tablets.

2. In a beaker, mix 50 mL of the PBS solution with 10 mg of the β-NADH powder and
mix thoroughly. This is the 100% Test Solution.

3. (Optional) Read a 150-μL sample of the solution at 340 nm; it should be within
0.700 to 1.000 OD. If low, adjust up by adding more powder. Do not adjust if
slightly high.

Test Procedure

1. Prepare the 75% Test Solution by mixing 15 mL of the 100% Test Solution with 5
mL of the PBS Solution.

2. Prepare the 50% Test Solution by mixing 10 mL of the 100% Test Solution with 10
mL of the PBS Solution.

3. Carefully pipette the three solutions into a new 96-well microplate:

l 150 μL of the 100% Test Solution into all wells of columns 1 and 2

l 150 μL of the 75% Test Solution into all wells of columns 3 and 4

l 150 μL of the 50% Test Solution into all wells of column 5 and 6
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4. Create a Gen5 experiment based on the Synergy 2 Abs Test 3 protocol and read
the plate.

l Save the experiment. Refer to the instructions on page 105 to perform
calculations and determine pass/fail.

l Troubleshooting tips are provided on page 106.

l Test descriptions are provided on page 101.
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Luminescence Test

Luminescence Testing starting on page 107 describes the test method, lists the Gen5
protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

Requirements

To perform this test, you will need:

l Harta Luminometer Reference Microplate, BioTek PN 8030015 (which includes
adapter PN 8032028 for this reader)

l Gen5 protocol described on page 107:

o Synergy 2 LumTest_Harta

l A Plug in the Excitation filter wheel

l An open position (Hole) in the Emission filter wheel

Test Procedure

1. Turn on the Harta reference plate using the I/O switch on the back of the plate.

2. Check the battery by pressing the test button on the back of the plate and ensuring
that the test light turns on. The test light may be difficult to see in bright light;
change your angle of view or move to a darker environment if necessary. If the light
does not turn on, replace the battery.

3. Place the adapter on the reader's microplate carrier and then place the Harta
reference plate on top of the adapter.

4. In Gen5, create an experiment based on the Synergy 2 LumTest_Harta protocol
and initiate a plate read.

The experiment begins with a three-minute Delay step.

5. When the experiment is complete, calculate and evaluate results as described under
Results Analysis on page 109.

6. When finished, turn off the Harta reference plate to preserve battery life.
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Fluorescence Liquid Tests

Fluorescence Liquid Tests starting on page 110 describes the test methods, lists the
Gen5 protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

The tests in this section require specific microplates, solutions, and
filters or wavelengths. Your laboratory may require a deviation from
some of these tests. For example, you may wish to use a different plate
or test solution. If deviation from the tests as presented in this section is
required, perform the following steps the first time each test is run:

Perform the tests exactly as described here.

Rerun the tests using your particular plates, solutions, and so on.

If results are comparable, then the results from these tests will be
your baseline for future tests. Document your new test procedure
and save all test results.
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Materials

Kits containing the microplates and solutions required by the Liquid Tests
are available for purchase; see Materials for Conducting Liquid Tests on
page 5.

Microplates should be clean and free from dust and bottom scratches. Use new
microplates from sealed packages.

Manufacturer part numbers are subject to change.

All tests:

l Deionized or distilled water

l Various beakers, graduated cylinders, and pipettes

l 95% ethanol (for cleaning clear-bottom plates)

l Aluminum foil

l (Optional, but recommended) 0.45-micron filter

l (Optional) Black polyethylene bag(s) to temporarily store plate(s)

l Gen5 protocols listed below (as applicable for your reader model) and described in
detail under Gen5 Protocol Parameters starting on page 111

Synergy 2 FI_B.prt Corners, Sensitivity, Linearity tests, Bottom optics,
Sodium Fluorescein (SF)

Synergy 2 FI_T.prt Corners, Sensitivity, Linearity tests, Top optics,
Sodium Fluorescein (SF)

Synergy 2 FP.prt Fluorescence Polarization (FP) test

Synergy 2 TRF.prt Time-Resolved Fluorescence (TRF) test

Synergy 2 FI_MUB.prt Corners, Sensitivity, Linearity tests, Top optics,
Methylumbelliferone (MUB, alternate/supplemental
test for Top optics)
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Corners/Sensitivity/Linearity (FI) Tests:

The materials listed here are for use with Sodium Fluorescein.
Methylumbelliferone (MUB) may be used as an alternate or supplemental
method for conducting the FI tests for the Top optics; see page 145.

If using test kit BTI #7160010 or #7160013 (see page 5) the buffer and SF are
pre-diluted.

l Buffer:

o NIST-traceable Sodium Borate Reference Standard (pH 9.18) (e.g., Fisher-
Scientific 1 L Sodium Borate Mfr. #159532, or equivalent), or

o Phosphate-Buffered Saline (PBS), pH 7.2–7.6 (e.g., Sigma tablets, Mfr.
#P4417, or equivalent) and pH meter or pH indicator strips with range 4–10

l Sodium Fluorescein Powder (1-mg vial, BioTek PN 98155)

l Bottom optics:

o A new, clean 96-well glass-bottom Greiner SensoPlate (Mfr. #655892); or a
clean Hellma Quartz 96-well titration plate (Mfr. #730.009.QG); or equivalent

l Top optics:

o A new, clean 96-well solid black microplate, such as Corning Costar #3915. The
Greiner SensoPlate mentioned above can also be used.

l Excitation filter 485/20 nm installed

l Emission filter 528/20 nm installed

l 510 nm dichroic mirror installed

Fluorescence Polarization (FP) Test:

The FP Test may be conducted using the same plate as for the Top
Corners/Sensitivity/Linearity (FI) Tests.

l The recommended test solutions are available from Invitrogen Corporation in their
“FP One-Step Reference Kit” (#P3088) or BioTek (#7160014; see page 5). This kit
includes:

o (Green) Polarization Reference Buffer, 15 mL

o Green Low Polarization Reference, 4 mL

o Green High Polarization Reference, 4 mL

o The Invitrogen kit also includes two red polarization solutions, not used

l A new, clean, 96-well solid black microplate, such as Corning Costar #3915. A
Greiner SensoPlate can also be used.

l Excitation filter 485/20 nm installed
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l Emission filter 528/20 nm installed

l 510 nm dichroic mirror and polarizers installed

Time-Resolved Fluorescence (TRF) Test:

l The recommended test solution (FluoSpheres carboxylate-modified microspheres,
0.2 μm europium luminescent, 2 μL) is available from Invitrogen Corporation
(#F20881) or BioTek (#7160011; see page 5)

l A new, clean 96-well solid white microplate, such as Corning Costar #3912

l 15-mL conical-bottom, polypropylene sample tube

l Excitation filter 360/40 nm installed

l Emission filter 620/40 nm installed

l 400 nm dichroic mirror installed

Test Solutions

Determine which tests to run for your reader model. Prepare the necessary test solutions
using the materials described on the previous pages.

Corners/Sensitivity/Linearity (FI) Tests:

If using BioTek’s sodium fluorescein powder (BTI #98155), be sure to
hold the vial upright and open it carefully; the material may be
concentrated at the top. If a centrifuge is available, spin down the tube
before opening.

When diluting the sodium fluorescein powder in buffer, it takes time for
the powder to completely dissolve. Allow the solution to dissolve for five
minutes, with intermittent vortexing, before preparing the titration dyes.

Wrap the vial containing the stock solution in foil to prevent exposure to
light. Discard unused solution after seven days. Discard any open,
unused buffer solution after seven days.

1. The Sodium Borate solution does not require further preparation; proceed to step 2.
If you are using PBS, prepare the solution:

l (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL of
deionized or distilled water.

l Follow the manufacturer’s instructions on the PBS packaging to create 200 mL,
dissolving the necessary amount of PBS into the filtered water.

l Stir the solution (preferably using a stir table) until the PBS is completely
dissolved.

l Check the pH; it should be between 7.2 and 7.6 at 25°C.
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2. Prepare the sodium fluorescein stock solution:

l Add 2.0 mL of the buffer solution to the 1 mg Sodium Fluorescein (SF) vial. This
yields a 1.3288 mM stock solution.

l Ensure that the dye has completely dissolved and is well mixed.

3. Carefully prepare the dilutions. Label each with “SF” and the concentration:

Mix this SF solution: with buffer: to make:

0.53 mL of 1.3288 mM stock solution 13.47 mL 50.2 µM

110 µL of 50.2 µM SF 13.89 mL 400 nM

3.5 mL of 400 nM SF 10.50 mL 100 nM

0.46 mL of 100 nM SF 13.54 mL 3.3 nM Corners Test

4.24 mL of 3.3 nM SF 9.76 mL 1 nM Sensitivity/Linearity Tests

Fluorescence Polarization (FP) Test:

As described in the Materials section, the recommended test solutions are available
from Invitrogen Corporation (or BioTek). They do not require additional preparation.

Time-Resolved Fluorescence (TRF) Test:

As described in the Materials section, the recommended test solutions are available
from Invitrogen Corporation (or BioTek).

l Shake the FluoSpheres container vigorously for 30 seconds prior to pipetting.
Alternatively, sonicate or vortex the container.

l Mix 10 μL of FluoSpheres with 10 mL of deionized water, in a 15-mL conical-bottom,
polypropylene sample tube. This yields a 20-nM equivalent suspension.

l Shake the vial vigorously for 30 seconds prior to pipetting. Alternatively, sonicate or
vortex the container.

l Mix 10 μL of 20-nM suspension with 10 mL of deionized water, in a 15-mL conical-
bottom, polypropylene sample tube. This yields a 20-pM equivalent suspension.

l Refrigerate any unused portions of the FluoSpheres. The temperature must be
between +2°C to +6°C.

The prepared TRF plate can be kept for a maximum of seven days, if
covered and stored in the dark between +2°C to +6°C. Allow the plate to sit
at room temperature for approximately 15 minutes prior to use. Shake the
plate gently prior to the read.
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Test Procedure

1. If you have not already done so, prepare the solutions for the tests you plan to
perform. See instructions starting on page 140.

Refer to the pipette maps on the next few pages for the remaining steps.

2. Perform the Corners/Sensitivity/Linearity tests using the Bottom optics:

l Pipette the solutions into a clean 96-well glass-bottom or quartz microplate.

l Create an experiment based on Synergy 2 FI_B.prt and read the plate.

3. Perform the Corners/Sensitivity/Linearity tests using the Top optics:

l Pipette the solutions into a new 96-well solid black or glass-bottom plate.

l Create an experiment based on Synergy 2 FI_T.prt and read the plate.

4. If your reader is equipped with Fluorescence Polarization capability:

l Pipette the solutions for the “FP” test into the same plate as used in step 3.

l Create an experiment based on Synergy 2 FP.prt and read the plate.

5. If your reader is equipped with Time-Resolved Fluorescence capability:

l Pipette the solutions for the “TRF” test into a new 96-well solid white plate.

l Create an experiment based on Synergy 2 TRF.prt and read the plate.

6. Save the experiments. Refer to the instructions starting on page 114 to perform
calculations and determine pass/fail.

l Troubleshooting tips are provided on page 116.

l Test descriptions are provided on page 110.
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Pipette Maps

Seal the plates with foil or store them in black polyethylene bags until use. When using a
clear-bottom plate, if the base of the plate is touched, clean the entire base with alcohol
(95% ethanol) and then wipe with a lint-free cloth. Before placing the plate in the
instrument, blow the bottom of the plate with an aerosol duster.

Corners, Sensitivity, and Linearity (FI) Tests:

Using a single-channel pipette:

l Pipette 200 μL of the 3.3 nM SF solution into the twelve “corner” wells.

l Pipette 200 μL of the buffer in the wells surrounding the SF. (Omit if using a solid
black plate or Greiner SensoPlate.)

Using a multi-channel pipette with just four tips installed:

l Pipette 150 μL of the buffer into columns 2–5 and 10–12. Discard the tips.

l Pipette 150 μL of the 1 nM SF solution into column 1.

l Pipette 150 μL of the 1 nm SF solution into column 2. Mix the wells using the pipette.
Do not discard the tips.

l Aspirate 150 μL from column 2 and dispense into column 3. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 3 and dispense into column 4. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 4 and dispense into column 5. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 5. Discard the solution and the tips.

1 2 3 4 5 6 7 8 9 10 11 12

Corners A 3.3 nM 3.3 nM 3.3 nM BUF BUF 3.3 nM 3.3 nM 3.3 nM

B BUF BUF BUF BUF BUF BUF BUF BUF

C 1 nM 0.5 nM 0.25 nM 0.125 nM 0.0625 nM BUF BUF BUF

Sensitivity/ D 1 nM 0.5 nM 0.25 nM 0.125 nM 0.0625 nM BUF BUF BUF

Linearity E 1 nM 0.5 nM 0.25 nM 0.125 nM 0.0625 nM BUF BUF BUF

F 1 nM 0.5 nM 0.25 nM 0.125 nM 0.0625 nM BUF BUF BUF

G BUF BUF BUF BUF BUF BUF BUF BUF

Corners H 3.3 nM 3.3 nM 3.3 nM BUF BUF 3.3 nM 3.3 nM 3.3 nM
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Fluorescence Polarization (FP) Test:

The plate used for testing Corners/Sensitivity/Linearity of the Top optics can
also be used for this test.

l Pipette 200 μL of the (green) polarization buffer (BUF) into wells A6–H6.

l Pipette 200 μL of the green high polarization reference (HPR) into wells A7–B7.

l Pipette 200 μL of the green low polarization reference (LPR) into wells A8–H8.

1 2 3 4 5 6 7 8 9 10 11 12

A BUF HPR LPR

B BUF HPR LPR

C BUF LPR

D BUF LPR

E BUF LPR

F BUF LPR

G BUF LPR

H BUF LPR

Time-Resolved Fluorescence (TRF) Test:

l Pipette 200 μL of deionized water (DI) into wells A6–H6.

l If you have not already done so, shake the vial of 20 pM europium suspension
vigorously for 30 seconds prior to pipetting. Alternatively, sonicate or vortex the vial.

l Pipette 200 μL of the 20 pM europium suspension (Eu) into wells A8–B8.

1 2 3 4 5 6 7 8 9 10 11 12

A DI Eu

B DI Eu

C DI

D DI

E DI

F DI

G DI

H DI
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Alternate/Supplemental Tests Using Methylumbelliferone (MUB)

(Optional) As an alternative to using Sodium Fluorescein, Methylumbelliferone (MUB) can
be used to perform the Sensitivity/Linearity tests for the top optics.

Materials

Kits containing the microplates and solutions required by the Liquid Tests
are available for purchase; see Materials for Conducting Liquid Tests on
page 5.

Manufacturer part numbers are subject to change.

l Methylumbelliferone (MUB) (10-mg vial, BTI #98156)

l Carbonate-Bicarbonate buffer (CBB) capsules (Sigma #3041)

l 100% methanol (BTI #98161)

l A new, clean 96-well solid black plate, such as Corning Costar #3915 (or equivalent)

l Excitation filter 360/40 nm, Emission filter 460/40 nm installed

l 50% mirror installed

l Deionized or distilled water

l Various beakers, graduated cylinders, and pipettes

l 95% ethanol (for cleaning clear-bottom plates)

l Aluminum foil

l (Optional, but recommended) 0.45-micron filter

l (Optional) Black polyethylene bag(s) to temporarily store plate(s)

l Gen5 protocol Synergy 2 FI_MUB.prt, described in detail under Gen5 Protocol
Parameters starting on page 111

Synergy 2 Operator's Manual

Fluorescence Liquid Tests | 145



Test Solutions

Filter solutions to remove particulates that could cause erroneous
readings. Do not allow dust to settle on the surface of the solution; use
microplate covers or seals when not reading the plate.

Wrap the vial containing the MUB stock solution in foil to prevent
exposure to light.

Discard any open, unused solutions after seven days.

1. Prepare the buffer (CBB) solution:

l (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL of
deionized or distilled water.

l Open and dissolve the contents of two CBB capsules (do not dissolve the outer
gelatin capsule) into 200 mL of the water.

l Stir the solution (preferably using a stir table) until the CBB is completely
dissolved.

2. Prepare the MUB stock solution:

l Add 1 mL of 100% methanol to the 10-mg vial of MUB.

l Make sure all of the dye has completely dissolved and is well mixed. This yields a
10 mg/mL stock solution.

l Wrap the solution in aluminum foil to prevent exposure to light.

3. Prepare the dilutions. Label each with “MUB” and the concentration.

Mix this MUB solution: with: to make:

0.5 mL of 10 mg/mL stock solution 4.5 mL of 100% methanol 1 mg/mL

0.88 mL of 1 mg/mL solution 4.12 mL of CBB 176 µg/mL

0.1 mL of 176 µg/mL solution 9.9 mL of CBB 1.76 µg/mL

0.5 mL of 1.76 µg/mL solution 4.5 mL of CBB 176 ng/mL

1 mL of 176 ng/mL solution 9 mL of CBB 17.6 ng/mL
(100 nM)
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Test Procedure

1. If you have not already done so, prepare the test solutions; see page 146.

Refer to the pipette map on the next page for the remaining steps.

2. Perform the Sensitivity/Linearity tests using the Top optics:

l Pipette the solutions into a new 96-well solid black plate.

l Create an experiment based on Synergy 2 FI_MUB.prt and read the plate.

3. Save the experiment. Refer to the instructions starting on page 114 to perform
calculations and determine pass/fail.

l Troubleshooting tips are provided on page 116.

l Test descriptions are provided on page 110.
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Pipette Map

Seal the plate with foil or store it in a black polyethylene bag until use.

Use a multi-channel pipette with just four tips installed:

l Pipette 150 μL of the buffer into wells C2–F5 and C10–F12. Discard the tips.

l Pipette 150 μL of the 17.6 ng/mL (100 nM) MUB solution into column 1.

l Pipette 150 μL of the 17.6 ng/mL (100 nM) MUB solution into column 2. Mix the wells
using the pipette. Do not discard the tips.

l Aspirate 150 μL from column 2 and dispense into column 3. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 3 and dispense into column 4. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 4 and dispense into column 5. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from column 5. Discard the solution and the tips.

1 2 3 4 5 6 7 8 9 10 11 12

A

B

C 100 nM 50 nM 25 nM 12.5 nM 6.25 nM BUF BUF BUF

D 100 nM 50 nM 25 nM 12.5 nM 6.25 nM BUF BUF BUF

E 100 nM 50 nM 25 nM 12.5 nM 6.25 nM BUF BUF BUF

F 100 nM 50 nM 25 nM 12.5 nM 6.25 nM BUF BUF BUF

G

H
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Injection System Tests

Injection System Testing starting on page 118 describes the test methods, lists the Gen5
protocol parameters, explains how to analyze the test results, and provides
troubleshooting tips in the event of test failure.

Materials

Manufacturer part numbers are subject to change.

Absorbance reader with capability of reading at 405, 630, and 750 nm. The reader must
have an accuracy specification of ±1.0% ±0.010 OD or better and a repeatability
specification of ±1.0% ±0.005 OD or better.

The Synergy 2 may be used if it is equipped with Absorbance capabilities and
has passed the Absorbance Plate Test or Absorbance Liquid Test 1.

Microplate shaker (if the absorbance reader does not support shaking)

Precision balance with capacity of 100 g minimum and readability of 0.001 g

50–200 μL hand pipette and disposable tips

Deionized water

Supply bottles

250-mL beaker

New 96-well, clear, flat-bottom microplates

Green Test Dye Solution (BTI #7773003) undiluted, or one of the alternate test solutions
provided on the next page

100-mL graduated cylinder and 10-mL pipettes (if not using BioTek’s Green Test Dye
Solution)

Gen5 protocols listed below (as applicable for your reader model) and described in
detail under Gen5 Parameters starting on page 118:

For models with Absorbance capabilities:

Synergy 2 Disp 1 Test.prt
Synergy 2 Disp 2 Test.prt

For models without Absorbance capabilities:

Synergy 2 Disp 1 Test No Read.prt
Synergy 2 Disp 2 Test No Read.prt

and, if you will use Gen5 with another BioTek absorbance-capable reader:

Synergy 2 Disp Test Other Reader.prt
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Alternate Test Solutions

If you do not have BioTek’s Green Test Dye Solution (PN 7773003), prepare a dye
solution using one of the following methods:

80 μL of test solution with 150 μL of deionized water should read between 1.300
and 1.700 OD at 405/750 nm. The solutions should be at room temperature.

Using BioTek's Blue and Yellow Concentrate Dye Solutions:

Item Quantity

Concentrate Blue Dye Solution
(BTI #7773001, 125 mL)

4.0 mL

QC (Yellow) Solution
(BTI #7120782, 125 mL)

5.0 mL

Deionized water 90.0 mL

Using FD&C Blue and Yellow Dye Powder:

Item Quantity per Liter

FD&C Blue No. 1 0.200 grams

FD&C Yellow No. 5 0.092 grams

Tween 20 1.0 mL

Sodium Azide N3Na 0.100 gram

Deionized water make to 1 liter

Test Procedure for Models with Absorbance Capability

1. Prime both dispensers with 4000 μL of deionized or distilled water.

2. Remove the inlet tubes from the supply bottles. Prime both dispensers with the
Volume set to 2000 μL. This prevents the water from diluting the dye.

3. Fill a beaker with at least 20 mL of the green dye solution. Prime both dispensers
with 2000 μL of the solution. When finished, remove the priming plate from the
carrier.

4. Create an experiment based on the Synergy 2 Disp 1 Test protocol.

5. Place a new 96-well microplate on the balance and tare the balance.

6. Place the plate on the microplate carrier.

Running a dispense protocol with no plate on the carrier will
contaminate the reading chamber with spilled fluid.

150 | Chapter 8: Instrument Qualification Procedures

BioTek Instruments, Inc.



When each dispense step is finished, you will weigh the plate, record the
weight, tare the balance with the plate on it, and then place the plate back
on the carrier for the next step.

7. Initiate a plate read. Gen5 will prompt you to empty the tip priming trough.

8. When ready, proceed with the experiment. The sequence is as follows:

l 80 μL/well is dispensed to columns 1–4.

l When prompted, remove the plate and weigh it. Record the weight and tare the
balance. Place the plate on the carrier.

l 20 μL/well is dispensed to columns 5–8.

l When prompted, remove the plate and weigh it. Record the weight and tare the
balance. Place the plate on the carrier.

l 5 μL/well is dispensed to columns 9–12.

l When prompted, remove the plate and weigh it. Record the weight.

l Manually pipette 150 μL of deionized or distilled water into all 12 columns, on top
of the green test dye solution.

l Place the plate on the carrier for the shake and read steps.

9. When the experiment is complete, save the file with an identifying name.

10. Remove the plate from the carrier and set it aside.

11. Repeat the procedure using the Synergy 2 Disp 2 Test protocol and a new
microplate.

12. When the tests are complete:

l Prime both dispensers with at least 5000 µL of deionized water to flush out the dye
solution.

l Refer to the instructions on page 121 to perform calculations and determine
pass/fail.

l Test descriptions are provided on page 118.
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Test Procedure for Models without Absorbance Capability

If you are not using a BioTek absorbance reader for this procedure, prepare your reader
to perform two reads with the following characteristics:

80 µL Read 20 and 5 µL Read

Primary Wavelength: 405 nm 630 nm

Reference Wavelength: 750 nm 750 nm

Plate Columns: 1–4 5–12

1. Prime both dispensers with 4000 μL of deionized or distilled water.

2. Remove the inlet tubes from the supply bottles. Prime both dispensers with the
Volume set to 2000 μL. This prevents the water from diluting the dye.

3. Fill a beaker with at least 20 mL of the green dye solution. Prime both dispensers
with 2000 μL of the solution. When finished, remove the priming plate from the
carrier.

4. Create an experiment based on the Synergy 2 Disp 1 Test No Read protocol.

5. Place a new 96-well microplate on the balance and tare the balance.

6. Place the plate on the microplate carrier.

Running a dispense protocol with no plate on the carrier will
contaminate the reading chamber with spilled fluid.

When each dispense step is finished, you will weigh the plate, record the
weight, tare the balance with the plate on it, and then place the plate back
on the carrier for the next step.

7. Initiate a plate read. Gen5 will prompt you to empty the tip priming trough.

8. When ready, proceed with the experiment. The sequence is as follows:

l 80 μL/well is dispensed to columns 1–4.

l When prompted, remove the plate and weigh it. Record the weight and tare the
balance. Place the plate on the carrier.

l 20 μL/well is dispensed to columns 5–8.

l When prompted, remove the plate and weigh it. Record the weight and tare the
balance. Place the plate on the carrier.

l 5 μL/well is dispensed to columns 9–12.

l When prompted, remove the plate and weigh it. Record the weight.

l Manually pipette 150 μL of deionized or distilled water into all 12 columns, on top
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of the green test dye solution.

l Carefully set the plate aside.

9. Close the experiment without saving it.

If you are not using a BioTek absorbance reader, read the plate using the
parameters described in the table above. Perform the calculations and
dettermine pass/fail according to the instructions on page 121.

10. If you are using a BioTek absorbance reader, configure Gen5 to communicate with
the reader.

11. Create an experiment based on the Other Reader protocol and read the plate.

12. When the experiment is complete, save the file with an identifying name.

13. Remove the plate from the carrier and set it aside.

14. Repeat the procedure using the Synergy 2 Disp 2 Test No Read protocol and a
new microplate.

15. When the tests are complete:

l Prime both dispensers with at least 5000 µL of deionized water to flush out the dye
solution.

l Refer to the instructions on page 121 to perform calculations and determine
pass/fail.

l Test descriptions are provided on page 118.
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Appendix A

Specifications
This appendix contains BioTek's published specifications for the Synergy
2.

General Specifications 156
Absorbance Specifications 157
Fluorescence Specifications 159
Luminescence Specifications 161
Dispense/Read Specifications 161



General Specifications

Microplates

The Synergy 2 accommodates standard 6-, 12-, 24-, 48-, 96-, 384-, and 1536-well
microplates with 128 x 86 mm geometry, and the BioTek Take3 Micro-Volume Plate.

Note: 1536-well microplates are not supported for luminescence measurements.

Maximum Plate Height:

l Absorbance mode: plates up to 0.8" (20.30 mm) high

l Fluorescence and luminescence modes: plates up to 1.25" (31.75 mm) high

l PCR tube trays up to 1.25" (31.75 mm) high (may require an adapter)

l Injector models dispense to standard height 6-, 12-, 24-, 48-, and 96-well
microplates.

Hardware and Environmental

Light Source Absorbance: Xenon flash light source, 10W maximum average
power, not user-changeable

Fluorescence: Tungsten quartz halogen, 20W power, user-
changeable

TRF (and optionally for FI and FP): Xenon flash light source,
60W maximum average power, not user-changeable

Dimensions Approximately 17.5" D x 15" W x 17.5" H (44.5 cm D x 38.5 cm
W x 44.5 cm H)

Note: For dimensions that include installation with a BioStack,
refer to the BioStack Operator's Manual

Weight For a model equipped with all available modules, excluding the
power supply and dispense module, approximately 57 lbs. (25.8
kg)

Environment Operational temperature, 64° to 104°F (18° to 40°C)

Humidity 10% to 85% relative humidity (non-condensing)

Power Supply 24-volt external power supply compatible with 100–240 V~;
±10%@50–60 Hz

Power Consumption 250W maximum

Incubation Temperature control range from 4º over ambient to 65ºC.

Temperature variation ± 0.50°C across the plate @ 37°C (250
µL per well with the plate sealed).
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Absorbance Specifications

Optics

Wavelength Range 200 to 999 nm

Wavelength Bandpass 2.4 nm

Measurement Range 0.000 to 4.000 OD

Wavelength Accuracy ±2 nm

Wavelength Repeatability ± 0.2 nm

Detector Photodiodes (2)

Measurements are reference channel-corrected for light
source fluctuation

Performance

All qualifications were conducted using 96-/384-well, flat-bottom microplates. For the
performance described here, the Gain on the Optics Test should be below 10.0

Accuracy

0.000 to 2.000 OD ±1.0% ±0.010 OD Normal/Rapid modes, 96-well plates
0.000 to 2.000 OD ±2.0% ±0.010 OD Normal/Rapid modes, 384-well plates
2.000 to 2.500 OD ±3.0% ±0.010 OD Normal/Rapid modes, 96-/384-well plates
2.500 to 3.000 OD ±3.0% ±0.010 OD Normal mode, 96-well plates
0.000 to 1.000 OD ±1.0% ±0.010 OD Sweep mode, 96-/384-well plates

Linearity

0.000 to 2.000 OD ±1.0% Normal/Rapid modes, 96-well plates
0.000 to 2.000 OD ±2.0% Normal/Rapid modes, 384-well plates
2.000 to 2.500 OD ±3.0% Normal/Rapid modes, 96-/384-well plates
2.500 to 3.000 OD ±3.0% Normal mode, 96-well plates
0.000 to 1.000 OD ±1.0% Sweep mode, 96-/384-well plates

Repeatability

0.000 to 2.000 OD ±1.0% ±0.005 OD Normal/Rapid modes, 96-/384-well plates
2.000 to 2.500 OD ±3.0% ±0.005 OD Normal/Rapid modes, 96-/384-well plates
2.500 to 3.000 OD ±3.0% ±0.005 OD Normal mode, 96-/384-well plates
0.000 to 1.000 OD ±2.0% ±0.010 OD Sweep mode, 96-/384-well plates
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Read Timing

Endpoint read time is from plate start to plate stop. Kinetic read time is from A1 to A1 read
positions.

Single 630 nm Dual 630/450 nm

Endpoint
96-well plate

Normal 0 ms delay:
Normal 100 ms delay:

Sweep:

34 sec
43 sec
22 sec

53 sec
73 sec
35 sec

Endpoint
384-well plate

Normal 0 ms delay:
Normal 100 ms delay:

Sweep:

77 sec
115 sec
32 sec

143 sec
220 sec
56 sec

Endpoint
1536-well plate

Normal 0 ms delay:
Normal 100 ms delay:

Sweep:

231 sec
385 sec
53 sec

450 sec
757 sec
97 sec

Kinetic
96-well plate

Normal 0 ms delay:
Normal 100 ms delay:

Sweep:

21 sec
31 sec
11 sec

Kinetic
384-well plate

Normal 0 ms delay:
Normal 100 ms delay:

Sweep:

66 sec
104 sec
22 sec

Kinetic
1536-well plate

Normal 0 ms delay:
Normal 100 ms delay:

Sweep:

219 sec
373 sec
42 sec
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Fluorescence Specifications

Read Timing

Because of the possible wide variations in setup, the following benchmark conditions are
specified: Excitation Filter 485/20 nm, Emission Filter 528/20 nm; 10 Samples per well;
100 ms Delay before sampling; 1 ms Delay between samples.

96-well read: 99 seconds, 384-well read: 339 seconds, 1536-well read: 1256 seconds

Optical Probes

Bottom position: 1.5, 3, or 5 mm diameter probes can be installed

Top position: 3 mm diameter fixed, with motor-driven moveable apertures to reduce the
diameter to support different plate formats

Sensitivity

The following specifications apply to 96-well read formats using the Tungsten bulb.

5 mm optical probe, bottom reading

10 pg/mL solution of Sodium Fluoroscein in PBS

40 reads per location averaged, 350 ms delay before read
150 µL per well signal-to-noise ratio greater than 2
Excitation 485/20, Emission 528/20
Hellma 96-well quartz plate or Greiner SensoPlate

62.5 ng/mL solution of Propidium Iodide in PBS

40 reads per location averaged, 350 ms delay before read
150 µL per well signal-to-noise ratio greater than 2
Excitation 485/20, Emission 645/40
Corning Costar 96-well plate with black sides, clear bottom

3 mm optical probe, bottom reading

20 pg/mL solution of Sodium Fluoroscein in PBS

40 reads per location averaged, 350 ms delay before read
150 µL per well signal-to-noise ratio greater than 2
Excitation 485/20, Emission 528/20
Hellma 96-well quartz plate

125 ng/mL solution of Propidium Iodide in PBS

40 reads per location averaged, 350 ms delay before read
150 µL per well signal-to-noise ratio greater than 2
Excitation 485/20, Emission 645/40
Corning Costar 96-well plate with black sides, clear bottom
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1.5 mm optical probe, bottom reading

40 pg/mL solution of Sodium Fluoroscein in PBS

40 reads per location averaged, 350 ms delay before read
150 µL per well signal-to-noise ratio greater than 2
Excitation 485/20, Emission 528/20
Hellma 96-well quartz plate

250 ng/mL solution of Propidium Iodide in PBS

40 reads per location averaged, 350 ms delay before read
150 µL per well signal-to-noise ratio greater than 2
Excitation 485/20, Emission 645/40
Corning Costar 96-well plate with black sides, clear bottom

3 mm fixed optical probe with movable apertures, top reading

2 pg/mL solution of Sodium Fluoroscein in PBS

40 reads per location averaged, 5 mm Z-axis offset, 350 ms
delay before read
200 µL per well signal-to-noise ratio greater than 2
Excitation 485/20, Emission 528/20, Dichroic 510 nm
Corning Costar 96-well solid black plate

0.16 ng/mL solution of Methylumbelliferone in CBB

40 reads per location averaged, 5 mm Z-axis offset, 350 ms
delay before read
150 µL per well signal-to-noise ratio greater than 2
Excitation 360/40, Emission 460/40, 50% mirror
Corning Costar black strips

Time-Resolved Fluorescence

96/384-well plates: 250 fM Europium (plate and well modes), 20 reads per location, 5 mm
Z-axis offset, 350 ms delay before read

Integration Interval: 20 to 16000 µs

Delay: 0 to 16000 µs

Granularity: 1-µs steps

Fluorescence Polarization

96/384-well plates: 5 mP at 1 nM Sodium Fluorescein, 60 reads per location, 5 mm Z-axis
offset 350 ms delay before read
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Luminescence Specifications

50 amol/well flash ATP in a 96-well plate (low-noise PMT)

500 amol/well flash ATP in a 96-well plate (red-shifted PMT)

Dispense/Read Specifications

Applies only to models equipped with injectors

Plate Type Dispenses to standard height 6-, 12-, 24-, 48-, and 96-well
microplates

Detection Method Absorbance, Fluorescence, Luminescence

Volume Range 5–1000 µL with a 5–20 µL tip prime

Accuracy ±1 µL at 5–50 µL
±2% at 51–1000 µL

Precision <2.0% for volumes of 50–200 µL
<4.0% for volumes of 25–49 µL
<7.0% for volumes of 10–24 µL
<10.0% for volumes of 5–9 µL
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Appendix B

Error Codes
This appendix lists and describes Synergy 2 error codes that may
appear in Gen5.

Overview 164
Error Codes 165



Overview

When a problem occurs during operation with the Synergy 2, an error code appears in
Gen5. Error codes typically contain four characters, such as “4168,” and in most cases are
accompanied by descriptive text, such as “PMT overload error.” With many errors, the
instrument will beep repeatedly; press the carrier eject button to stop this alarm.

Some problems can be solved easily by the user, such as “2B0A: Priming plate not
detected” (place a priming plate on the carrier). Some problems can be solved only by
trained BioTek service personnel. This appendix lists the most common and easily resolved
error codes that you may encounter.

Error codes beginning with “A” (e.g., A100) indicate conditions that require immediate
attention. If this type of code appears, turn the instrument off and on. If the System
Test does not conclude successfully, record the error code and contact BioTek’s
Technical Assistance Center.

If an error code appears in Gen5, you may want to run a System Test for diagnostic
purposes. In Gen5, select System > Diagnostics > Run System Test.

Contact Info: BioTek Service/TAC

Use this appendix to diagnose problems and solve them if possible. If you need further
assistance, contact BioTek’s Technical Assistance Center.

Phone: 800-242-4685 (toll free in the U.S.) or 802-655-4740 (outside the U.S.)

Fax: 802-654-0638

E-Mail: tac@biotek.com

For errors that are displayed during operation of the Synergy 2 with the BioStack
Microplate Stacker, refer to the BioStack Operator’s Manual.
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Error Codes

This table lists the most common and easily resolved error codes that you may encounter.
If an error code appears in Gen5, look for it here. If you find the code, follow the
suggestions provided for solving the problem. If you cannot find the code or if you are
unable to solve the problem, please contact BioTek’s Technical Assistance Center. The
Gen5 Help system also provides troubleshooting tips.

Code Description and possible remedy

0202/0203 EX/EM filter wheel (respectively) did not home

Generally, this error indicates the Excitation or Emission filter
wheel is not seated properly in the reader. Remove the wheel,
ensure each filter or plug is properly positioned, and reinstall it
securely. Restart the reader.

020B/020C Dispenser syringe 1 or 2 (respectively) did not home

Generally, this error indicates the syringe was not properly
installed. Make sure the syringe’s thumbscrews are properly
threaded. (Refer to the Installation chapter for instructions.)
Restart the reader.

0402/0403 EX/EM filter wheel (respectively) failed positional verify

Generally, this error indicates the Excitation or Emission filter
wheel is not seated properly in the reader. Remove the wheel,
ensure each filter or plug is properly positioned, and reinstall it
securely. Restart the reader.

040B/040C Dispenser syringe 1 or 2 failed position verify

Generally, this error indicates the syringe was not properly
installed. Make sure the syringe’s thumbscrews are properly
threaded. (Refer to the Installation chapter for instructions.)
Restart the reader.
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Code Description and possible remedy

050x Light beam saturated (too much light). Relative
Fluorescing Units (RFU) reached (99999).

This error can indicate one of several scenarios. It is possibly due
to incorrect chemistry, e.g., the fluorescence standards dispensed
to the plate exceed expectations.

See also the description for 0E01.

Verify that the microplate carrier access door is closing properly
and no ambient light is getting into the read chamber.

If you are manually setting the Gain in your Gen5 procedure, try
using the Automatic Gain Adjustment feature.

Verify that the Gen5 Fluorescence/Luminescence filter table
matches the contents of the filter wheels.

Verify that the EX filter in position #2 does not overlap with the EM
filter in position #3. For models with injectors, the internal
chamber may require cleaning (see the Preventive Maintenance
chapter).

0700/0800/
0900

Noise Test Errors, Offset Test Errors, Dark Range Errors

This series of System Test errors may indicate that there is too
much light inside the chamber. Make sure the reader’s shroud is
properly fastened, and the plate carrier door and the front hinged
door are properly closed.

For models with injectors, if the dispense tubes are not connected
to the back of the reader, re-install the plastic plugs that shipped
with the instrument (or cover the holes with black tape). Restart
the reader.

0E01-6 Fluorescence wavelength not found in table

This error indicates that the specified wavelength is not detected in
the reader’s filter table. The last number is the filter set number in
the assay protocol. In Gen5, verify the Fluorescence filter table has
the wavelengths loaded into the reader. Compare the contents of
the table with the Excitation and Emission filters installed (see the
Gen5 Help system for more information). Restart the reader.

0F01 Filter is defined in the wrong location

Ensure that Gen5’s Fluor/Lum wavelengths table matches the
actual filters installed in the filter wheels.
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Code Description and possible remedy

1306-7/
1406-7

<Motor> not homed successfully

This error indicates that the <motor> is not at home. Make sure
the Plate Type described in the Gen5 Protocol matches the plate
you are using.

Check for any obstructions that may prevent the carrier, syringes,
or filter wheels from moving normally. Restart the reader.

2901 Tungsten Lamp reference voltage out of range

A test of the tungsten lamp is performed when the instrument is
turned on and then periodically during background functions. This
error may indicate that the lamp is weak or defective. Refer to the
As Needed Maintenance chapter for instructions to replace the
lamp. If the error still appears after replacing the lamp, contact
BioTek TAC.

2A01 Plate jam error

Make sure the Plate Type described in the Gen5 Protocol matches
the plate you are using. This error can also occur if the plate type is
correct but the lid was left on the plate. If you wish to read the
plate with a lid on it, create a new plate type in Gen5 and be sure to
enter the correct Plate Height.

Models with injectors: Verify that the tip prime trough and priming
plate are not stuck in the reading chamber.

2B01-04 Syringe motor axis did not find the home opto sensor
transition

Generally, this error indicates the syringe was not properly
installed. Make sure the syringe’s thumbscrews are properly
threaded. (Refer to the Installation chapter for instructions.)
Restart the reader.

2B0A Priming plate not detected

Applies to models with injectors.

3306 Required carrier in when expected to be outside

The carrier is inside the read chamber and the probe needs to move
down for the requested operation. Press the Carrier Eject button
and restart the experiment.
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Code Description and possible remedy

4xxx PMT overload well error at <well #>

This error typically means that the fluid in a well has oversaturated
the PMT (i.e., the well is too “bright”). Try lowering the gain value
in the read step.

Wells are counted starting at A1, moving left-to-right, row-by-row.
The row and column of the well can be extracted from the well
number code by applying the following formula (example uses 8 x
12 geometry, 96-well plate):

1. Convert the ASCII hex string to a decimal equivalent. Ex: “057”
indicates 57 hex, yielding a well code of 87 decimal.

2. Row = (well code) / (columns in plate), rounded up to a whole
number. Ex: 87/12 = 7.25, indicating row 8 (or H).

3. Column = (well code) - ((row-1) * (columns in plate)). Ex: 87 -
((8 - 1) * 12) = column 3.

NOTE: If this code is returned during an area scan, it indicates the
scan point corresponding to the row/column equivalent in the
currently defined scan map, NOT the actual well where the error
occurred.
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Appendix C

Instrument Dimensions for Robotic
Interface

This appendix shows the location of the microplate carrier in reference
to the exterior surfaces of the Synergy 2 and the mounting holes on the
bottom. Use the illustrations to facilitate system setup with a robotic
instrument, such as the BioStack Microplate Stacker. Dimensions are in
inches.



Figure C-1: Bottom view

The two arrows point to special mounting holes for alignment caps for operation
with the BioStack.
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Figure C-2: Top view
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Figure C-3: Side view

BioStack users: Special alignment hardware is included in the BioStack’s alignment kit
for correct positioning with the Synergy 2. Refer to the Installation chapter in the
BioStack Operator’s Manual for instructions.
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Appendix D

Sample Reports
This appendix contains sample System Test and Absorbance Plate Test
reports for the Synergy 2.



                              Gen5 System Test Report 
 
Reader:                       Synergy 2  (Serial Number: 15060819) 
Basecode:                     P/N 7160204  (v1.14) 
Gen5 Version:                 2.06.10 
Date and Time:                6/10/2015 9:15:35 AM 
User:                         7358 
Company:                      BioTek 
Comments:                      
 
Test Results 
 
 
Operator ID:______________________________________________________________ 
 
Notes:____________________________________________________________________ 
 
__________________________________________________________________________ 
 
 
                         SYSTEM SELF TEST 
 
7160204  Version 1.14       15060819   1111 1100 0010 0000 
 
Voltage Reference Test     Min    Low   High    Max 
   Fluorescence Flash      666    836   1089   1260 
   Absorbance Flash       1323   1605   1992   2275 
   Motors                 3728 
   Tungsten Lamp            21                 3419 
 
 
ABSORBANCE 
 
Optics Test         Ref   Meas   Gain   Resets 
   #1:200                        2.12      4 
      Light       13419  38608 
      Dark         9870   9845 
      Delta        3549  28763 
   #2:352                        1.51      4 
      Light       12607  39140 
      Dark         9872   9855 
      Delta        2735  29285 
   #3:620                        2.88      2 
      Light       12309  39704 
      Dark         9872   9821 
      Delta        2437  29883 
   #4:790                        2.33      2 
      Light       12234  39677 
      Dark         9873   9832 
      Delta        2361  29845 
   #5:860                        1.63      1 
      Light       12219  39399 
      Dark         9881   9832 
      Delta        2338  29567 
   #6:962                        2.02      1 
      Light       12223  39712 
      Dark         9881   9822 



      Delta        2342  29890 
 
Noise Test          Ref   Meas 
      Max          9827   9745 
      Min          9826   9743 
      Delta           1      2 
 
 
FLUORESCENCE/LUMINESCENCE 
 
Filter PCB 
   Bias current offset    -0.4 counts   PASS   
   Offset voltage         1489 counts   PASS   
   750V measurement       25.2 counts   PASS   
   750V noise               13 counts   
   750V offset            1492 counts   
   500V measurement       11.7 counts   
   500V noise                1 counts   
   500V offset            1491 counts   
   Reset offset           1504 counts   
   Reference bias          1.6 counts   PASS   
   Reference offset      10817 counts   PASS   
   Reference noise         0.3 counts   PASS   
 
Excitation Wheel   500V   650V   750V 
   #1:360/40 
      Gain         1.00   1.00   1.00 
      Light       15084  17238  18830 
      Dark        10817  10817  10817 
      Delta        4267   6421   8013 
   #2:485/20 
      Gain         1.00   1.00   1.00 
      Light       15825  17454  18588 
      Dark        10817  10817  10817 
      Delta        5008   6637   7771 
   #3:540/25 
      Gain         1.00   1.00   1.00 
      Light       15908  17589  18730 
      Dark        10817  10817  10817 
      Delta        5091   6772   7913 
   #4:PLUG 
 
Emission Wheel 
   #1:460/40 
   #2:528/20 
   #3:620/40 
   #4:HOLE 
 
 
CALIBRATION 
 
Carrier - Bottom Fluorescence Probe 
   Upper Left       x= 9744   y= 4564 
   Lower Left       x= 9740   y=10088 
   Lower Right      x= 1052   y=10088 
   Upper Right      x= 1056   y= 4568 
   Delta 1          9744 - 9740=   +4 



   Delta 2          1056 - 1052=   +4 
   Delta 3          4568 - 4564=   +4 
   Delta 4         10088 -10088=   +0 
 
Carrier - Top Fluorescence Probe (Filters) 
   Upper Left       x=10628   y=  228 
   Lower Left       x=10620   y= 5748 
   Lower Right      x= 1932   y= 5752 
   Upper Right      x= 1936   y=  232 
   Delta 1         10628 -10620=   +8 
   Delta 2          1936 - 1932=   +4 
   Delta 3           232 -  228=   +4 
   Delta 4          5752 - 5748=   +4 
 
Carrier - Luminescence Probe 
   Upper Left       x= 9740   y= 3000 
   Lower Left       x= 9736   y= 8524 
   Lower Right      x= 1044   y= 8528 
   Upper Right      x= 1052   y= 3004 
   Delta 1          9740 - 9736=   +4 
   Delta 2          1052 - 1044=   +8 
   Delta 3          3004 - 3000=   +4 
   Delta 4          8528 - 8524=   +4 
 
Carrier - Absorbance Probe 
   Upper Left       x=11312   y= 4564 
   Lower Left       x=11308   y=10092 
   Lower Right      x= 2616   y=10096 
   Upper Right      x= 2616   y= 4572 
   Delta 1         11312 -11308=   +4 
   Delta 2          2616 - 2616=   +0 
   Delta 3          4572 - 4564=   +8 
   Delta 4         10096 -10092=   +4 
 
Carrier - Injectors 
   Upper Left       x= 9740   y= 4560 
   Lower Left       x= 9732   y=10080 
   Lower Right      x= 1044   y=10084 
   Upper Right      x= 1048   y= 4564 
   Delta 1          9740 - 9732=   +8 
   Delta 2          1048 - 1044=   +4 
   Delta 3          4564 - 4560=   +4 
   Delta 4         10084 -10080=   +4 
 
Carrier - Test Sensors 
   Middle Sensor    y=11936 
   Tested             11936 
   Delta                 +0 
   Back Sensor      x=11592   y=10624 
   Tested             11592     10624 
   Delta                 +0        +0 
 
Probe Height        34.06 mm 
Plate Sensor        336 
 
Probe Changer       444    
 



Mirror              3908   
 
Lamp Reflector      640    
 
Aperture            2180   
 
Absorbance Monochromator      A=+0.000000  B=-0.000936  C=-0.279281 
 
 
INCUBATION 
 
Temperature Setpoint:  0.0     Current Average: 43.6      A/D Test: PASS   
 
Zone 1: 43.9   Min: 43.9   Max: 44.5     Range: PASS    Thermistor: PASS   
Zone 2: 42.5   Min: 42.5   Max: 43.3     Range: PASS    Thermistor: PASS   
Zone 3: 44.4   Min: 44.4   Max: 45.1     Range: PASS    Thermistor: PASS   
Zone 4: 43.4   Min: 43.4   Max: 44.4     Range: PASS    Thermistor: PASS   
 
 
SYSTEM TEST PASS 
0000 
 
Dispenser 1: 005.1,009.8,019.7,039.3,079.6,199.5 
Dispenser 2: 004.9,009.8,019.7,039.3,079.1,199.0 
 
Mirror 1: 50% Mirror, 0200, 0850, 0200, 0850 
Mirror 2: Dichroic  , 0320, 0390, 0410, 0800 
Mirror 3: Dichroic  , 0440, 0505, 0515, 0640 
Polarizers present. 
  
 
Reviewed/Approved By: _______________________________________    
 
Date: ________________ 
 



                              Absorbance Test Plate Results 
 
Reader:                       Synergy 2  (Serial Number: 15060819) 
Basecode:                     P/N 7160204  (v1.14) 
Date and Time:                6/9/2015 1:01:47 PM 
Absorbance Plate:             7 Filter Test Plate (P/N 7260522) - S/N 210505 
Last Plate Certification:     April 2015 
Next Plate Certification Due: April 2016 
User:                         7358 
Comments:                      
 
Peak Absorbance Results 
 
Well        C6                       
Reference   279                      
Tolerance   3                        
Read        280                      
Result      PASS                     
 
Alignment Results 
 
Wells       A1          A12         H1          H12          
Read        0.000       0.000       0.000       0.000        
Tolerance   0.015       0.015       0.015       0.015        
Result      PASS        PASS        PASS        PASS         
 
Wavelength = 630 nm 
 
Accuracy Results 
 
Wells       C1          E2          G3          H6          F5          D4           
Reference   0.172       0.589       1.083       1.666       1.804       2.338        
Min Limit   0.149       0.557       1.041       1.613       1.748       2.224        
Max Limit   0.195       0.621       1.125       1.719       1.860       2.452        
Read 1      0.174       0.590       1.083       1.668       1.805       2.333        
Result      PASS        PASS        PASS        PASS        PASS        PASS         
 
Repeatability Results 
 
Wells       C1          E2          G3          H6          F5          D4           
Read 1      0.174       0.590       1.083       1.668       1.805       2.333        
Min Limit   0.168       0.579       1.067       1.647       1.781       2.258        
Max Limit   0.181       0.601       1.099       1.690       1.828       2.408        
Read 2      0.174       0.589       1.083       1.668       1.805       2.330        
Result      PASS        PASS        PASS        PASS        PASS        PASS         
 
Reviewed/Approved By: _______________________________________    
 
Date: ________________ 
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